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End User License Agreement
AMNIS CORPORATION SOFTWARE LICENSE AGREEMENT

PLEASE READ THE FOLLOWING TERMS AND CONDITIONS CAREFULLY
BEFORE DOWNLOADING, INSTALLING OR USING THE SOFTWARE OR ANY
ACCOMPANYING DOCUMENTATION (COLLECTIVELY, THE “SOFTWARE”).

THE TERMS AND CONDITIONS OF THIS SOFTWARE LICENSE AGREEMENT
(“AGREEMENT”) GOVERN USE OF THE SOFTWARE UNLESS YOU AND
AMNIS CORPORATION (“AMNIS”) HAVE EXECUTED A SEPARATE AGREE-
MENT GOVERNING USE OF THE SOFTWARE.

Amnis is willing to license the Software to you only upon the condition that you accept all
the terms contained in this Agreement. By clicking on the “I accept” button below or by
downloading, installing or using the Software, you have indicated that you understand this
Agreement and accept all of its terms. If you are accepting the terms of this Agreement on
behalf of a Company or other legal entity, you represent and warrant that you have the
authority to bind that Company or other legal entity to the terms of this Agreement, and, in
such event, “you” and “your” will refer to that Company or other legal entity. If you do not
accept all the terms of this Agreement, then Amnis is unwilling to license the Software to
you, and you must return the Software to Amnis for a full refund, if you have paid for the
license to the Software, or, if Amnis has made the Software available to you without
charge, you must destroy all copies of the Software. Y our right to return the Software for a
refund expires 30 days after the date of purchase.

1. Grant of License. Conditioned upon your compliance with the terms and conditions of
this Agreement, Amnis grants you a non-exclusive and non-transferable license to Execute
(as defined herein) the executable form of the Software on a single computer, solely for
your internal business purposes. Y ou may make a single copy of the Software for backup
purposes, provided that you reproduce on it all copyright and other proprietary notices that
are on the original copy of the Software. Amnis reserves all rights in the Software not
expressly granted to you in this Agreement. For purposes of this Agreement, “Execute”
and “Execution” means to load, install, and run the Software in order to benefit from its
functionality as designed by Amnis.

2. Restrictions. Except as expressly specified in this Agreement, you may not: (a) copy
(except in the course of loading or installing) or modify the Software, including but not lim-
ited to adding new features or otherwise making adaptations that alter the functioning of the
Software; (b) transfer, sublicense, lease, lend, rent or otherwise distribute the Software to
any third party; or (c) make the functionality of the Software available to multiple users
other than the users of the single computer for which it is licensed through any means,
including but not limited to uploading the Software to a network or file-sharing service or



through any hosting, application services provider, service bureau, software-as-a-service
(SaaS) or any other type of services. You acknowledge and agree that portions of the Soft-
ware, including but not limited to the source code, file formats, and the specific design and
structure of individual modules or programs, constitute or contain trade secrets of Amnis
and its licensors. Accordingly, you agree not to disassemble, decompile or reverse engineer
the Software or data files, in whole or in part, or permit or authorize a third party to do so,
except to the extent such activities are expressly permitted by law notwithstanding this pro-
hibition.

3. Ownership. The copy of the Software is licensed, not sold. You own the media on
which the Software is recorded, but Amnis retains ownership of the copy of the Software
itself, including all intellectual property rights therein. The Software is protected by United
States copyright law and international treaties. You will not delete or in any manner alter
the copyright, trademark, and other proprietary rights notices or markings appearing on the
Software as delivered to you.

4. Term. The license granted under this Agreement remains in effect for a period of 75
years, unless earlier terminated in accordance with this Agreement. Y ou may terminate the
license at any time by destroying all copies of the Software in your possession or control.
The license granted under this Agreement will automatically terminate, with or without
notice from Amnis, if you breach any term of this Agreement. Upon termination, you must
at Amnis’ option either promptly destroy or return to Amnis all copies of the Software in
your possession or control.

5. Limited Warranty. Amnis warrants that, for thirty (30) days following the date of pur-
chase (or delivery, if Amnis has made the Software available to you without charge), the
Software will perform in all material respects in accordance with the Documentation. As
your sole and exclusive remedy and Amnis’ entire liability for any breach of this limited
warranty, Amnis will at its option and expense promptly correct or replace the Software so
that it conforms to this limited warranty. Amnis does not warrant that the Software will
meet your requirements, that the Software will operate in the combinations that you may
select for Execution, that the operation of the Software will be error-free or uninterrupted,
or that all Software errors will be corrected. The warranty set forth in this Section 5 does
not apply to the extent that Amnis provides you with the Software (or portions of the Soft-
ware) for beta, evaluation, testing or demonstration purposes.

6. DISCLAIMER. THE LIMITED WARRANTY SET FORTH IN SECTION 5 IS IN
LIEU OF AND AMNIS EXPRESSLY DISCLAIMS ALL OTHER WARRANTIES
AND CONDITIONS, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED
TO ANY IMPLIED WARRANTIES AND CONDITIONS OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT, AND
ANY WARRANTIES AND CONDITIONS ARISING OUT OF COURSE OF DEAL-
ING OR USAGE OF TRADE. NO ADVICE OR INFORMATION, WHETHER



ORAL OR WRITTEN, OBTAINED FROM AMNIS OR ELSEWHERE WILL
CREATE ANY WARRANTY OR CONDITION NOT EXPRESSLY STATED IN
THIS AGREEMENT.

7. Limitation of Liability. AMNIS’ TOTAL LIABILITY TO YOU FROM ALL
CAUSES OF ACTION AND UNDER ALL THEORIES OF LIABILITY WILL BE
LIMITED TO THE AMOUNTS PAID TO AMNIS BY YOU FOR THE SOFTWARE
OR, IN THE EVENT THAT AMNIS HAS MADE THE SOFTWARE AVAILABLE
TO YOU WITHOUT CHARGE, AMNIS’ TOTAL LIABILITY WILL BE LIMITED
TO $100. IN NO EVENT WILL AMNIS BE LIABLE TO YOU FOR ANY SPECIAL,
INCIDENTAL, EXEMPLARY, PUNITIVE OR CONSEQUENTIAL DAMAGES
(INCLUDING LOSS OF DATA, BUSINESS, PROFITS OR ABILITY TO
EXECUTE) OR FOR THE COST OF PROCURING SUBSTITUTE PRODUCTS
ARISING OUT OF OR IN CONNECTION WITH THIS AGREEMENT OR THE
EXECUTION OR PERFORMANCE OF THE SOFTWARE, WHETHER SUCH LIA-
BILITY ARISES FROM ANY CLAIM BASED UPON CONTRACT, WARRANTY,
TORT (INCLUDING NEGLIGENCE), STRICT LIABILITY OR OTHERWISE, AND
WHETHER OR NOT AMNIS HAS BEEN ADVISED OF THE POSSIBILITY OF
SUCH LOSS OR DAMAGE. THE FOREGOING LIMITATIONS WILL SURVIVE
AND APPLY EVEN IF ANY LIMITED REMEDY SPECIFIED IN THIS AGREE-
MENT IS FOUND TO HAVE FAILED OF ITS ESSENTIAL PURPOSE.

8. U.S. Government End Users. The Software and Documentation are “commercial items”
as that term is defined in FAR 2.101, consisting of “commercial computer software” and
“commercial computer software documentation,” respectively, as such terms are used in
FAR 12.212 and DFARS 227.7202. If the Software and Documentation are being
acquired by or on behalf of the U.S. Government, then, as provided in FAR 12.212 and
DFARS 227.7202-1 through 227.7202-4, as applicable, the U.S. Government’s rights in
the Software and Documentation will be only those specified in this Agreement.

9. Export Law. You agree to comply fully with all U.S. export laws and regulations to
ensure that neither the Software nor any technical data related thereto nor any direct prod-
uct thereof are exported or re-exported directly or indirectly in violation of, or used for any
purposes prohibited by, such laws and regulations.

10. General. This Agreement will be governed by and construed in accordance with the
laws of the State of Washington, without regard to or application of conflict of laws rules or
principles. The United Nations Convention on Contracts for the International Sale of
Goods will not apply. Y ou may not assign or transfer this Agreement or any rights granted
hereunder, by operation of law or otherwise, without Amnis’ prior written consent, and any
attempt by you to do so, without such consent, will be void. Except as expressly set forth in
this Agreement, the exercise by either party of any of its remedies under this Agreement
will be without prejudice to its other remedies under this Agreement or otherwise. All



notices or approvals required or permitted under this Agreement will be in writing and deliv-
ered by confirmed facsimile transmission, by overnight delivery service, or by certified
mail, and in each instance will be deemed given upon receipt. All notices or approvals will
be sent to the addresses set forth in the applicable ordering document or invoice or to such
other address as may be specified by either party to the other in accordance with this sec-
tion. The failure by either party to enforce any provision of this Agreement will not con-
stitute a waiver of future enforcement of that or any other provision. Any waiver,
modification or amendment of any provision of this Agreement will be effective only if in
writing and signed by authorized representatives of both parties. If any provision of this
Agreement is held to be unenforceable or invalid, that provision will be enforced to the
maximum extent possible, and the other provisions will remain in full force and effect. This
Agreement is the complete and exclusive understanding and agreement between the parties
regarding its subject matter, and supersedes all proposals, understandings or com-
munications between the parties, oral or written, regarding its subject matter, unless you
and Amnis have executed a separate agreement. Any terms or conditions contained in your
purchase order or other ordering document that are inconsistent with or in addition to the
terms and conditions of this Agreement are hereby rejected by Amnis and will be deemed
null.

11. Contact Information. If you have any questions regarding this Agreement, you may con-
tact Amnis at 645 Elliott Avenue, Suite 100, Seattle, WA 98119.

DURING INSTALLATION, IF YOU AGREE TO THE FOREGOING TERMS AND
CONDITIONS AND DESIRE TO COMPLETE INSTALLATION OF THE SOFT-
WARE, PLEASE CLICK THE “I ACCEPT” BUTTON. OTHERWISE, PLEASE
CLICK THE “I DO NOT ACCEPT” BUTTON AND THE INSTALLATION PROC-
ESS WILL STOP.

Disclaimers

The screen shots presented in this manual were created using the Microsoft® Windows®
XP operating system and may vary slightly from those created using other operating sys-
tems.The Amnis® ImageStream® cell analysis system is for research use only and not for
use in diagnostic procedures.

Technical Assistance

Amnis Corporation

645 Elliott Ave. W. Suite 100
Seattle, WA

Phone: 206-374-7000

Toll free: 800-730-7147
WWW.amnis.com
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Chapter 1

Welcome to IDEAS® 6.0

Welcome to the IDEAS version 6 application documentation for ImageStream and
FlowSight data analysis.

How to use this manual

This manual provides instruction for using the Amnis IDEAS® application to analyze
data files from the Amnis ImageStream and FlowSight cell analysis systems.

The intuitive user interface of the IDEAS application makes it easy for you to explore
and analyze data. The application can quantify cellular activity by performing sta-
tistical analyses on thousands of events and, at the same time, permit visual con-
firmation of any individual event. Furthermore, you can operate the applicationin a
batch processing mode and store specific analysis templates for either repeated use
or sharing with colleagues.

The fastest way to put the IDEAS application to work is to first skim through this
manual—becoming familiar with the application’s structure, compensation, file types,
and analysis tools—and then use the application wizards on some sample exper-
imental data to begin exploring the power that the application provides. This manual
has been integrated into the IDEAS application to provide searchable and context
sensitive help. Typing F1 while in the application opens the help files.




What's New in IDEAS 6.0

What's New in IDEAS 6.0

IDEAS 6.0 offers numerous improvements for analyzing data from any ImageS-
tream or FlowSight instrument. Please refer to the web site for the latest improve-
ments and updates to this manual.

1 General

* New user application default settings include setting graph and statistics
exporting formats.

» Color mapping tool has been improved in the application defaults settings.
» Files processed prior to IDEAS version 4.0 may not load in 6.0.
2 Data
* New Feature Finder wizard for choosing a feature.
» Tagging tool updates the number tagged.

» Tagging tool defaults the population symbol to a solid diamond and a new
color for each population for easier viewing in graphs.

3 Features and Masks

* The Valley mask has been improved.

Image Gallery

* The measurement tool is now available in the gallery.
5 Analysis Area

* Moving panels in the analysis area is now easier. Click and drag on the panel
anywhere except the toolbar.

» Panels are aligned by their tops by lines.

» Cursor changed to indicated current state.

Reporting

» Copy/Save graphs and images has been improved. Images may show scale

bar, adjust font sizes, and save as .tif, .png, or .bmp files at 300 DPI. Graph
default settings may be used for fonts, graph sizes, and resolution.

N
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Chapter 1

Setting Up the IDEAS® Application

This chapter describes the hardware and software requirements for
the application, which includes the procedures for installing, remov-
ing, and upgrading the application. The following subsections cover
this information:

Setting Up the IDEAS® Application

Installing the IDEAS Application

Setting Your Computer to Run the IDEAS® Application

Viewing and Changing the Application Defaults

Hardware and Software Requirements

This section states the minimum and the recommended hardware and software
requirements for running the IDEAS application.

Hardware Requirements

The minimum hardware requirements are 4 GB of RAM and a dual core Intel proc-
essor. However, due to the large size of the image files that the ImageStream cell
analysis system creates, a larger amount of RAM will prevent paging and thus
increase performance.

Software Requirements

IDEAS 6.0 64 bit version requires that the Windows 7 operating system be installed
on your computer. IDEAS 32 bit version requires Windows XP, Windows 2000 or
later version of the operating system. The latest service pack and any critical
updates for the operating system must be included. You must also install the Micro-
soft .NET Framework 2.0, which requires Microsoft Internet Explorer 5.01 or later.

Important: If the software requirements are not met, Setup will not block installation
nor provide any warnings.

Note that service packs and critical updates are available from the Microsoft Secu-
rity Web Site.

Installing the IDEAS Application

If the IDEAS application has previously been installed, the previous version will be
removed during installation.

Toinstall IDEAS software

Download the application Setup file from your account at www.amnis.com.
View the contents in My Computer or Windows Explorer.

Double-click Setup.exe.

Follow the instructions until the installation process has completed.

A WN =




Setting Up the IDEAS® Application

MadCap help viewer is installed and opened during installation or upgrade.
Select the language and check box to not show this dialog again.

Anicon appears on the desktop and IDEAS Application appears on the All Pro-
grams menu.

Setting Your Computer to Run the IDEAS® Application

Setting the Screen Resolution
Confirm that the screen resolution is adequate for the IDEAS application. To be able
to view the entire application window, you must set the width of the screen res-
olution to a minimum of 1024 pixels.

To set the screen resolution

1
2

From the Start menu, select Control Panel, and then click Display.
Click the Settings tab to set the screen resolution.

Viewing File Name Extensions
When loading a file, the IDEAS application uses the file name extension to deter-
mine the file type. It will be easier for you to distinguish raw image files, com-
pensated image files, and data analysis files from each other if Windows Explorer
does not hide the extensions.

To view file name extensions

1
2

3

In Windows Explorer, go to Tools > Folder Options.

Click the View tab, and make sure that the Hide extensions for known file types
check box is not selected.

Click OK.

Copying the Example Data Files

Copy datafiles to a single directory on your hard drive. Sample data files are avail-
able on your workstation or at www.amnis.com/login for customers with an account.

To copy the example data files

AW N =

Copy the data files.

Right-click the directory that contains the data files, and click Properties.
Clear the Read-only check box.

Click OK.

Viewing and Changing the Application Defaults
To view or change these defaults, chooseApplication Defaults from
the Options menu, Each tab allows you to view or change the
default settings.
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|| Directories | Populations | Masks I Graph Display I Graph Export | Image Export I Colors |

Default Data Files Directony

C:\Users'sfriend\Desktop \MFkB Translocation FS

Update automatically when file is selected

Default Template Files Directony

C:\Users'sfriend \AppData“\Foaming*Amnis Corporationtemplates

[ Update automatically when file is selected UUse default data directory

Default Batch Report Files Directory

C:\Users'sfriend \AppData“Roaming*Amnis Corporation“batches

[ Update automatically when file is selected

Default Compensation Matrix Files Directory

C:\Users"sfriend \App Data“\Foaming“Amnis Comporation \compensation

[ Update automatically when file is selected Use default data directory

The Directories tab contains the default Data, Template, Batch or Compensation
Matrix file directories.




Setting Up the IDEAS® Application

|| Directories | Populations I Masks I Graph Display I Graph Export | Image Export I Colars |

Default Data Files Directory

C:\Users'sfriend \Desktop NFkE Translocation FS

Update automatically when file is selected

Default Template Files Directony

C:M\Users'sfriend App Data"\Roaming Amnis Corporationtemplates

7] Update automatically when file is selected Use defautt data directory

Default Batch Report Files Directory
C:hUserssfiend"App Data" Roaming"Amnis Corporationbatches

[ Update automatically when file is selected

Default Compensation Matrix Files Directory
C:hUserssfiend \App Data" Roaming"Amnis Corporation 'compensation

[ Update automatically when file is selected Use default data directory

oK | | Cancel

The Populations tab contains the default color or symbol for populations. To change
the default settings, click on the color to or choose a default symbol from the list.
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||| Directories Populations | Masks I Graph Display I Graph Export I Image Export I Colorsl

| oefaukcolor: [ ]

Default Symbol:  Simple Dot -

The Masks tab contains the default mask color. To change the color of the mask
click on the color button.

L hl

|| Directories | F‘opulatior15| Masks |Gmph Display I Graph Export I Image Export | Color5|

|| Default Color:

The Graph Displaytab contains the default list of statistics shown for a graph.
Check the box next to the statistic to have it show below the graphs when statistics
are shown for a graph. The default graph size and font size for the graphs in the anal-
ysis area may be changed in this tab.

I

I Directoﬁ&il F‘opulationsl Masks| Graph Display |G|aph Export | Image Export ICoIors|

Default Graph Statistics Default Graph Size

Count @ Small
] %Total

[V] “Gated

[ %Ploti=d
[] Objects/mL

M
E M::::m Default Graph Font Sizes

[] Std. Dev.
] MAD Title: [12 =
] cv
[] Minimum fods Labels: (10
[] Madmum
[] Geo. Mean Tick Mark Labels: (10 =

] Mode
] Varance Region Mames: |10

] NaN

Update Graphs in Analysis Area

[ Graph Size

[ Font Sizes

[ Statistics




Setting Up the IDEAS® Application

The Graph Export tab contains the default settings for printing and exporting graphs
when copying and pasting from IDEAS for reporting into other programs.

|i| Directories I Populations I Masks I Graph Displa}f| Graph Export |Image Export ICoIors |

Graph
Size (300 DPT)

Width: (1027 =]  Height: [0.947 = [E

Lock aspect ratio

Fort Size

Title: “ Tick mark labels:
Pois labels: |12 = Region names:

Default export settings to @ Graph 0 Defaults

Graph Options
] Legend Show sample name in title
] Cursor

[ Statistics
Font Size

Title: |12 - Values:
Headers:

The Image Export tab contains the default settings for image export when copying
and pasting from IDEAS for reporting into other programs.
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I

||| Directories I Populations I Masks I Graph Display I Graph Export | Image Export | Colors

Options
Show channel names l_
[ Show object number Show scale bar

Background
@ Black ) White @ Transparent

Fort Sizes

Channel names: |12 =

Scalebar: (12 =

Object number: |10 =

The Colors tab contains the mapping of dark and light mode colors.

4~ Application Defaults

Directories | Populations | Masks [ Statistics [ Graphs | Image Export | Colors

Map population colors for light and dark graph backgrounds

Select a dark mode color a light mode color

ORECE N R
o {mfof T IRl fafof [
I Il
I T
EEEEEN EEEEEN

[ Update Populations in Open Files ]
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Chapter 2

Overview of the IDEAS® Application

This chapter provides an overview of the IDEAS application user
interface, the files that the IDEAS application creates and uses, the
recommended directory organization and an overview of the work-
flow.

Understanding the Data Analysis Workflow

Overview of compensation, analysis tools and file structure

The Amnis cell analysis systems possess unique capabilities that neither flow
cytometry nor microscopy alone can deliver. The IDEAS application provides an
image gallery to view every cell in the data file along with linked graphical data for
confident gating and image confirmation. The application contains powerful algo-
rithms that facilitate and quantify the image analysis of ImageStream and FlowSight
Ql data. Examples include the analysis of molecule co-localization and trans-
location, the analysis of cell-to-cell contact regions and signaling interactions, the
detection of rare molecules and cells, and a comprehensive classification of large
numbers of cells. The IDEAS application acquires data from INSPIRE™, com-
pensates the images, and allows the user to evaluate images with data analysis
tools. For more information about the QI and non-Ql FlowSight data see Comparing
the FlowSight basic, Quantitative Imaging and ImageStream data files.

-14 -



Comparing the Flow Sight basic, Quantitative Imaging and ImageStream data files

Comparing the FlowSight basic, Quantitative Imaging and
ImageStream data files

There are three types of instruments that collect data for Image Analysis in IDEAS:
The FlowSight without Quantitative Imaging (Ql), The FlowSight with the QI upgrade
and the ImageStream. There are some differences in the available features and anal-
ysis that can be done. The table below outlines these differences.

Data comparison

FlowSight - basic

FlowSight - QI

ImageStream

Default template

INSPIRE features
and acquisition anal-
ysis

IDEAS default fea-
ture set - analysis

IDEAS default fea-
ture set - no analysis

Default compensation
matrix

INSPIRE matrix

No compensation

No compensation

Combined features

New feature calculation only Unlimited Unlimited
User defined masks No Yes Yes
INSPIRE mask cal- [Default (Object) Default (Object)
Default mask culated during acquimask computed in  |mask computed in
sition IDEAS IDEAS
Open File, Display
Wizards Properties and Complete set Complete set
Begin Analysis
Building blocks All All All
Merging files No Yes Yes
. Intensity and All features and All features and
Compensation
Images only Images Images
Create new files from
populations e e e
IDEAS Requires version  [Requires version  |Can open in 4.0 or

5.0.x or later

5.0.x or later

later

-15 -



Chapter 2

Understanding the Data Analysis Workflow

Data analysis in IDEAS begins with opening a raw image file (.rif) that was collected
and saved using INSPIRE. Then, an existing compensation matrix or a new com-
pensation matrix is applied to the .rif file and two additional files are created, the .cif
(compensated image file) and .daf (data analysis file).

A compensation matrix performs fluorescence compensation, which removes flu-
orescence that leaks into other channels. See Overview of Compensation for more
information about compensation. A compensated image can accurately depict the
correct amount of fluorescence in each cell image. Compensation is defined as the
correction of the fluorescence crosstalk. When creating the .cif the IDEAS appli-
cation also automatically performs corrections to the raw imagery using values
saved from the instrument at the time of data collection. These corrections include
flowspeed normalization, brightfield gains, and spatial registry.

A template is used to define the features, graphs, image display properties and anal-
ysis for the .daf. Within the .daf file, the user can perform many analyses using the
tools and wizards within the application and save the results as a template file (.ast).

The IDEAS application then calculates feature values and shows the data as spec-
ified by the selected template.

Once a data analysis file (.daf file) or compensated image file (.cif file) is saved, it
can be opened directly for data analysis. You would only open a .cif if you wanted to
change the template or a .rif file to change the compensation.

The diagram on the next page displays this workflow.

-16 -



Understanding the Data Analysis Workflow

INSPIRE IDEAS

Data Collection Spectral Compensation Data Analysis
[ i I T o ]
Compensated Data
Image Analysis
£xp ] Sam File File
- [ Laahat 11 1]
h ey daf
o0 R
et HN
Template .
Contral Samples @0 @ File
Compensation
. E E Mlatrin Aast |
e -{) A
: BRSNS Sl

Batch Processing

Conrnue further

barch peoeiiing

Overview of Data Analysis Workflow

1 Create a compensation matrix using the single color control files. Open an exper-
imental .rif file or from the Compensation menu choose Create New Matrix.

2 A .cif and .daf file are automatically created. Analyze the experimental file using
data analysis tools in the .daf file to create an analysis template.

3 Create a statistics report table within the .daf file and save the data file, as an
anlaysis template.

Note: this is usually done on the positive and negative controls to create the appro-

priate analysis and then applied to the rest of the experimental files in the next step.

4 Perform batch processing, applying compensation and template files created
above.
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Overview of the Data File Types

Data from the Amnis cell analysis systems are collected and managed using three
types of data files: raw image file (.rif), compensated image file (.cif), and data anal-
ysis file (.daf).

This section describes each file type and the table summarizes the features of each
file.

Raw Image File (.rif)

The INSPIRE application saves the digital image data, pixel intensities and location
that were acquired by the instrument to a .rif file.

A .rif file contains:

» Pixel intensity data (counts and location) collected for each object that the
instrument detected.

* Instrument settings that were used for data collection.
+ Calibration values from ASSIST.
« Compensation matri x if used while acquiring data.

Compensated Image File (.cif)

The IDEAS application creates a .cif file when the user opens a .rif file and applies a
compensation matrix. The segmentation algorithm automatically defines the bound-
aries of each object, creating a mask that is used for calculating feature values. The
applied compensation matrix performs pixel-by-pixel fluorescence compensation
prior to segmentation.During the creation of the .cif file, the application makes cor-
rections to the imagery. These corrections include:

* Removal of artifacts from variability in the flow speed, camera background,
and brightfield gains.

» Alignment of the objects to subpixel accuracy, which allows the viewing of
compensated imagery, composite imagery and the calculation of multi-image
feature values, such as the Internalization value.

» Coincident objects are cut apart to place into individual image frames. Note
that this will increase the number of objects in the file.

Multiple .cif files can be created from a single .rif file by applying a different flu-
orescence compensation matrix or correction each time a .rif file is opened and
choosing a unique name for the .cif file. Similarly, you can create a new .daf file from
a single .cif file by creating a new name and applying a different analysis template.

Data Analysis File (.daf)

The IDEAS application creates a .daf file while it is loading a .cif file into a template
file (.ast). The .daf file is the interface to visualize and analyze the imagery that the
.cif file contains and must reside in the same directory as the corresponding .cif file.

The .daf file contains:
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* Feature definitions

* Population definitions

» Calculated feature values

* Image display settings

» Definitions for graphs and statistics

Loading a .daf file restores the application to the same state it was in when the file
was saved, i.e., with the same views, graphs, and populations. In IDEAS versions
3.0 or later, a .daf file may be used as a template.

Note: When a .daf file is opened, the .cif file must be located in the same directory
as the .daf file since the .daf file points to images used for analysis that are stored in
the associated .cif file.

Template (.ast)

The IDEAS application saves the set of instructions for an analysis session in a .daf
file to a template (.ast file). Note that a template contains no data; it simply contains
the structure for the analysis. This structure includes definitions for:

* Features
» Graphs
* Regions

* Populations
The .ast also contains settings for:

* Image viewing
* Image names
» Statistics

The \templates subdirectory (under the directory where the IDEAS application
was installed) contains the default template, named defaulttemplate.ast. Because a
template is required for loading a .cif file, you must use the default template to create
the first .daf file. After you save a custom template, you can use it for any sub-
sequent loads of .cif files.

Note: The default template may change between releases of the IDEAS application
software. In IDEAS versions 3.0 or later, a .daf file may be used as a template. The
default template contains over 200 calculated features per object. An expanded tem-
plate is also available that includes over 600 calculated features per object. The
FlowSight without the Quantitative Imaging upgrade has a limited set of features
available.

Compensation Matrix File (.ctm)

The IDEAS application saves the compensation values that are created and saved
during the spectral compensation of control files to a compensation matrix file (.ctm
file). This file has no associated object data; it is created and saved to be applied to
experimental files. The compensation matrix can be created in IDEAS using single
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color control files after acquisition or during acquisition. See the INSPIRE or Flow-
Sight manual for more information.

Review of Data File Types
Table 1: Review of Data File Types

File Acronym and

File Creation Description
Name

Contains instrument setup data, pixel intensity data,
.rif . and uncorrected image data from the INSPIRE appli-
Raw Image File Created in INSPIRE cation. The IDEAS application uses the .rif file to create
a compensated image file (.cif file).
Contains imagery that has been corrected for variations
in the camera background, camera gains, flow speed,
and vertical and horizontal positioning between chan-
nels.
User creates a .cif Serves as a database of images used for feature-value
from the .rif and .ctm |calculations and imagery display.
The IDEAS application also performs fluorescence com
pensation, if necessary, when creating a .cif file.
The IDEAS application loads the .cif file into a template
to create a data analysis file (.daf file)
The main working data file that contains the calculated
References the .cif  |feature values, the graphs, and the statistics used for
analysis. The .daf file references the .cif.
This file contains no data; it contains the structure for
.ast _ Created from the daf the.analysis, such a§, def!nitions for f.eatures., graphs,
Template File regions, and populations; image viewing settings;
image names; and statistics settings.

Contains compensation values that are created and
User creates new . . .
.ctm . saved during the spectral compensation of control .rif
Compensation -ctm when opening a files. This file has no associated object data; it is

Matrix File .Srifkc))rr]durlng acqu | reated and saved to be applied to experimental .rif
files.

.Cif
Compensated
Image File

.daf
Data Analysis File

Note about Case Sensitivity: Even though Windows does not treat file names as
case sensitive, the IDEAS application depends on the case-sensitive .rif, .cif, and
.daf file name extensions to identify the file types. Avoid the use of illegal characters
for file names such as: “\/:*?<>1”.
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Getting Started with the IDEAS Application

This chapter is divided into two sections. First, guided analysis is
described using the analysis wizards and second, advanced anal-
ysis with more detailed instructions that describe how to open, com-
pensate, merge, save, and create data files without using the
wizards. Building blocks are also discussed which provide a short
cut method to building commonly used graphs.

Guided analysis makes it easy to start analyzing your data. Once
you are familiar with the basic analysis available you may want to
perform more advanced analysis.

Note that data files from FlowSight without the Quantitative Imaging
upgrade have a limited feature set and limited wizard analysis.

General Outline of data analysis:

Note that these steps apply to any type of data analysis whether you use a wizard or
not.

1 Open one data file (the + or - control).

2 Create and save a compensation matrix for the experiment.

3 Using an application wizard or the begin analysis wizard:
» Select focused cells.
« Select single cells (or conjugates).
» Select channels for subpopulation markers and gate to define subpopulations.
* Gate on positive cells for the channels you wish to use for morphological anal-

ysis.

4 By using an application wizard evaluate the feature for your analysis and refine

as needed. Or follow the feature finder wizard to find the feature that separates

your populations.Note that if the morphological differences are in separate files
this may require merging both a + and - control before beginning step 1.

5 Refine the analysis and save the template.

6 Perform batch analysis on all data files in the experiment using the compensation
matrix and analysis template.
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Guided Analysis

Data analysis always begins with opening a data file. The Start Analysis button will
step you through opening a file, setting the image display mapping and choosing an
analysis wizard.

Application wizards are available to guide you through an analysis. The wizards can

be accessed from the Guided Analysis menu or the wizard tool | A |or at the end of

the Start Analysis routine.

The following wizards are available:

| “&, Wizards

Select the wizard to use for analysis:

es 3 template to faciltate analysis.

Display Properies Automatically sets image display properties.

Begin Analysis Identifies single, focused, fluorescent positive cells.

Assists the userin picking relevant features for separating populations.

Feature Finder The file must contain members of each population.

Apoptosis Creates an analysis late for identifying apoptotic events based on brightfield and nuclear morphology.

Cell Cycle - Mitosis Creates an analysis template that distinguishes mitotic and apoptotic events.

Codocalization Creates an analysis template for measuring the codocalization of two probes on, in , or between cells in your sample.

Intemalization Creates an analysis template for measuring the intemalization of a probe.

Muclear Localization Creates an analysis template for measuring the nuclear localization of a probe.

Shape Change Creates an analysis template for measuring circular morphology.

Spot Creates an analysis template for measuring testure based on spot counting.
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Application Wizards

General:

*  Open File Wizard:
— Guides you through the process of opening a data file and setting image
display mapping in the image gallery.
» Display Properties:
— Sets image display mapping in the image gallery.

» Begin Analysis:
— Guides you through finding focused, single, positive cells.

* Feature Finder:
— Guides you through finding focused, single, positive cells.

Application specific:

* Apoptosis Wizard
— Guides you through the process of creating the features and graphs for
analyzing apoptosis.
» Cell Cycle - Mitosis Wizard

— Guides you through the process of creating the features and graphs for
analyzing the cell cycle and enumerating mitotic events.

¢ Co-localization Wizard

— Guides you through the process of creating the features and graphs for
analyzing the co-localization of 2 probes.

¢ |Internalization Wizard

— Guides you through the process of creating the features and graphs for
analyzing the internalization of a probe.

* Nuclear Localization Wizard
— Guides you through the process of creating the features and graphs for
analyzing the nuclear localization of a probe.
*  Shape Change Wizard
— Guides you through the process of creating the features and graphs for
analyzing the circular shape of a cell using a surface stain or brightfield
image.

* Spot Wizard
— Guides you through the process of creating the mask, feature and graphs
for analyzing fluorescently labeled spots in images.

The wizard window is organized so that the instructions for each step are written in
the left side of the window, the stepwise progress through the wizard is shown in the
list on the right side and there may be tips provided at the bottom of the window.
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Click Next to progress through the wizard or Exit to stop at any time. Some steps
are optional and a Skip button is provided. Follow the instructions in the wizard to
complete an analysis.

[ Instructions J © -
W a region around the single cells on the Area vs. Aspect Ratio scatter plot 1. Select nuclear image

I to create a single cells population 2 Gate single cells
3 Gate cells in bestfocus

Or
4. Gate fluorescence positives
Select an existing single cells population. 5 Select subpopulation marker(s)
6. Gate subpopulation(s)
Single Cell Al [= 7. Select additional subpopulation marker

8. Gate additional subpopulationis)
9. Gate apoptotic events

: Click on the dots in the scatter plot to see the comesponding image in the
[Mrage gallery

Tip2: If you wish to change the plot properties, right-click on the plot and select
| "Graph Properties..."
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Open File Wizard:

This wizard will guide you through the opening of a data file and setting the image dis-
play mapping. Use this wizard to open a file if you are not using one of the appli-
cation specific wizards.

£ o

To begin, double-click on Open File

Follow the instructions to open your file.

Tip: You can limit the view to specific file types (.daf, .cif or .rif) by using the drop-
down menu ‘Files of type:’ in the Select Data File window.

A .daf file will open directly without further input, a .cif file will require a template and
a .rif file will require a template and a compensation matrix. If the template or com-
pensation matrix boxes are left blank, the default template and/or matrix will be
applied. For more information on opening data files see Opening data files .

Open, File Wizard

Step 1: Select the data file you wish to open

Step Progress

ct data file to open

Thiz wizard will take you through the steps involved in opening ImageStream
data filez. There are 3 types of data files that can be opened in IDEAS:

Fiaw Image File [.1if]: uncompensated data from the instrument
Compensated Image File [.cif; compensated data
[rata Analysis File [ daf]: analyzed data

Click the folder button to select the file to open

|

Once a data file is open you may begin analysis.
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Display Properties Wizard

This wizard is automatically run when you use the other analysis wizards or the
Open File wizard. It is also available to run in any open data file from the Guided Anal-
ysis menu or from the wizard icon. This wizard will set the image display mapping for
the channel images you select and create a view of selected images. Brightfield and
scatterimages will be automatically selected.

To begin, select wizards from the Guided Analyis menu or click the wizard icon in
the analysis area toolbar.

X

The Wizards window opens.

* Wizards

Select the wizard to uge for analyzis:

Mame

Dizplay Properties

Apoptosiz
. Cell Cycle - Mitosiz

Drescription

Opening ImageStream data files.

Automatically sets image display properties.

Creates an analyzis template for identifying apoptotic events based
on brightfield and nuclear morphology.

Creates an analyzis template that distinguishes mitotic and apoptotic
events.

()8 l ’ Cancel

Double-click on the Display Properties option and follow the instructions.

The Display Properties adjusts the mapping of the pixel intensities to the display
range for optimizing the display and creates a view that includes the chosen chan-
nels. This is for display only and does not effect the pixel values. For more infor-

mation on image display see Setting the Image Gallery Properties.

B Display Properties Wizard

fitmp.1: fied smpar dinnlax nrosedio

71/

charrs aed . s axpasesere.

Chk ot b e
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Begin Analysis Wizard

This wizard is available once a data file is open and will guide you through choosing
the focused cells, then single cells, then choosing subsets of fluorescent positive
cells for phenotypic analysis before progressing on to a morphological analysis.

Open a data file using the Start Analysis button or by choosing Wizards from the
Guided Analysis menu. The wizards selection screen will appear once the data file is
open. If you have an open data file and want to access this wizard, choose Wizards
from the Guided Analysis menu.

Beain Analysis

To begin, double-click on Begin Analysis

Step 1. Gate cells in best focus

A histogram of the brightfield channel Gradient RMS values for the 'All' population
has been added to the analysis area. Click on the bins in the histogram to view the
images in each bin. The cells with better focus have higher Gradient RMS, values.
Begin your region at the bin after the Gradient RMS value you wish to exclude and
continue the region to the maximum in the plot. You may choose an already existing
population.

Step 2. Gate single cells

A scatter plot of the brightfield Area versus Aspect Ratio for the population chosen in
step one has been added to the analysis area. Single cells will have an intermediate
Area value and a high Aspect Ratio. Click on the dots to view the image associated
with that dot. Note that the image is surrounded by a light green line and the image
next to it in the image gallery is not it's neighbor in the plot. The images are pre-
sented in the order of acquistion.You may choose an already existing population.

Step 3. Select subpopulation marker(s)

Choose one or two channels you wish to use to identify populations based on Inten-
sity. Click Next to add the scatter plot to the analysis area. Click Skip if you do not
wish to use this step. Draw regions in the scatter plot to identify as many pop-
ulations as you want. This step will be repeated until you choose Skip or Finish.

The statistics Count and Percent Gated are added to the Population Statistics table
in the analysis area and a statistics definition is added to the template. To view the
definition choose Define Statistics Report from the Reports menu.
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Feature Finder Wizard

The feature finder wizard will guide you through the process of choosing a feature for
morphological analysis when a specific application wizard is not appropriate. This
wizard is available once a data file is open and will guide you through choosing the
focused cells, then single cells, then choosing subsets of fluorescent positive cells
for phenotypic analysis before progressing on to choosing a feature for mor-
phological analysis.

Open a data file that contains images of both phenotypes you wish to separate.Note
that it may be necessary to merge two files together if the populations are in sep-
arate files. Open the data file using the Start Analysis button or by choosing Wizards
from the Guided Analysis menu. The wizards selection screen will appear once the
data file is open. If you have an open data file and want to access this wizard,
choose Wizards from the Guided Analysis menu or click the wand icon.

Feature Finder

To begin, double-click on Feature Finder

Step 1. Gate cells in best focus

A histogram of the brightfield channel Gradient RMS values for the 'All' population
has been added to the analysis area. Click on the bins in the histogram to view the
images in each bin. The cells with better focus have higher Gradient RMS, values.
Begin your region at the bin after the Gradient RMS value you wish to exclude and
continue the region to the maximum in the plot. You may choose an already existing
population. Click Next.

Step 2. Gate single cells

A scatter plot of the brightfield Area versus Aspect Ratio for the population chosen in
step one has been added to the analysis area. Single cells will have an intermediate
Area value and a high Aspect Ratio. Click on the dots to view the image associated
with that dot. Note that the image is surrounded by a light green line and the image
next to it in the image gallery is not it's neighbor in the plot. The images are pre-
sented in the order of acquistion.You may choose an already existing pop-
ulation.Click Next.

Step 3. Select subpopulation marker(s)

Choose one or two channels you wish to use to identify populations based on Inten-
sity and include the channel(s) you are going to use for morphological analysis. Click
Next to add the scatter plot to the analysis area. Click Skip if you do not wish to use
this step. Draw regions in the scatter plot to identify as many populations as you
want. This step will be repeated until you choose Skip or Finish.
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Step 4. Assign truth populations

Choose two truth populations of cells that represent one morphological phenotype dif-
ference you wish to separate. Use the tagging tool icon to hand-tag images or select
pre-existing gated populations. Note: If there are more than one phenotypic dif-
ferences, repeat the process for each with new truth populations.

Step 5. Select channels and feature categories

Choose the channel and feature category you wish to explore. Multiple rows may be
entered. The features in the table below will be created and calculated. All of the
default features, newly created features and user defined features in the chosen cat-
egories will be evaluated for their ability to separate the truth populations. The three
highest ranking features for each category will be saved and available for evaluation.

Step 7. Results

The top ranking features are listed in the table with their category and channel. A Sta-
tistics table is added to the analysis area that lists the features with the RD Mean for
the truth populations. RD is the Fischer's discriminant ratio which is the difference in
the means divided by the sum of the standard deviations for the two populations.

The larger the RD value, the better the separation afforded by the feature. A scatter
plot is added to the analysis area of the truth populations for the top two features.

It may be necessary to refine your results. Visually verify the morphology and sep-
aration for the features listed. Additional features may be quickly plotted by selecting
them in the list and clicking 'Plot Features'. To return to the truth population assign-
ment step click 'Refine populations'. To choose different channels or categories
click 'Change Category'.

Table 1: List of additional features (beyond default) that are created and explored in
the Feature Finder wizard

e Feature name and description Mask used
category
. Location Features are in X,Y pixel coordinates from an origin
Location . .
in the upper left corner, pixels or contour
Delta Centroid XY Feature
The distance between the Centroids of the intensity weighted and |channel mask
non-intensity weighted image
Shape Shape Features define the mask shape and have units that

vary with the feature.

Aspect Ratio Feature

The ratio of the Minor Axis divided by the Major Axis. Rl

Circularity Feature

The degree of the mask’s deviation from a circle. Object

Compactness Feature Obiect
Describes the density of intensities within the object. )

Elongatedness Feature

The ratio of the Height/Width which use the bounding box. Object

Lobe Count Feature Object
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FELD Feature name and description Mask used
category
The number of lobes in a cell. (Also see Symmetry)
Shape Ratio Feature Object
The ratio of Thickness Min/Length features.
Symmetry 2, 3, 4 Features
These three features measure the tendency of the object to have a .
single axis of elongation, a three-fold and a four-fold variation of the Object
shapes.
Size Size-based Features are in microns.
Area Feature Object, Thresh-
The size of the mask in square microns. old 30,50,70 %
Height Feature
Based on a bounding rectangle, the Width is the smaller side and  [Object
the Height is the longer side of the rectangle.
Length Feature Object
Measures the longest part of the mask.
Major Axis and Minor Axis Features
Describes the widest part of the mask and the narrowest part of the|Object
mask, respectively.
Perimeter Feature Object, Thresh-
Describes circumference of the mask. old 30,50,70 %
Thickness Max Feature Object
Describes the longest width of the mask.
Thickness Min Feature Object
Describes the shortest width of the mask.
Width Feature
Based on a bounding rectangle, the Width is the smaller side and  |Object
the Height is the longer side of the rectangle.
Texture features measure pixel or regional variation and indi-
Texture . . .
cate the granularity or complexity of the image.
Contrast Feature Morphology
Enumerates changes of pixel values in the image to measure the . ’
; : Object
focus quality of an image.
H Texture Features Channel mask
Measures Haralick texture features. Granularity settings 1,5,15,19
Modulation Feature Morphology
Measures the intensity range of an image, normalized between 0 . ’
Object
and 1.
Spot Count Feature
Eﬁumerates the number of spots. CIEmE] s
Std Dev Feature Morphology,
Describes the overall distribution of pixel intensities. Object
glt?:::;th Signal Strength Features are measured in pixel values.
Intensity Feature Morphology,
The sum of the pixel intensities in the mask, background sub- Object, Thresh-
tracted. old 30,50,70 %
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The statistics Count and Percent Gated are added to the Population Statistics table
in the analysis area and a statistics definition is added to the template. To view the
definition choose Define Statistics Report from the Reports menu.
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Apoptosis Wizard

The apoptosis wizard will guide you through the process of creating the features and
graphs to measure apoptosis using the images of the nuclear dye and brightfield.
Begin by opening a data file and then choosing the Apoptosis wizard.

( =
Apoptosis

To begin, double-click on Apoptosis

Follow the instructions to analyze your file.

Step 1. Select the nuclear image channel

From the drop down menu pick the nuclear channel image.
Step 2. Gate cells in best focus

A Gradient RMS histogram of the All population has been added to the analysis area.
Click on the bins in the histogram to view the images in each bin. The cells with
better focus have higher Gradient RMS, values. Begin your region at the bin after the
Gradient RMS value you wish to exclude and continue the region to the maximum in
the plot. You may choose an already existing population.

Step 3. Gate single cells

A scatter plot of Area versus Aspect Ratio has been added to the analysis area. Sin-
gle cells will have an intermediate Area value and a high Aspect Ratio. Click on the
dots to view the image associated with that dot. Note that the image is surrounded
by a light green line and the image next to it in the image gallery is not it's neighbor in
the plot. The images are presented in the order of acquistion.

Step 4. Optional

Answer Yes if you want to define subpopulations in your experiment.

Select subpopulation marker(s)

Choose one or two channels you wish to use to identify populations based on Inten-
sity. Click Next to add the scatter plot or histogram to the analysis area. Click Skip if

you do not wish to use this step.

Next Step. Gate subpopulations step number sequence is dependent on the
number of times the subpopulation marker step is taken.

Draw regions in the scatter plot or histogram to identify as many populations as you
want. This step will be repeated until you choose Skip.
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Next Step. Optional - Select additional subpopulation marker(s) OR. Gate
nucleated cells.

A histogram of the nuclear channel Intensity is added to the analysis area. Gate on
the positive events.

Next Step . Gate apoptotic cells

The nucleated cells scatter plot of the brightfield Contrast versus the Area of the
thresholded nucleus is added to the analysis area. Gate on the apoptotic cells with
low nuclear area and high brightfield contrast.

The statistics Count and Percent Gated are added to the Population Statistics table
in the analysis area and a statistics definition is added to the template. To view the
definition choose Define Statistics Report from the Reports menu.
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Cell Cycle - Mitosis Wizard

The cell cycle - mitosis wizard will guide you through the process of creating the fea-
tures and graphs to analyze the cell cycle and identify mitotic events using the
images of a nuclear dye.

Cell Cycle - Mitosis

To begin, double-click on Cell Cycle - Mitosis

Follow the instructions to analyze your file.

Step 1. Select the nuclear image channel

From the drop down menu pick the nuclear channel image.
Step 2. Gate cells in best focus

A Gradient RMS histogram of the All population has been added to the analysis area.
Click on the bins in the histogram to view the images in each bin. The cells with
better focus have higher Gradient RMS, values. Begin your region at the bin after the
Gradient RMS value you wish to exclude and continue the region to the maximum in
the plot. You may choose an already existing population.

Step 3. Gate single cells

A scatter plot of Area versus Aspect Ratio has been added to the analysis area. Sin-
gle cells will have an intermediate Area value and a high Aspect Ratio. Click on the
dots to view the image associated with that dot. Note that the image is surrounded
by a light green line and the image next to it in the image gallery is not it's neighbor in
the plot. The images are presented in the order of acquistion.

Step 4. Optional

Answer Yes if you want to define subpopulations in your experiment.

Select subpopulation marker(s)

Choose one or two channels you wish to use to identify populations based on Inten-
sity. Click Next to add the scatter plot or histogram to the analysis area. Click Skip if

you do not wish to use this step.

Next Step. Gate subpopulations step number sequence is dependent on the
number of times the subpopulation marker step is taken.

Draw regions in the scatter plot or histogram to identify as many populations as you
want. This step will be repeated until you choose Skip.
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Next Step. Optional - Select additional subpopulation marker(s) OR. Gate
G2/M cells.

A histogram of the nuclear channel Intensity is added to the analysis area. Gate on
the G2/M population with 2n DNA.

Next Step . Gate cells with condensed DNA

The G2/M cells scatter plot of the threshold Area versus Bright Detail Intensity of the
nuclear image is added to the analysis area. Gate on the cells with condensed
nuclear that have low nuclear area and high Bright Detail Intensity values These will
include apoptotic cells which you can remove in the next step.

Next Step . Gate mitotic cells

The condensed DNA cells scatter plot of the brightfield Contrast versus the Area of
the thresholded nucleus is added to the analysis area. Gate on mitotic events with
low brightfield Contrast.

The final 3 plots are shown below:

QG S [FT ERY= BN BIGE ELY- R
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The statistics Count and Percent Gated are added to the Population Statistics table
in the analysis area and a statistics definition is added to the template. To view the
definition choose Define Statistics Report from the Reports menu.
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Co-localization Wizard

The co-localization wizard will guide you through the process of creating the features
and graphs to measure the co-localization of two probes in any population of cells
you identify.

Codocalization

To begin, double-click on Co-localization

Follow the instructions to analyze your file.
Step 1. Select the co-localization image channels

From the drop down menus pick the two image channels that contain the co-local-
izing probes.

Step 2. Gate cells in best focus

A Gradient RMS histogram of the All population has been added to the analysis area.
Click on the bins in the histogram to view the images in each bin. The cells with
better focus have higher Gradient RMS, values. Begin your region at the bin after the
Gradient RMS value you wish to exclude and continue the region to the maximum in
the plot. You may choose an already existing population.

Step 3. Gate single cells

A scatter plot of Area versus Aspect Ratio has been added to the analysis area. Sin-
gle cells will have an intermediate Area value and a high Aspect Ratio. Click on the
dots to view the image associated with that dot. Note that the image is surrounded
by a light green line and the image next to it in the image gallery is not it's neighbor in
the plot. The images are presented in the order of acquistion.

Step 4. Optional

Answer Yes if you want to define subpopulations in your experiment.

Select subpopulation marker(s)

Choose one or two channels you wish to use to identify populations based on Inten-
sity. Click Next to add the scatter plot or histogram to the analysis area. Click Skip if

you do not wish to use this step.

Next Step. Gate subpopulations step number sequence is dependent on the
number of times the subpopulation marker step is taken.
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Draw regions in the scatter plot or histogram to identify as many populations as you
want. This step will be repeated until you choose Skip.

Next Step. Gate double positives

A scatter plot of the last gated (or selected) population of the Intensity values for the
co-localization channels is added to the analysis area. Draw a region around the dou-
ble positive cells for the co-localizing probes.

Next Step. Gate co-localized events

A histogram of Bright Detail Similarity R3 for the double positive population is added
to the analysis area. Draw a region to gate on co-localized events.

RL -2kt

0y COADTSF Cpoll

Low co-localization High co-localization

For a more thorough explanation of the Bright Detail Similarity feature see Bright
Detail Similarity R3 Feature

The statistics Count and Percent Gated are added to the Population Statistics table
in the analysis area and a statistics definition is added to the template. To view the
definition choose Define Statistics Report from the Reports menu.

-38 -



Guided Analysis

Internalization Wizard

This wizard will create an analysis template for measuring the internalization of a
probe in any population of cells you identify.

Intemalization

To begin, double-click on Internalization

Follow the instructions to analyze your file.
Step 1. Select the internalization image channels

From the drop down menus pick the cell image, the channel that defines the cell sur-
face, and the internalizing probe channel.

Step 2. Gate cells in best focus

A Gradient RMS histogram of the All population has been added to the analysis area.
Click on the bins in the histogram to view the images in each bin. The cells with
better focus have higher Gradient RMS, values. Begin your region at the bin after the
Gradient RMS value you wish to exclude and continue the region to the maximum in
the plot. You may choose an already existing population.

Step 3. Gate single cells

A scatter plot of Area versus Aspect Ratio has been added to the analysis area. Sin-
gle cells will have an intermediate Area value and a high Aspect Ratio. Click on the
dots to view the image associated with that dot. Note that the image is surrounded
by a light green line and the image next to it in the image gallery is not it's neighbor in
the plot. The images are presented in the order of acquistion.

Step 4. Optional
Answer Yes if you want to define subpopulations in your experiment.
Select subpopulation marker(s)

Choose one or two channels you wish to use to identify populations based on Inten-
sity. Click Next to add the scatter plot or histogram to the analysis area. Click Skip if
you do not wish to use this step.

Next Step. Gate subpopulations step number sequence is dependent on the
number of times the subpopulation marker step is taken.

Draw regions in the scatter plot or histogram to identify as many populations as you
want. This step will be repeated until you choose Skip.
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Next Step. Optional - Select additional subpopulation marker(s) OR. Gate
internalization positives

A scatter plot of Max Pixel versus Intensity for the internalizing probe is added to the
analysis area. Draw a region to include the positive cells.

Next Step. Gate internalization events

A histogram of the Internalization feature for the positive cells is added to the anal-
ysis area. Draw a region to include the cells with high internalization. The example
below shows the internalization of labeled CpG (red).

Low intemalization. _Fitgh Internalization

For a more thorough explanation of the Internalization feature seelnternalization
Featurelnternalization Feature

The statistics Count and Percent Gated are added to the Population Statistics table
in the analysis area and a statistics definition is added to the template. To view the
definition choose Define Statistics Report from the Reports menu.
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Nuclear Localization Wizard

This wizard will create an analysis template for measuring the nuclear localization of
a probe in any population of cells you identify.

Muclear
Localization

To begin, double-click on Nuclear Localization

Follow the instructions to analyze your file.
Step 1. Select the translocation image channels

From the drop down menus pick the nuclearimage channel and the translocating
probe image channel.

Step 2. Gate cells in best focus

A Gradient RMS histogram of the All population has been added to the analysis area.
Click on the bins in the histogram to view the images in each bin. The cells with
better focus have higher Gradient RMS, values. Begin your region at the bin after the
Gradient RMS value you wish to exclude and continue the region to the maximum in
the plot. You may choose an already existing population.

Step 3. Gate single cells

A scatter plot of Area versus Aspect Ratio has been added to the analysis area. Sin-
gle cells will have an intermediate Area value and a high Aspect Ratio. Click on the
dots to view the image associated with that dot. Note that the image is surrounded
by a light green line and the image next to it in the image gallery is not it's neighbor in
the plot. The images are presented in the order of acquistion.

Step 4. Optional

Answer Yes if you want to define subpopulations in your experiment.

Select subpopulation marker(s)

Choose one or two channels you wish to use to identify populations based on Inten-
sity. Click Next to add the scatter plot or histogram to the analysis area. Click Skip if

you do not wish to use this step.

Next Step. Gate subpopulations step number sequence is dependent on the
number of times the subpopulation marker step is taken.
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Draw regions in the scatter plot or histogram to identify as many populations as you
want. This step will be repeated until you choose Skip.

Next Step. Gate double positives

A scatter plot of the last gated (or selected) population of the Intensity values for the
nuclear image and the translocating probe image is added to the analysis area. Draw
a region around the double positive cells.

Next Step. Gate translocated events

A histogram of Similarity of the double positive cells is added to the analysis area.
Draw a region to include the cells with translocation. Note that for a normally dis-
tributed population you may want to report the RD of the double positive population
in a treated versus untreated sample instead of the percentage gated.

Nuclear localization of a probe is measured using the Similarity feature in the final
graph presented in the wizard. The example shown here is of THP1 cells stimulated
with 1 ug LPS for 90 minutes and stained with DRAQS5 (red) and NFkB (green) to
measure the nuclear localization of the NFkB.

Untreated Stimulated

R EEE L LA

For a more thorough explanation of the Similarity feature see Similarity Feature .

The statistics Count and Percent Gated are added to the Population Statistics table
in the analysis area and a statistics definition is added to the template. To view the
definition choose Define Statistics Report from the Reports menu.
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Shape Change Wizard

This wizard will create an analysis template for measuring the shape (circularity) of
any population of cells you identify.

Shape Change

To begin, double-click on Shape Change

Follow the instructions to open and analyze your file.

Step 1. Select the cell morphology image channel

From the drop down menu pick the channel for the cell image.
Step 2. Gate cells in best focus

A Gradient RMS histogram of the All population has been added to the analysis area.
Click on the bins in the histogram to view the images in each bin. The cells with
better focus have higher Gradient RMS, values. Begin your region at the bin after the
Gradient RMS value you wish to exclude and continue the region to the maximum in
the plot. You may choose an already existing population.

Step 3. Gate single cells

A scatter plot of Area versus Aspect Ratio has been added to the analysis area. Sin-
gle cells will have an intermediate Area value and a high Aspect Ratio. Click on the
dots to view the image associated with that dot. Note that the image is surrounded
by a light green line and the image next to it in the image gallery is not it's neighbor in
the plot. The images are presented in the order of acquistion.

Step 4. Optional
Answer Yes if you want to define subpopulations in your experiment.
Select subpopulation marker(s)

Choose one or two channels you wish to use to identify populations based on Inten-
sity. Click Next to add the scatter plot or histogram to the analysis area. Click Skip if
you do not wish to use this step.

Next Step. Gate subpopulations step number sequence is dependent on the
number of times the subpopulation marker step is taken.
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Draw regions in the scatter plot or histogram to identify as many populations as you
want. This step will be repeated until you choose Skip.

Next Step. Gate fluorescence positives

A histogram of the last gated (or selected) population of the Intensity value for the
cell image is added to the analysis area. Draw a region around the double positive
cells. Note that this step is skipped if the cell image channel chosen is brightfield.

Next Step. Gate shape-changed events

A histogram of Circularity of the last gated population is added to the analysis area.
Draw a region to include the cells with low circularity scores.

Shape change is measured in the final graph presented in the wizard. Cells with low
circularity scores have a highly variable radius. In this example monocytes in whole
blood were stained with CD 14 (green).

LY LI E

Low circularity High circularity

For a more thorough explanation of the Circularity feature see Circularity Feature .

The statistics Count and Percent Gated are added to the Population Statistics table
in the analysis area and a statistics definition is added to the template. To view the
definition choose Define Statistics Report from the Reports menu.
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Spot Wizard

This wizard will create an analysis template for measuring texture based on spot
counting. If the low and high spot count data are in separate data files merge the files
together before beginning.

Spot

To begin, double-click on Spot

Follow the instructions to open and analyze your file.
Step 1. Gate cells in best focus

A Gradient RMS histogram of the All population has been added to the analysis area.
Click on the bins in the histogram to view the images in each bin. The cells with
better focus have higher Gradient RMS, values. Begin your region at the bin after the
Gradient RMS value you wish to exclude and continue the region to the maximum in
the plot. You may choose an already existing population.

Step 2. Gate single cells

A scatter plot of Area versus Aspect Ratio has been added to the analysis area. Sin-
gle cells will have an intermediate Area value and a high Aspect Ratio. Click on the
dots to view the image associated with that dot. Note that the image is surrounded
by a light green line and the image next to it in the image gallery is not it's neighbor in
the plot. The images are presented in the order of acquistion.

Step 3. Optional

Answer Yes if you want to define subpopulations in your experiment.

Select subpopulation marker(s)

Choose one or two channels you wish to use to identify populations based on Inten-
sity. Click Next to add the scatter plot or histogram to the analysis area. Click Skip if

you do not wish to use this step.

Next Step. Gate subpopulations step number sequence is dependent on the
number of times the subpopulation marker step is taken.

Draw regions in the scatter plot or histogram to identify as many populations as you
want. This step will be repeated until you choose Skip.

Next Step. Select the spot image channel

From the drop down menu choose the image channel for the spot counting.
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Next Step. Assign truth populations

From the drop down menus select two truth populations, one with high and one with
low spot count. To create the truth populations, either use the tagging tools or gate
the cells of interest.

Next Step. Gate spot events

A histogram of the Spot Count feature for the last gated population is added to the
analysis area. Regions have been drawn that include the truth populations. Adjust
the regions as necessary. Note that you may want to adjust your truth populations
and repeat the wizard after looking at the images and validating the spot counts.
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The statistics Count and Percent Gated are added to the Population Statistics table
in the analysis area and a statistics definition is added to the template. To view the
definition choose Define Statistics Report from the Reports menu.
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Building Blocks

Building blocks may be used to create a graph for finding single cells, focused cells
or positive cells based on Intensity. The building blocks are shortcuts to creating a
graph that provide a limited list of relevant features with set X and Y axis scales set
for the graph. For more information on creating graphs see Creating Graphs.

Table 1: Building blocks

Building Block

X axisFeatures

Y axis Features

one color

Flourescence Positives -

Intensity_ MC_ChX
(for all channels)

two color

Flourescence Positives -

Intensity_ MC_ChX
(for all channels)

Intensity_ MC_ChX
(for all channels)

Focus

Gradient RMS_MX_ChX
(for all channels)

is default

Note: Gradient RMS of brightfield

Single Cell

Area_brightfield (default)
Area_scatter

Intensity_ MC_ChX

(for all channels)

Aspect Ratio_brightfield (default)
Aspect Ratio Intensity_ MX_ChX
(for all fluorescence channels)
Intensity_scatter

Single Cell Default

Area_brightfield

Aspect Ratio_brightfield

Size/SSC

Area_brightfield

Intensity scatter

To begin, choose Building Blocks from the Guided Analysis Menu or click on the
Building Blocks icon in the analysis area toolbar.

The Building Blocks window opens. This window is used to define a graph with a
specified set of features available depending on the purpose of the graph.

1 Choose the specific Building Block from the drop-down menu.

=" Building Blocks

Select Predefined Building Block:

Fluorescence Paositives - One Calar
Fluorezcence Positives - Two Colaor
Focuz

Single Cell

Single Cell Default

—

T= [T

2 Choose the population(s) to graph.
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* Building Blocks

Select Predefined Building Block:

Fluorezcence Pozsitives - One Calar w

Ilze the contral key to select multiple populations;

= Al &y
=-[9 Single cell:
=+ F2
[ apoptotic

3 Choose the X Axis Feature and the Y Axis feature, if applicable.

Title and Axes

Title: 3 R3
Intersity MC_ChOT

Intenzity FMC Chil
& Bis Label:

Intenzity_MC_ChiZ
Intengitp_MC_Chi3
Intenzity_MC_Chid
Intengitp MC_ChiE

v Az Feature:

v Az Label:

4 Click OK.
5 The graph is added to the analysis area.
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Advanced Analysis
Opening data files

Saving Data Files

Overview of Compensation

Creating a New Compensation Matrix File

Viewing Sample Information

Merging Data Files

Creating new data files from populations

Batch Processing

-49 -



Chapter 3

Opening data files

Use the File menu, which is shown in the following figure, to open, save, and close
image and analysis files and to quit the IDEAS application. Alternatively, you may
open a data file by drag and drop into an open IDEAS window. Muliple data files can
be open in one instance of the IDEAS application.

File |
Open...

Save Data Analysis File (.daf)

Save as Data Analysis File - Used Features Only
Save as Template (.ast)

Save All

Close

Exit

Opening a .rif file

A .rif file is opened when there is new data and the IDEAS application needs to apply
corrections. When opening a .rif file, the IDEAS application corrects each image for
the spatial alignment between channels, camera background normalization, flow
speed, and brightfield gain normalization. If you want fluorescence compensation to
correct for spectral overlap, you must create or choose a compensation matrix at
this time by using the control files that were collected for a particular experiment. If a
FlowSight data file was acquired with a compensation matrix, that matrix will be
used by default. For more information on compensation see Creating a New Com-
pensation Matrix File. The application performs the corrections by using calibration
information that was saved to the .rif file during acquisition.

To open a .rif file

To use a wizard to do this see Open File Wizard:, otherwise:

1 From the File menu, choose Open or drag the file into the IDEAS window.
2 Select the .rif file that you want in the Select File To Load window.

Tip: while browsing for the file to open you can limit the type of file shown in the win-
dow to .rif files.
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Select File To Load

Look in: | 1259 rifs

v @%@

&

My Recent

Documents | ||=]0.1ng 45_11_18.1if
- |=]0.1ng 60_16_23.1if

[ |=]0.1ng 75_21_d.rif

|=]0.1ng 90_26_9.rif

=] 10ng 15_3_10.rif

=] 10ng 30_8_15.rif

=] 10ng 45_13_20.riF

=] 10ng 60_1&_1.1if

=] 10ng 75_23_6.rif

=] 10ng 90_28_11.1iF

=] 1000ng 15_5_12.rif

|=] 1000ng 30_t0_17.rif

|=] 1000ng 45_15_z2.rif

=] 1000ng 60_z0_3.1if

=] 1000ng 75_25_8.rif

|=] 1000ng 90_30_13.rif

=

Desklop

&

My Documents

g

My Computer

@ﬁ

by Metwork,
Flaces

|=]0.0ng_2_9.rif |=]121906 C16 72-06 DRAQS+_-noBF4.rif
|=]0.1ng 15_1_g.rif |=]121906 C16 72-06 DRAQS+_-noBF4_m.rif
|=]0.1ng 30_6_13.1iF |=]121906 16 72-08 FITC_-naBF3.rif

File narne: |El.'| ng 15_1_8.rif

[ Open ]

Filez of type: | Fiaws image files [*.rif]

[ Cancel ]

{IDEAS files [*.rif:" cif.” daf
Faw image f
Compensated image files [* cif]

Drata analyzis files [ daf]

In the next window you will:

» Choose a compensation matrix
* Choose atemplate
* Name the output files

* Choose the number of events to process
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= Opening C:\Training Data Files 3.0\NFkB Translocation Dose an... |;||:,fg|

To perfarm fuorezcence compenzation

Select a compenzation matrix, compenzated image file, or data
analyziz file [.ctm, .cif, . daf]

IcEm

Or

Create a compenzation matrix from control files Mew b atris,..

Touse a custom template for analysiz

Select a template or data analyziz file [ ast, .daf]

Mame the output filez to be created

Compenzated image file [ cif]

|1000ng 60_20_3.cif =

Data analysis file [ daf]

| 1000ng 60_20_3.daf | [a.]

Enter the number of objects to process

1000 of 1000

(o] (o)

3 Click the folder next to Select a compensation matrix, compensated image

file, or data analysis file (.ctm, .cif, .daf) field to choose the matrix that was gen-
erated from the controls used for the experiment. If the .rif file contains a com-
pensation matrix used during acquisition it will be entered into this box. If you
leave it blank, the default compensation matrix will be used, but this is not rec-
ommended unless you do not want to compensate your data.
» If acompensation matrix for the experiment has not been made, click New
Matrix. For more information on creating a compensation matrix see Creating
a New Compensation Matrix File.
In the Select a template or data analysis file (.ast, .daf) field, select a tem-
plate file to load by clicking the folder and browsing for the file. If left blank, the
Default template with the basic features, masks, and settings will be used. Flow-
Sight files use the acquisition template as the default.

Name the output files with a new name, if necessary.

You may change the number of objects to load in the box under Enter the
number of objects to process. The default value is the number of objects in the
file.
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Tip: you can select a smaller number than the maximum if you have a large
number of objects to load. This helps save time for creating a template file. The
IDEAS application randomly loads the specified number of objects within the file.

7 Click OK.

The application then creates the .cif and .daf files and the .daf file is loaded into
the Image Analysis area.

Note: Most often, the defaults will be adequate. For some older data files, you may
need to provide control files for certain settings. For assistance call Amnis appli-
cation support.

» Toview the corrections that will be applied to the .rif file, click Advanced
within the Opening a .rif file window.

The Opening file window appears.

2= Opening Skt Nk Fite Da5 No LPS. 2.if [E=TRE——]

| Comected dumng acqusien

| Pt neemhter: 285 of 4358

¥ Apply cell classiiers ¥] Separate snge cbyects

Save Gomostana o Raw Image Fie. oK. (=]

* Make any changes to the corrections that you need, and then click OK.

Opening a .cif file
A _cif file is generated when corrections are applied to a .rif file, as described in Over-

view of the Data File Types. When opening a .cif file, the IDEAS application cal-
culates feature values and creates a .daf file to display images and graphs.

When opening a .cif file, an analysis template is selected. The template provides the
initial characteristics of the analysis. Opening the .cif file causes the IDEAS appli-
cation to calculate feature values and to use populations, graphs, and image viewing
settings to display the cells as defined by the template.

To open a .cif file

To use awizard to do this see Open File Wizard:, otherwise:
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1 From the File menu, choose Open or drag the file into the IDEAS window.
2 Select the .cif file that you want in the Select File To Load window.

Tip: while browsing for the file to open you can limit the type of file shown in the win-
dow to .cif.

Select File To Load

Look in: | =3 analyzed cif and daf files hd | @ " 4 '

|=]0.0ng_2_9.cif
=]0.1ng 15_1_8.cif
My Recent | |[=]0.1ng 30_6_t3.cf
Documents  |[=]0.1ng 45_11_18.cF
|=]0.1ng 60_16_23.cF

?'_‘:
[ [=)0.1ng 75_21_4.cf
Desktop ﬂ 0.1ng 90_26_9.cif
=] 10ng 15_3_10.cif
. =] 10ng 30_8_15.cif
) =] 10ng 45_13_20.cf

=] 10ng 60_18_1.cf

=] 10ng 75_23_6.cf

=] 10ng 90_25_11.cif

=] 1000ng 15_5_12.cif
J |=] 1000ng 30_t0_17.cf

My Computer |2 1 000ng 45_15_z2.cf

=] 1000ng 60_20_3.cif

=] 1000ng 75_25_8.cif

=] 1000ng 90_30_13.cf

My Documents

£ ie

by Metwork,
Flaces

File name: 0.0ng_2_9 Default .daf A | [ Open ]

Files of type: Compensated image files [*.cif] w [ Cancel ]

In the next window you will:

* Choose atemplate
* Name the output file

Opening 10ng 60_18_1.cif (=3
To uze a custom template for analysiz
Select a template or data analysis file [ ast, .daf)
Mame the analysiz file to be created
[rata analysis file:
10ng 60_18_1.dsf |
Ok ] [ Cancel ]

3 Click the folder next to Select a template or data analysis file (.ast, .daf) and
choose the template to use for analysis. If left blank, the IDEAS application will
use a default template. However, it is useful to create and save your own tem-
plates for specific experimental procedures.

4 Change the Data analysis file name, if necessary. The default name matches
the name of the .cif.
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5 Click OK.

During the opening of a .cif file, the IDEAS application calculates the values of
the features that are defined in the template you selected. The progress is shown
by a progress bar. After the application has successfully opened the .cif file, the
.daf file is saved.

See also: Saving Data Files.

Opening a .daf file

A .daf file contains the calculated feature values so that they will not need to be recal-
culated, as described in Overview of the Data File Types. To open a .daf file, the
IDEAS application requires the .cif file to reside in the same directory. The .daf file
does not contain any image data, so you can think of the .cif file as the database that
contains the imagery. Because all of the feature values have been saved init, the
.daf file should open quickly.

To open a .daf file

To use a wizard to do this see Open File Wizard:, otherwise:

1 From the File menu, choose Open or drag the file into the IDEAS window.
2 Select the .daf file that you want in the Select File To Load window.

Tip: while browsing for the file to open you can limit the type of file shown in the win-
dow to .daf.

Select File To Load E]

Laoak in: |L'f) analyzed cif and daf files V| € ) ? ® '

r |=]0.0ng_2_9 Default .daf | <] 1000ng 90_30_13.daf
ﬁ |=]0.0ng_2_9.daF
MyFecent | ||=]0.1ng 15_1_8.daf
Documents | ||=]0,1ng 30_6_13.daF
— |=]0.1ng 45_11_18.daF
F |=]0.1ng 60_16_23.daF
=]0.1ng 75_21_4.daf
=]0.1ng 90_26_9.daf
! =] 10ng 15_3_10.daF
J =] 10ng 30_5_15.daf
=] 10ng 45_13_20.daf
=] 10ng 60_15_1.daf
=] 10ng 75_23_6.daF
g! =] 10ng 90_25_11.daf
L =] 1000ng 15_5_12.daf
My Computer |2 1000ng 30_10_17.daf
=] 1000ng 45_15_z2.daF
‘g |=] 1000ng 60_20_3.daf
1 =] 1000ng 75_25_8.daf
by M etwork
Places

Desktop

My Documents

File name: A | [ Open ]

Filez of type: [rata analyzis files [ daf] w [ Cancel ]

IDEAS files [".rif;" cif.". daf)
Fiaws image files [*.rif]
Compensated image files [*. cif

The progress is shown by a progress bar. The state of the IDEAS application is
restored to what it was when the .daf file was saved.
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Saving Data Files

Data files are saved at several stages of analysis. Raw image files are saved during
data acquisition, by merging multiple .rif files or by creating new files from pop-
ulations. Compensated image files and Data analysis files are saved when opening
.rif files, merging multiple .cif files, or when running a batch analysis. The IDEAS
application also saves other types of files that are used for data correction and pre-
sentation. Template files (.ast) save the structure of an analysis and compensation
matrix files (.ctm) save the compensation matrices.

Application Defaults are set that direct the files into specific folders and can be
viewed or changed by the user. See Viewing and Changing the Application Defaults
for more information.

Saving a Data Analysis File (.daf)

A .daf file contains a snapshot of an analysis as described in Overview of the Data
File Types. Saving the analysis as a .daf file allows you to recall that analysis simply
by opening the file. When you quit the IDEAS application, you are always prompted
to save changes to a .daf file. You can also save changes from the File menu.
Remember that the .daf file does not contain image information, so opening the .daf
file requires the related .cif file to reside in the same directory.

To save a .daf file

1 Onthe File menu, click Save as Data Analysis File (.daf).

2 Enterafile name. Note that the default directory is the one where the .cif file was
saved.
If you select an existing file name, a warning appears that asks you to verify the
overwriting of the existing file.

3 Click Save.
The data is now ready for analysis. You can create graphs, view imagery, and dis-
play feature values and statistics. After you have defined an analytical procedure
in the .daf file, you can save the file as a template, which allows you to use the
procedure for analyzing other files. Refer to Overview of the Data Analysis Tools
for more information.

option: Saving a data analysis file with only the feature values used.

When you want to reduce the size of a data analysis file you may save the .daf with
only the features that are used for analysis of statitics or graphs.

On the File menu, click Save as Data Analysis File - Used Features Only. and follow
the instructions 2-3 above.

Saving a Compensated Image File (.cif)

The IDEAS application creates and saves a .cif file when a .rif file is opened. By
default, the application names the .cif file with the same name that the .rif file has,
replacing the .rif extension with .cif. The application also places the .cif file in the
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same directory as the .rif file. The .cif file will be larger than the .rif file because the
.cif file contains masking information as well as corrected and/or compensated
images.

Saving a Template (.ast)

Saving an analysis as a template allows you to apply the structure of the analysis to
other .cif files. Save a template file after saving a .daf file. A template includes all
graph definitions, Image Gallery settings, feature definitions, and statistics settings.
No data are saved in a template. Therefore, selected images and populations that
are dependent on specific objects, such as tagged populations, are not saved.

To save atemplate

1 Onthe File menu, click Save As Template File (.ast).
A Save File dialog box appears.

2 Enterthe name of the file to save.

3 Click Save.

If you select an existing file name, a warning appears that asks you to verify the
overwriting of the existing file.

Tip: You can change the default template directory in the menu Analysis > Appli-
cation Defaults.
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Overview of Compensation

Spectral compensation corrects imagery for fluorescence that leaks into nearby
channels so that you may accurately depict the correct amount of fluorescence in
each cell image.

For example, the light from one fluorochrome may appear primarily in channel 3, but
some of the light from this fluorochrome may appear in channel 4 as well, because
the emission spectrum of the probe extends beyond the channel 3 spectral band-
width. The light from a second fluorochrome may appear primarily in channel 4 but,
unless you subtract the light emitted by the first fluorochrome into channel 4, you
cannot generate images that accurately represent the distribution of the second fluor-
ochrome.

Emmission Spectra for two fluorochromes:

Channel 3 Channel 4

Percent Emission

475 500 525 550 575 600 625 650 675 700 725

Wavelength in nm

Below is an example of cells stained with two fluorochromes independently and run
together as one sample. Intensity scatter plots and images are shown uncom-
pensated and compensated. Image compensation is performed on a pixel by pixel
basis.
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The IDEAS application builds a matrix of compensation values by using one or more
control files. A control file contains cells stained with one fluorochrome. Because it
is critical that matrix values be calculated from intensities derived from a sole source
of light, control files are collected without brightfield illumination, or scatter. The
IDEAS application performs brightfield compensation when it loads a .rif file. The
process of creating the compensation matrix is described in the next section.

Creating a New Compensation Matrix File

The compensation matrix is a table of coefficients. The IDEAS application uses this
table to place the detected light that is displayed in each image into the proper chan-
nels, on a pixel-by-pixel basis. The coefficients are normalized to 1. Each coefficient
represents the normalized amount of the leakage of the fluorochrome into the other
channels.

The default matrix, which is used if no compensation matrix is chosen, is the identity
matrix, shown below.
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ChO1 Ch02 ChO2 Ch04 ChO5 Ch06 Ch07 Ch08 Ch03  Ch10  Ch1l  Chi2

» chl |1 0 0 ] 0 0 0 0 0 0 0 0
Cho2 |0 1 0 0 0 0 0 0 0 0 0 0
Chos |0 0 1 ] 0 0 0 0 0 0 ] 0
Chod |0 0 0 1 0 0 0 0 0 0 0 0
Chos |0 0 0 0 1 0 0 0 0 0 0 0
Chog |0 0 0 0 0 1 0 0 0 0 0 0
Cho7 |0 0 0 0 0 0 1 0 0 0 0 0
Chos |0 0 0 ] 0 0 0 1 0 0 ] 0
chos |0 0 0 0 0 0 0 0 1 0 0 0
Chin |0 0 0 0 0 0 0 0 0 1 0 0
Chi1 |0 0 0 0 0 0 0 0 0 0 1 0
Chi2 |0 0 0 ] 0 0 0 0 0 0 ] 1

To generate a new compensation Matrix file

1 Start the Compensation Wizard in one of two ways:
— Click the New Matrix button when opening a .rif file
— OR select Compensation>Create New Matrix .
The compensation wizard opens to Step 1:

2= Create Compensation Matrix (= 2|

Step 1: Select the control files for compensation.

To compensate data collected on a single camera instrument, the control files
must contain all & channels. To compensate data collected on a two camera
instrument, the control files must contain all 12 channels

Control Files

Add Files.. ] [ Remove Files ]

2 Add compensation control files by clicking Add Files and browsing for the control
files for the experiment. The files will have the suffix no-BF. Hold down the con-
trol key to select multiple files at once.

3 When all of the control files for the experiment have been added to the list, click
Next. The control file(s) are merged and loaded.
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4 Step 2: Verify the channels for each control in the experiment by checking the

channel boxes.

Step 2: Select/remove channels for compensation.

Verify that the selected channels are appropriate for your selected contrals.
Make any appropriate changes and click Next.

[ chot Chi2 Ch03
ChD4 Chis [0 chos
Chi7 Chog [[1 chog
[ ch1o Ch11 Ch12

[

Nead

] ’ Previous ]

’ Cancel

|

The following tables are provided as a guide for each instrument configuration.

Table 1: First generation ImageStream (1S100)

Ch1 Ch2 Ch3 Ch4 Ch5
470-500nm |400-470nm (500-560nm [560-595nm (595-660nm (660-735nm
Scatter DAPI FITC BE 7-AAD PE-Cy5
Table 2: ImageStreamX- 1 camera
Ch6
430-505nm [505-560nm (560-595nm [595-660nm (660-745nm (745-800nm
DAPI FITC PE PE-Tex- AF647 APC-Cy7
asRed
Table 3: ImageStreamX- 2 camera or FlowSight
Ché6
430-480nm |480-560nm [560-595nm [595-660nm |660-745nm [745-800nm
PE-Tex-
BF FITC PE asRed PE-Cy5 PE-Cy7
Ch10 Ch 11 Ch12
430-505nm [505-570nm (570-595nm [595-660nm (660-745nm (745-800nm
DAPI Pacific BF Texas Red  |AF647 APC-Cy7
Orange

5 Background and spatial offset corrections are performed, the imagery is dis-
played, bivariate plots of adjacent channels Intensity are added to the analysis
area and the compensation matrix values are computed and displayed in a table.
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Example:

A~ Create Compensation Matrix =1 3
Step 3: Validate the compensation matrix.
Double click each matrix coefficient to validate the fit of the positive control population. The resulting graphs can be added to the analysis area to
refine the positive control populations.
0 Ch2 Ch03 Chi4 Ch05 Chi6 Ch07 Ch08 Ch03 Ch10 Ch11
v oo GEC0sT  [oose  [oos [oove o 0028 |00z o 0 0.002
Ch02 1 0.12 0.07 0.052 0 0.042 0 0 0.008
Ch03 0212 1 0.235 0.132 0 0.019 0 0 0.005
ChD4 0.078 0.512 1 0.156 0 0.015 0 0 0.005
Ch05 0.018 0.113 0.24 1 0 0.016 0 0 0.onm
Chis 0.055 0.1 0.132 0.255 1 0.009 0 0 0.004
07 0.005 0.013 0.015 0.015 0 1 0 0 0.051
Chog 0.044 0.081 0.02 007 0 0.363 1 0 0 0.05
Chog 0.00 0.174 0.03 0.013 0 0.062 0.4 1 0 0.045
Ch10 0.004 0.08 0.08 0.021 0 0.027 0.288 0 1 0.086
Ch11 0.002 0.021 0.026 0.175 0 0.012 0.103 0 0 1
Ch12 0.004 0.027 0.018 0.043 0 0.087 0.143 0 0 0.267
@ Best Fit Means Preview Images... | | Restore Matrix |
Positive Control Populations
ChOT:  None [+] chom 7 Postive []
Ch02:  2_Postive [x] cnoe: 8 _Postive [=]
Ch03: 3 Postive [*] cno3:  None [=]
Chi4: 4 Postive ] onie: None [~
Ch05:  5_Positive [=] cnit: 11_Posiive [=]
ChOS:  None [7] chiz 12 Postive [~]
| Finish | | Previous | | Cancel |

The Positive Control Populations are shown in the graphs below.
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6 InStep 3, choose one of two methods for calculating the coefficients.
* The Best Fit method is used for objects such as cells where intensities vary.

» The Means method is used for objects such as beads that have only slight
variations in intensity.
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For each fluorochrome, the application automatically identifies a positive con-
trol population, excluding the brightest and dimmest objects, and assigns it to
the proper channel.

Inspect the matrix values in the table of coefficients.

Coefficients should always be less than 1, and decrease from the assigned chan-
nel. In other words, leakage should be greater in the channel nearest to the
assigned channel. Fluorescence always extends in the long-wavelength direction
from the exciting light.

Verify that no coefficients are larger than 1.

Verify that, in a column corresponding to a fluorochrome, the coefficients
decrease from the assigned channel.

Verify that the coefficient is greater in the channel below the 1 in the table than
the value above the 1 in the table. Verify that these coefficients also decrease
in subsequent channels below the 1.

Verify that there are no changes from the identity matrix in the columns where
there are no fluorochromes, including the scatter and brightfield channels. If
necessary, the column can be set to the identity values by double-clicking on
the heading.

Inspect the coefficients in the matrix by double-clicking on the coefficient.
Coefficients highlighted by red have errors greater than 1%.

A graph representing the coefficient appears. The population potted in the
graph is the positive control population of the column of the coefficient. The X
Axis represents the intensity in the assigned channel of the fluorochrome. The
Y Axis represents the intensity in the channel of leakage. The coefficent value
and error are also displayed.

Matrix Coefficient Inte... B@

3_Positive )

50000
70000
2
580000
50000
240000
=
£30000
20000
10000

: - | :
20000 40000 60000 20000

Intensity_MC_Ch03

Coefficient value: 19 Coefficient erar:. | g 0003s
Add Graph to Analpsiz Area

You can use the automatically generated control populations as they are, or
you can refine them and create different populations by using the region tools.
See the option below to remove objects from the population. By default, the
populations are named 3_Positive, 5_Positive, and so on. You can view the
populations in the Image Gallery. Some populations may be empty.

To choose a different population, use the arrow and select the population from
the list. The hierarchical relationship is shown in the population list. Assign
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populations only to the channels that correspond to the fluorochromes used in
the experiment.

» If you want to clear a column, double click on the channel heading.

» If needed, you can create new scatter plots by using the Analysis Area tool-
bar. For example, a 4_Intensity versus 5_Intensity plot may be useful. See
Creating Graphs for more information.

* The slope of the line on the plot is the coefficient in the matrix.

8 If objects in the population exist that are outliers, they should most likely be
removed from the positive population within the compensation matrix by the fol-
lowing optional steps.

Matrix Coefficient Inte... B@

3_Positive )

| ] ]
40000 60000 20000

Intensity_MC_Ch03

]
20000

Coefficient value: 19 Coefficient erar:. | g 0003s
Add Graph to Analpsiz Area

* The slope of the line on the plot is the coefficient in the matrix.

» If objects in the population exist that are outliers, they should most likely be
removed from the positive population within the compensation matrix by the
following optional steps.

Option: Remove Objects from the Population

1 Within Step 2 of the compensation wizard, double-click the coefficient to display
the intensity plot.
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Matrix Coefficient Intensity Plot

12_Positive

MC_Ch0?

Intensity_|

- 1 1 i
a 1E+05 24E+05
Intensity_MC_Chi12

Coefficient walue: |07 Coefficient emor: |g.012
Add Graph to Analysiz Area

2 If you notice outliers, click Add Graph to Analysis Area.
The plot populates in the Analysis Area.
3 Returnto the Analysis Area and use the region tools to draw a new region on the

plot that defines a new positive control population, excluding the outliers. Refer to
Creating Regions on Graphs for more information.

» Create a new region to exclude outliers.

Click the Resize @ and Zoom Z&! pyttons on the graph toolbar to more
clearly see the population of interest. Using one of the region buttons on the tool-
bar, draw a region that contains only the cells you want to use for determining
compensation. You can click a point on the graph and view the image to help you
decide where the region boundaries should be.

In the example below, the Polygon Region tool was selected to draw a border
around a selection of cells. Clicking within the graph anchors the line and double-
clicking completes the region.

T2 Fosive < SRR

K Create a Region

MC_Cha?

[ Use for statistics only

Intensity_|

T
285
Intensity_MC_Ch12

For more information, refer to Creating Regions on Graphs.

4 Assign the new population to the appropriate channel by using the Positive Con-
trol Populations list for that channel.
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& Create Compensation Matrix
Step 2: Validate the compensation matrix.
Double click each matrix coefficient to validate the fit of the positive control population. The resulting graphs can be added to the analyzis area to
refine the positive control populations.
Chil | Ch02 | ChO3 | ChO4 | ChOS | ChOS  ChO7  ChOS | ChO3 | Ch10 | Chll | Chi2
chot |1 0051 (008 (003 (0075 O 00% (002 |0 o |ooo2 0015
thoz |0 1 |01z 0075 (0052 |0 00% (8754 |0 o |ooos 877
choz |0 0z N1 023 (0132 |0 oms (2097 |0 o |ooos | o065
Chod |0 ooe  0s1z |1 |0186 |0 omz  |po7 |0 o |0005 0055
Chos |0 ome  janz 02 |1 0 0005 (0025 |0 o oot 0027
Thos |0 00ss |01 0132 |02 1 0005 (0023 |0 o (0004 0067
» ChD7 (O 0003 009 |0m4 (o040 1 laz19 |0 |0 LU 2057 |
Thog |0 0044 (00N QW3 (007 O 03| |1 0 o |oos  |ooss
chod |0 0oe (0174 (003 [oM3 0 0081 (043 )1 o |05 ooz
tho |0 0004 008 [0073  [0021 (O 002 (029 |0 |1 |0085  |0.032
Chil |0 0o0z (0021 (006 [0476 |0 oo 0103 |0 [0 1 o
thiz |0 0004 |00 (0018 (0043 |O 0086 (0143 |0 [0 0267 |1
(%) BestFit O Means [Previewlmages] [ Fiestore b atrix ]
Fositive Control Populations
Chol:  [Nore [=]  crom [7_Positive [~
Choz:  [2_Positive [=]  cros [8_Posiive [~
ChO3:  [3_Posiive [=]  chos: [None [=]
Cho4:  |4_Positive | B [ [~
ChiS:  [5_Positive [=]  emt: [11_Posiive [=]
Chog:  [Nore [=] w2z [R1%12_Posiive [~
= 021810101 THPT merged_comp_control-matri
&l
D 2_Positive
D 3_Positive
D 4_Positive
D 5_Positive
D 7_Positive
D 8_Positive
D 11_Positive
= 12_Positive
Lt
{3 Nore

5 The coefficient value is automatically recalculated when a new population is
selelcted.

6 Repeat these steps as required to redefine the coefficients.

7 Click Preview Images to view individual objects with corrections applied. Double
click on an image to add it to the preview window. Note: the corrections are only
applied to on-camera channels. For example, if the object is brightest in channel
3 on the first camera, only channels 1-6 are shown corrected for that object.

8 When the matrix appears satisfactory, click Finish.

9 Enter a name for the compensation matrix file (.ctm) and click Save
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Save As Compensation Matrix (.ctm) File @
Save in: |L'f) compensation j EF Ed-
_2 compraatrix:Junez0.ctrm
L compriatrix:Junezs. ctrm
My Recent
Documents
Desklop

My Documents

My Computer

&ﬁ

iy Metwark, File name: | j Save
Flaces
Save as type: |c:ompensation matrix files [*.ctm] j

Note: The matrix is saved as a compensation matrix file (.ctm file). This file con-
tains the compensation values and can be opened later for editing. To provide the
values for fluorescence compensation, you select a .ctm file when opening a .rif
file. See Opening a .rif file for more information.

Preview and edit a compensation matrix

A compensation matrix can be applied to a population or .rif file in a preview mode for
editing a matrix.

To open a compensation Matrix

1 Select View/Edit Compensation Matrix from the Compensation menu to view,
edit or preview the matrix on image data.Select the data file by clicking on the

folder and then click Open. The matrix values are displayed in a table and may be
edited.
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Compensation Matrix AE3)

Select a compenzation matrix:

Calor Compensation' 0218 0 PO _E47 APCCYF.ctm

ChO1 | ChO2 | Ch03 | ChO4 | ChOS | ChO6 | ChO7 | Ch0O3 | Ch03 | Ch10 | Ch11 | Chi12
b Chil 0.051 |0.034 (003 0076 |0 0026 0019 |0 0 0002 |oms
Chi2 |0 1 0121 |0.076 |0.052 |0 0036 0145 |0 0 0.0o0s (0129
Chdz |0 0212 |1 0235|0132 |0 0.5 |0.087 |0 0 0.006 | 0075
Ch04 |0 0ove 0512 |1 0156 |0 0mz |oo7 |0 0 0.005 | 0063
Chls |0 00ma 0113|024 1 0 0005 0024 |0 0 0011|003
Chle |0 0.055 |01 0132 |0.2585 1 0005 0021 |0 0 0.004 | 0063
Chd7 |0 0003 0013|0015 0Ms |0 1 0215 |0 0 0.051 |0076
Chiz |0 0.045 |0.031 |002 0080 0353 |1 0 0 0os |01
Chd3 |0 0008 0774|003 030 0067 |0.434 1 0 0.045 |0.033
Chi0 |0 0004 008 003 00210 0026 0231 |0 1 0.086 |0.035
Ch11 |0 0002 |0.021 |0026 0175 |0 00 0102 |0 0 1 0113
Ch1z 0 0.004 |0.027 {0018 0043 |0 0086 0142 |0 0 0267 |1

Freview a file with thiz matrix applied

(%) Select an existing .rif fils

| | Ovenwrite preview files

| | hd I Preview...

[ ()8 ] [ Cancel ]

2 To preview the matrix on image data, browse for a file or select a population from
the current file to preview and click Preview.

Note: It is recommended that you first create a small tagged pop-
ulation to preview compensation changes because previewing large
populations requires a lot of memory and may be slow.

3 You may repeat editing the matrix and previewing until satisfied.
4 When done, click OK and save the matrix.
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Merging Data Files

Merging Raw Image Files
You can merge .rif files together for analysis. This option is not available for basic
FlowSight files without the Quantitative Imaging (Ql) upgrade.

To merge .rif files

1 Onthe Tools menu, click Merge .rif Files.

The Merge Raw Image Files window appears.
': Merge Raw Image Files El_ﬁ

Select raw image fles for merging
A o fin wil be created and the from the frst o | Add Flea
Hete: duing the kading of the menged 1. the aooly cell classfiers aption needs to be set manually L J
[ Fismerve Fom |
\ Cancel

2 Toselect the .rif files to merge, click Add Files.
The .rif file names appear in the list.
3 If youwant to remove a file from the list, select it and then click Remove File.
4 When the merge list is complete, click OK.
The Save Merged Raw Image (.rif) File dialog box appears.
5 Type a unique file name.

6 Click Save.
The Creating merged .rif file window appears.
rCreating merged .rif file: OA\Guests\092011 Dema\temp.rif @M1
Files to merge

% 0:\Guests\092011 Demo'\092011 X101 Unstimulated_12.rf
O O:N\Guests'092011 Dema’\092011 X107 Stimulated_11.rf

O Unprocessed ‘& In process ® Processed

% -]

When the merge is complete, the Merged .rif Created message appears.

7 Click OK.
Note: The sample information will contain the classifier information for the first
file in the merge list however the classifier is turned off when a merged file is
loaded. To turn the classifier on manually, go to the Advanced panel on the open
.rif window when opening a merged file.
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Merging Compensated Image Files

You can merge .cif files together for analysis.This option is not available for basic
FlowSight files without the Quantitative Imaging (Ql) upgrade.

To merge .cif files

1 Onthe Tools menu, click Merge .cif Files.
The Load Multiple .cif Files window appears.

= Load Multiple .cif Files

Select cff files to load. Enter the number of objects to load from each file. A population will be created for each file.
Specify the population name.

File # Objects | Population

Add Files ] [Remo\re Files ]

Compensated image file {.cif) Select a template or data analysis file (ast, .daf)

Data analysis file (.daf)

ok | [ Cancel |

2 Toselect the .cif files to merge, click Add Files.

The .cif file names appear in the list.

If you want to remove a file from the list, select it and then click Remove File.
Type a unique name for the output files.

Select atemplate..

Click OK.

The merged files are created and the new .daf file is loaded with a population
created from each file.

N o o bhow
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Creating New Data Files

Creating new data files from populations

To further analyze a population or merge it with other data when working in a .daf,
you can save it to a new data file. This course of action is useful if your data file con-
tains a large number of objects that are not pertinent to your experiment. Decreasing
the data file size results in better performance by the IDEAS application, as
described in Creating Regions on Graphs. Note that you cannot create a new .cif or

.rif when multiple data files are open. This option is not available for basic FlowSight

files without the Quantitative Imaging (Ql) upgrade.

To create data files from populations

1 Onthe Tools menu, click Create Data File from Populations.

The Create .cif and/or .rif From Populations window appears.
(:: Create .cif and/or .rif From Populations [ =B é]
Ui

Select populations:

[SE¥l NFB Fitc Dg5 No LPS Analyzed _2.cif

e Al

[] New Raw Image File {rif)

[] New Compensated Image File (.cif)

In the Select populations list, select the populations that you want to include in
the new data file(s). Ctrl click to select multiple populations.

To create a .rif file, select the New Raw Image File (.rif) check box, the pop-
ulation name is used as a default. You may enter a new name.

To create a .cif file, select the New Compensated Image File (.cif) check box,
the population name is used as a default. You may enter a new name.

Click OK.

If you created a new .cif file, you can choose to load it. When loading the .cif file,
the application will prompt you for the template.
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Viewing Sample Information

All of the information associated with an IDEAS file, such as the collection infor-
mation, camera settings and corrections, is saved within IDEAS and can be viewed

in the Sample Information window.
To open the Sample Information window

1 Goto Tools > Sample Information to open the window.

Information for the open data file will be loaded. You can browse for a data file by
clicking on the folder. You can open the Sample Information Window for any of

three file types: .rif, .cif, or .daf.
2 Select a Tab to see the information for each heading.
3 Click Print to print a report of all of the sample information.

Tip: You may click on the folder and browse for a file to view the sample information

for any file without loading the file.

IS N
4 Sample Information { = éj

Select Data File:
NAKE Fitc Dq5 No LPS Anelyzed 2t

Acquistion |Correctmns | Focus/Fluidics | Detection | Camera Settings | llumination I EDF | Compensation IChanneIs‘

Raw Data File
Name (i) NFKB Fitc Dg5 No LPS_21f
Acq. Date: [3/31/2010 Version No. Objects:

Processed Data File
Name (.cf):  C:\lsers\sfriend\\Desktop'2Cam DEMO NFkB Translocation\NFKEB Fitc Dg5 Mo LPS Analyzed _2
Version: 404270 No. Objects 4721

Sample:  NFkB Fitc Dg5 No LPS Analyzed _2
[ Show Sample Name in Graph Tiles Allow Post Processing

Acquisition tab: File names, software version numbers, date acquired, number of

objects, sample name.

Corrections tab: Camera background, alignment offsets (from ASSIST).

Focus/Fluidics tab: Core information and sample volume.

-72 -




Viewing Sample Information

Detection tab:1S100 and ImageStreamX only. Cell classifier settings during
acquisition.

Population tab: FlowSight and lageStreamX MKII only. Lists the populations and
number acquired.

Camera Settings tab: Bin mode, magnification and sensitivity settings.
lllumination tab: Brightfield and laser information.

EDF tab: View kernels used for deconvolution of EDF imagery.
Compensation tab: View the compensation matrix.

Channels tab: Lists channels collected.
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Batch Processing

Batch processing allows you to automatically analyze a group of files with one tem-
plate when a compensation matrix has already been generated for the experiment.

To perform batch processing

1 Onthe Tools menu, select Batch Data Files.

The Batches window appears. It lists a record of all batches you have proc-
essed.

Batches to Run

Add Batch
Edit Batch

Remove Batch

Submit Batches

Processed Batches
@-L3 Batch 6-29-2011 11.05.33 AM

1) Batch 5-3-2011 10.38.34 AM
-3 Batch 5-3-2011 9.51.14 AM
-3 Batch 5-3-2011 9.41.07 AM
-3 Batch 452011 11.28.23 AM
-3 Batch 3-242011 11.47.57 AM
-3 Batch 3-23-20112.29.21 FM
-3 Batch 3-23-2011 2.00.37 FM
() Batch 3-2-2011 8.02.21 AM
@3 Batch 3-1-2011 1.17.04 PM
- Batch 2-9-2011 11.49.07 AM

2 Click Add Batch.
The Define a Batch window appears.
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N o o b~

ol B’
= oo R e

Input Files

Select nf, .of, or .daf files to process

Add Files

Select a compensation matri, compensated image file, or data analysis file

{.ctm, .cif, .daf)

Select a template or data analysis file (ast, .daf)

Chverwrte existing files Batch Mame: Batchl

File suffoc:

To select the files for the batch, click Add Files. Navigate to the files and select
by clicking on the file. Select multiple files to add by holding down the Ctrl key
while selecting the files.

« Toremove files from the Files to Process list, click Remove Files.
Select a compensation matrix from a file (.ctm, .cif, or .daf).

Select atemplate file (.ast or .daf). Leave blank to use the Default template.
Set the output files parameters.

If the template contains a Statistics Report template click on the Preview Sta-
tistics Report button. Order the files as you wish them to be reported by select-
ing a file with a left-click, then right-click the desired position and select ‘move
here’. See Reporting Statistics for more information.

Click OK.

The Define a Batch window closes. The batch appears in the Batches window.
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Batches to Run
Batch Add Batch

Edit Batch

Remove Batch

Submit Batches

Processed Batches

{3 Batch 6-29-2011 11.05.33 AM

{3 Batch 5-3-2011 10.38.34 AM
L3 Batch 5-3-20119.51.14 AM
- Batch 5-3-20119.41.07 AM
- Batch 452011 11.28.23 AM
-3 Batch 3-24-2011 11.47.57 AM
-3 Batch 3-23-20112.29.21 PM
- Batch 3-23-2011 2.00.37 PM

{3 Batch 3-2-2011 8.02.21 AM
12 Batch 3-1-2011 1.17.04 PM
-3 Batch 2-3-2011 11.45.07 AM

9 The Batches window offers the following options:
« Add Batch: If you want to create another batch to add to the list.
* Remove Batch: If you want to remove a batch from the Batches to Run list.
« Edit Batch: If you want to edit a batch in the Batches to Run list.

10 When you are satisfied with the Batches to Run list, click Submit Batches.

The files to process are listed and the progress is displayed in the Processing
Batch window. Once you have started processing batches, it may use up a fair
amount of your computer’s processing power.

5

r
Processing Batch: Batchl

o Unprocessed g5 Processing g Processed

3

i File

“®: 0.0ng_2_9if

© 0.Ing 15_1_8sF
© 0.1ng 30_6_13:
O 0.1ng 45_11_187

g i ]+

1

3

i File

O 0.0ng_2_3cf

O 0.1ng 15_1_8.cif
© 0.1ng 30_6_13.f
O 0.1ng 45_11_18.cf

© D inn AN 16 23cif
Cl e ]

1

daf File

| Total elapsed time : 0 minutes
| |
Cancel Batch

Tip: To cancel the batch processing at any time, click Cancel Batch. The
IDEAS application will confirm cancellation and complete the file it is working on.

When the batch processing is complete, the IDEAS application saves the .rif,
.cif, and .daf files in the batch results directory. In the Batches window, a list of
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processed batches appears in the Processed Batches list. If a batch did not suc-
cessfully complete, it will appear in red.

Tip: To display the error that occurred during processing, double-click the batch.

11 If you want a batch report, double-click the batch in the Processed Batches list of
the Batches window.

The Batch Results window appears.
12 Inthe Batch Results window, click Print.
13 In the Batch Results window, click Close.
14 Inthe Batches window, click Close.

2= Batch Results

Eatch Report

C:\Users'sfriend"AppData"RoamingAmnis Corporation*batches'Batch 2-1-2011 11.53.28 AM

Batch: Batch1
Template: C:\Users'sfiiend\Deskiop'/5100 NFk Translocation Dese and Time 4.0'analyzed cf and daf files’0.0ng_2_9 4 Anlyzedddf ||
Compensation:  C:\Users'sfriend\Dasktop\IS100 NFkB Translocation Dose and Time 4 0\analyzed cif and daf files\FITC DRAG ctm
Comections Alignment, Camera Background, Enghtfield Gain, EDF, Flow Speed

Output Options:  Cell classiiers applied, Single objects ssparated, Clipped objects removed, Nondramed objects srased

Input Files:

\lsers'sfiiend" Desktop'5 100 NFKE Translocation Dose and Time 4.0ifs\0.0ng_2_9.1f
Users\sfriend'\Desktop\IS100 NFkB Translocation Dose and Time 4 0\ifs\0.Tng 15_1_8.F
\Users'sfiiend* Desktop'5 100 NFKE Translocation Dose and Time 4.0'ifs\0.Ing 30_6_13.
Users\sfriend'\Desktop\IS100 NFkB Translocation Dose and Time 4 0\ifs\0.Tng 45_11_18.F
\Userssfiiend* Deskitop'5 100 NFKE Translocation Dose and Time 4.0%ifs0. Ing 60_16_23.17
Users\sfriend'\Desktop\IS100 NFkB Translocation Dose and Time 4.0\ifs\0. Ing 75_21_4
\lsers'sfriend’ Desktop'5 100 NFKE Translocation Dose and Time 4.0%ifs0. Ing S0_26_5u
Users\sfriend'\Desktop\IS100 NFkB Translocation Dose and Time 4 0\ifs\10ng 15_2_10#
\lsers'sfriend" Desktop'15 100 NFKE Translocation Dose and Time 4.0\ifs'10ng 30_8_ 15 I
Users\sfriend'\Desktop IS 100 NFkB Translocation Dose and Time 4 0\ifs\10ng 45_13_20.f
\Users'sfiiend" Desktop'5 100 NFKE Translocation Dose and Time 4.0%ifs'10ng 60_12_1.1f
Users\sfriend'\Desktop\IS100 NFkB Translocation Dose and Time 4 0\ifs\10ng 75_23 6.
\lserssfriend" Desktop'5 100 NFKE Translocation Dose and Time 4.0'ifs'10ng $0_28_ 1.1
Users\sfriend'\Desktop\IS100 NFkB Translocation Doss and Time 4.0\ifs\1000ng 15_5_12.if
\sers'sfiend" Deskitop'5 100 NFKE Translocation Dese and Time 4.0'ifs1000ng 30_10_17.1
Users\sfriend'\Desktop\IS100 NFkB Translocation Dose and Time 4 0\ifs'1000ng 45_15_22 if
\lsers'sfiiend" Desktop'15 100 NFKE Translocation Dose and Time 4.0%ifs'1000ng 60_20_3
Users\sfriend'\Desktop\IS100 NFkB Translocation Doss and Time 4.0\ifs\1000ng 75_25_&
\Users'sfiend’ Deskiop'!5 100 NFKE Translocation Dese and Time 4.0'ifs'1000ng 90_30_13

0000000000000 000000

Output Files:

Users\sfriend'\Desktop|S100 NFkB Translocation Dose and Time 4 0\ifs\0.Ong_2_3 cff
\Users\sfiend"\Desktop*|5100 NFB Translocation Dose and Time 4.0%ifs\0. Ing 15_1_8.cif
Users\sfriend"\Desktop*|S100 NFkB Translocation Dose and Time 4 0\ifs\0.1ng 30_6_13.cif
\\Users\sfriend'\Desktop"|5 100 NFkB Translocation Dose and Time 4.0%ifs\0.Ing 45_11_18.cif I
Users\sfriend'\Desktop*|S100 NFkB Translocation Dose and Time 4 0'ifs\0. 1ng 60_16_23 cif
\Users\sfiend'\Deskiop*|5100 NFkB Translocation Dose and Time 4.0%ifs\0. Ing 75_21_4.cif
Users\sfriend'\Desktop*|S100 NFkB Translocation Dose and Time 4 0\ifs\D.1ng 90_26_9.cif
\Users"sfriendDesktop"I5100 NFkB Translocation Dose and Time 4.0%ifs\10ng 15_3_10.cif
Users\sfriend*\Desktop*|S100 NFkB Translocation Dose and Time 4 0'ifs\10ng 20_8_15cif
\Users\sfriend"\Desktop*|5100 NFB Translocation Dose and Time 4.0%ifs'10ng 45_13_20 cff
Users\sfriend*\Desktop*|S100 NFkB Translocation Dose and Time 4 0'ifs\10ng 60_18_1.cif
\Users"sfriendDeskiop"I5100 NFkB Translocation Dose and Time 4.0%ifs\10ng 75_23_6 cff i
Users\sfriend'\Desktop*|S100 NFkB Translocation Dose and Time 4 0\ifs\10ng 90_28_11 cif
\Users"sfriendDesktop"I5100 NFkB Translocation Dose and Time 4.0%ifs\1000ng 15_5_12.cif
Users\sfriend‘\Desktop|S100 NFkB Translocation Dose and Time 4.0\ifs\1000ng 30_10_17 cff
\Users"sfriend*Deskiop"/5100 NFkB Translocation Dose and Time 4.0%ifs\1000ng 45_15_22.cif
Users\sfriend‘\Desktop*|S100 NFkB Translocation Dose and Time 4 0\ifs\1000ng 60_20_3 cif
\Users"sfriendDesktop"I5100 NFkB Translocation Dose and Time 4.0%ifs\1000ng 75_25_8 cif
Users\sfriend'\Desktop|S100 NFkB Translocation Dose and Time 4.0\vifs\1000ng 30_30_13 cff
\Users\sfiend\Deskiop*|5100 NFkB Translocation Dose and Time 4.0%ifs\0.0ng_2_3.daf
Users\sfriend'\Desktop|S100 NFkB Translocation Dose and Time 4.0'vifs\0.1ng 15_1_8 daf
\Users"sfriendDesktop"/5 100 NFkB Translocation Dose and Time 4.0%ifs\0.Ing 30_6_13.daf
Users\sfriend‘\Desktop|S100 NFkB Translocation Dose and Time 4 0\ifs\0. 1ng 45_11_18 daf
\\Users\sfriend'\Deskiop*|5100 NFkB Translocation Dose and Time 4.0%ifs\0. Ing 60_16_23.daf
Users\sfriend‘\Desktop*|S100 NFkB Translocation Dose and Time 4 0\ifs\D. Ing 75_21_4 daf
\Users'sfriendDesktop"/5 100 NFkB Translocation Dose and Time 4.0%ifs\0. Ing 90_26_9.daf
Users\sfriend‘\Desktop|S100 NFkB Translocation Dose and Time 4.0\vifs\10ng 15_3_10daf
\Users\sfriend"\Desktop*|5100 NFkB Translocation Dose and Time 4.0%ifs'10ng 30_8_15.daf
Users\sfriend‘\Desktop’|S100 NFkB Translocation Dose and Time 4 0\ifs\10ng 45_13_20 daf
\Users"sfriend"Deskiop"I5100 NFkB Translocation Dose and Time 4.0%ifs\10ng 60_18_1.daf
Users\sfriend'\Desktop|S100 NFkB Translocation Dose and Time 4 0\vifs\10ng 75_23_6 daf
\Users'sfriendDesktop"I5100 NFkB Translocation Dose and Time 4.0%ifs\10ng $0_28_11.daf
Users\sfriend'\Desktop|S100 NFkB Translocation Dose and Time 4.0vifs\1000ng 15_5_12 daf
\Users\sfriend'\Deskiop*|5100 NFB Translocation Dose and Time 4.0%ifs'1000ng 20_10_17.daf
Users\sfriend*\Desktop’|S100 NFkB Translocation Dose and Time 4 0\ifs\1000ng 45_15_22 daf
\Users"sfriendDesktop"I5 100 NFkB Translocation Dose and Time 4.0%ifs\1000ng 60_20_3 daf
Users\sfriend'\Desktop|S100 NFkB Translocation Dose and Time 4.0ifs\1000ng 75_25_8 daf
\\Users\sfriend\Desktop*l5100 NFkB Translocation Dose and Time 4.0%ifs'1000ng $0_30_13 daf

OO00O00000000N0000000000000000000000000

Start time: 2/1/2011 11:53:28 AM
End time: 2/1/2011 12:00:41 PM

Resut: Alfiles wers processed succsssfuly.
Statistics Report:  C.\Users'sfriend'\Desktop*15100 NFKB Translocation Dose and Time 4.0%ifs\0.0ng_2_9 _4 Defaul daf_siats b
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Overview of the Data Analysis Tools

The IDEAS application provides a powerful tool set that allows you to explore and
analyze data. The rich feature set lets you create hundreds of your own features to
differentiate objects and statistically quantify your results.

As shown in the following figure, the application window is divided into two panels—
the Image Gallery and Analysis Area—which each provide the corresponding tools
that you can use for data analysis. The layout can be changed to side by side or top
and bottom with re-sizable panels.

= mnss 18- s o AT S0 T T

kb LEE@A

You can create populations of objects by tagging hand-selected images, drawing
regions on graphs, and using Boolean logic to combine existing populations. After
you have created a population, you can view it in the Image Gallery or plot it on a
graph. You can view the statistics for populations or objects in tables placed in the
analysis area.

Graphs show data plotted with one or two feature values, and tools are provided that
allow you to draw regions for the purpose of generating new populations. You can
show any population on a plot.

Every image is linked to the feature data. Selecting an individual data point in a graph
allows you to view it in the Image Gallery or look at its feature values in the Statistics
Area. Any object that is selected in the Image Gallery is also shown on the plots in
the Analysis Area.

-78 -



Overview of the Image GalleryUsing the Image Gallery

Overview of the Image GalleryUsing the Image Gallery

This section contains the following subsections, which describe how to view pop-
ulations of objects in various ways, view masks, customize the Image Gallery dis-
play, and hand-select objects for a population:

Overview of the Image GalleryUsing the Image Gallery

Setting the Image Gallery Properties

Working with Individual Images

Creating Tagged Populations

Overview of the Image Gallery

The Image Gallery displays the imagery and masks of any population of objects.

A toolbar is provided in the upper-left corner of the panel, as shown in the following
figure. The Image Gallery also makes different viewing modes available for the
imagery. The default template contains the viewing modes which allows you to view
all channel images in grayscale or color, or each channel image individually.

Tip: You can build custom viewing modes as shown in this example. For more infor-
mation, see Setting the Image Gallery Properties.

= meas - v rved & 10 S5

4= File ‘W Guided Analysis  Analysis Compensation Tools Optiens Reports Windows Help

h, © @~ a a )
[~ «
Populgtion:  2n single T cell & double+ & Focus & conjugates E View: |Custom - ‘
BF Actin ADAP Drags ADAP/ACET ... BF Actin ADAP Drag3 ADAPACHNT ..

Image Gallery Tools
Table 1: Image Gallery Tools
Tool Description
Allows you to create a population of hand-
ro Tagging Mode Tool picked objects. See: Creating Tagged Pop-

ulations.

Image Gallery Properties Tool  |ting the Image Gallery Properties.

Provides custom display features. See: Set-

Show/Hide Mask Tool view of the Image GalleryUsing the Image

Displays masks on the imagery. See: Over-

Gallery.
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Tool Description
Sets the Image Gallery color. See: Over-
B show/Hide Color Tool view of the Image GalleryUsing the Image
Gallery.

I _ _ Click on the tool and it will show any sat-

— Show/Hide Saturated Pixels urated pixels will turn red. See: Overview of
Tool the Image GalleryUsing the Image Gallery.
Zoom Tools Zoom in or out and reset zoom on the image

® 9 Q gallery. See: Overview of the Image Gal-

leryUsing the Image Gallery

To view the imagery for a population

1 Inthe Population drop down menu of the Image Gallery, click the population that
you want. (The list includes all the populations as well as the currently selected
bin from a histogram.) To create a population, refer to Creating Tagged Pop-
ulations.

2 Toselect anindividual image, click on it. A thin, green frame indicates the
selected object.

The object’s feature values are displayed in a table if an object is selected and
atable is added to the Analysis Area.

The selected object is identified in each scatter plot graph with a green cross.
The image can be placed in the Analysis area by right click>Add Image to
Analysis Area.

Tip: Conversely in any scatter plot in the analysis area, clicking a graphical
point causes the Image Gallery to highlight and display the corresponding
object.

Note that the objects are presented in the Image Gallery in the order of acqui-
sition and are not necessarily near each other in a scatter plot.

To change the viewing mode

In the View drop down menu of the Image Gallery, select a specific view. The
imagery display changes according to the new view. To make a new view use
the Image Properties tool.

To show or hide masks

Click the Show/Hide Masks toolbar button to toggle between showing and

hiding the selected masks for all images in the Image Gallery .

The mask is shown as a transparent layer over each image. The mask dis-
played is selected in the Image Gallery Properties View tab. The color of the
overlayed mask can be changed in the Applications Defaults under the
Options menu.

Channel &
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Tip: To hide the mask for a specific channel only, set the individual channel
mask to None in the view tab of the Image Properties dialog.

To show or hide color

» Click the Show/Hide Color toolbar button to toggle between showing and hid-
ing the colors for all images in the Image Gallery. See Setting the Image Gal-
lery Properties for more information.

To zoom on the image gallery

* Click the Zoom In toolbar button to view the images in the gallery closer and
the Zoom Out or Reset Zoom to reverse the zoom.

/| zoomin
o zoom out
o resetzoom

To show saturation

* Click the Show/Hide Saturated Pixels toolbar button.
]

Saturated pixels in images, if any, appear in red.

Setting the Image Gallery Properties

When a new data file opens in the default template, you might find it difficult to
clearly see cell morphology because the Image Gallery display properties have not
yet been properly adjusted for the data set.

To optimize the display you may use the wizard Display Properties Wizard to set the
pixel intensity mapping to the display range. Manual adjustment and other settings
are described below.

Clicking the Image Gallery Properties toolbar button opens the Image Gallery Prop-
erties window, which contains the following tabs:

» Display Properties—Allows you to define the name, color, and display inten-
sity mapping for each image. Allows adjustment of the image size for the
image gallery.

* Views—Allows you to customize the views for the Image Gallery.

* Composites—Allows you to create composites and adjust the amount of color
from a channel that is included in a composite image.
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To customize the Image Gallery display properties

1

Click the Image Gallery Properties toolbar button to begin.

O

The Image Gallery Properties window appears with the Display Properties
tab displayed.

Display Properties | Views | Composites |

Images Cbject
chot Nams:  ChOZ coor: ()
cho2
Cro3, Minimum Pirel Intensty: 15 Maximum Picel Intensity: 1484
Cho4
Chos Ey
Chog
Ccho7
Chog
Chos
chio
chit
cni2

Automatic | Manual
Image Display Mapping X Aods Seale
Dleoky Widkiy Disginy Helght [ 5et Rangeto Pl Data | Ful Sede |
@ Channel Widih
[ setlnearCuve | [ Adoscae |
© Auto Fit @ Auto Fit
5 1202 2E
Preview Changss in Gallery

To change the size of the panels in the image gallery

1

Display Width and Display Height can be specified or changed to Auto Fit in the
lower left section of this window.

To change the name or color for each image

1

Select an image in the list of images on the Display Properties tab of the Image
Gallery Properties window.

On the right side of the window you can type a new, unique name for the selected
image. Note that each image is provided with a default name and the image
names appear near the top of the Image Gallery.

Click the colored square for the selected image.
Click the color that you want in the color palette.
Click OKto close the palette.

Tip: The grayscale image in each channel is assigned a default color forimage
display in the gallery. Setting the color to white is equivalent to using the original
grayscale image. The colors are also used to build composite images.
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To fine-tune the image display intensity for an image

1

On the Display Properties tab of the Image Gallery Properties window, select
an image by clicking the image name in the list. The graph for the currently
selected image is shown in the window and updates as the changes are made.
Select and image in the image gallery that has intensities for the image channel
you are adjusting.

Note: You will adjust the Display Intensity settings on the graph (the Y Axis),
the value of the display to (the X axis), the range of pixel intensities. The range of
pixel intensities will depend on the instrument and the collection mode set during
acquisition. The display range is 0-255; the range of intensities from the camera
is 0-4095 for the ImageStreamX or 0-32,767 for EDF mode collection. The IS100
first generation instrument has a 10 bit camera and therefore the range of pixel
intensities is 0-1023. The limits of the graph enable you to use the full dynamic
range of the display to map the pixel intensities of the image.

I I I
0 1000 2000 3000 4035

At each intensity on the X Axis of the graph, the gray histogram shows the
number of pixels in the image. This histogram provides you with a general sense
of the range of pixel intensities in the image. The dotted green line maps the pixel
intensities to the display intensities, which are in the 0-255 range.

Manual setting is done by Click-dragging the vertical green line on the left side
(crossing the X Axis at 0) allows you to set the display pixel intensity to O for all
intensities that appear to the left of that line. Doing so removes background noise
from the image.

Click-dragging the vertical green line on the right side allows you to set the dis-
play pixel intensity to 255 for all intensities that appear to the right of that line.

From the Image Gallery window, select the object to use for setting the mapping.
It appears in the Image Gallery Properties window.

Tip: You might need to select different objects for different channels because an
object might not fluoresce in all channels.

To adjust the pixel mapping for display, click-drag the vertical green line by click-
ing near it (but not near the yellow cross).

Tip: For fluorescence channels, set the vertical green line that appears on the left
side to the right of the large peak of background pixel intensities as shown above
and set the right vertical green line to the right of the brightest pixel intensities.
Click 'Set Linear Curve' to make the transformation linear. For the brightfield
channel, set the vertical lines to about 50 counts to the right and left of the his-
togram to produce an image with crisp brightfield contrast.

-83 -



Chapter 3

* To change the mapping curve to be logarithmic or exponential, click-drag the
yellow cross.

» Torestore the mapping to a linear curve, Click Set Linear Curve.
e Tosee the full scale for the X Axis Click Full Scale.

» Toset the display mapping of the X Axis to the lowest and highest values for
a selected object, Click Set Range to Pixel Data.

» Toset the scale of the X Axis to the range of the vertical green lines or of all
the pixel intensities for the selected object—whichever is larger—Click Auto-
scale.

* You may enter values manually by selecting the Manual tab.

Aatomatic | M aral

Image Dizplay Mapping # Bz Scale

’ Set Fange to Fikel Data l Full Scale

’ Set Linear Curve l Autozcale

4 If youwant to preview the changes in the Image Gallery, click Preview
Changes in Gallery.

5 Continue customizing the Image Gallery display properties with another pro-
cedure in this section, or click OK to finish and save changes or Cancel to finish
and discard changes.

To customize the Image Gallery views images and masks

1 Within the Image Gallery Properties window, click the Views tab.
Note: The Image Gallery view can be customized to view any combination of
channel images or composites. The default view All Channels is a view that
displays all image channels that were included during acquisition of the file
with their associated default masks. This mask may be changed for the
default view however, the images in this view cannot be changed.

The list of existing views is shown on the left.
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10

11

E Image Gallery Properties

Display Froperties | Yiews | Compasites|
Visws iew Difintion
Mame: |4l Channels |
Colurn
¥ = AllChannels
- DRA0S i B5C [msk: MOT]
¥ NFkB ~Ch2 [mask: MO2)
& 55C ~NFKB [mask: M03]
-~ ChA sk MD4] ‘
~BF [mask: MO5] mage:
L. DRAQS [mask: MOB) [5st =
Mask:
|MO1 v
Hew
e Changes i Gk

To create a new view, Click New. The new view is automatically added to the list
on the left.

In the right section of the window, type in a name for the view.

Click Add Column.

Define the column by selecting an image and a mask or a composite from the
dropdown menu.

Repeat the previous 2 steps until finished adding columns to the view. A column
will be added under the column currently selected. To insert a column click on the
image above insertion point.

Columns may be removed by clicking on Remove Column.

A view may be edited at any time by selecting the view and following the same
procedures.

If you want to delete a view, click the view to select it, and then click Delete.

A confirmation window appears.

If you want to preview any new changes in the Image Gallery, return to the Image
Gallery and choose your new view in the View drop down menu. Then return to
the Image Gallery Properties window and click Preview Changes in Gallery.
Continue customizing the Image Gallery display properties with another pro-
cedure in this section, or click OK to finish and save changes or Cancel to finish
and discard changes.

To create a composite

1

Within the Image Gallery Properties window, click the Compaosites tab.

The list of existing composites is shown on the left.

-85 -



Chapter 3

E Image Gallery Properties g!§|®

Display Properties | Views | Compasites |

5 NFKE / DRAOS !
® Translacalion Nare: [NFKE / DFA05 | Che 0

= NFKB /DRAQS
NFKB (100%) Image: )
DRARS (1007%) wra#]

Percent 100

Pisvisiu Charigas i Galiy

0o N o O A~

In the right section of the window, type a name for the composite or leave blank
to allow the name to be built automatically from the image names added to the
composite.

Click Add Image. The selected image appears in the Object box. Change the
Percent if desired. The percent specifies the percentage of of the image to
include in the composite.

Tip: As you make the changes, the image in the Object box updates accordingly.
If you want to preview any new changes in the Image Gallery, return to the Image
Gallery and select the View drop down menu to your new view. Then return to the
Image Gallery Properties window and click Preview Changes in Gallery.
Continue to add images as desired.

To remove and image from the composite, Click Remove Image.

The composite is automatically added to the list on the left.

A composite can be removed from the list by clicking Delete.

Continue customizing the Image Gallery display properties with another pro-
cedure in this section, or click OK to finish and save changes or Cancel to finish
and discard changes.

Working with Individual Images

You can work with individual images in the Image Gallery. You can zoom in or out on
the images. You can add a larger version of an image to the Analysis Area for further
analysis, show or hide masks for a single image in the Image Gallery, and copy one
or more images to the Clipboard.

To manipulate individual images

1

In the Image Gallery, right-click an image that you are interested in.
A menu appears.
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Add Image to Analysis Area
Show Masks

Coler On

Show Saturation Color
Copy/5ave Image...
Copy/Save Object Images...
Copy/Save Gallery Column...
Copy/Save Gallery...

» Toplace the image in the Analysis Area, click Add Image to Analysis Area.
(For more information, see Analyzing Individual Images.)

» Toshow or hide the masks for the object image, click Show Masks or Hide
Masks, respectively. (One or the other will appear depending on the current
state.)

* Toturn the colors on or off for the object image, click Color On or Color Off,
respectively.(One or the other will appear depending on the current state.)

« Toshow or hide the saturation color for the object image, click Show or Hide
Saturation Color respectively.(One or the other will appear depending on the
current state.)

To copy or save images for use in reports

1 Inthe Image Gallery, right-click an image that you are interested in.
A menu appears.

Add Image to Analysis Area
Show Masks

Color On

Show Saturation Color
Copy/5ave Image...
Copy/Save Object Images...
Copy/Save Gallery Column...
Copy/Save Gallery...

» Tocopy or save the single channel image to the Clipboard, choose
Copy/Save Image

» Tocopy orsave all of the channel images of one object, choose Copy/Save
Object Images.

» Tocopy or save the single channel image for all of the displayed images to the
Clipboard, choose Copy/Save Gallery Column.

» Tocopy orsave all the visible images in the Image Gallery choose
Copy/Save Gallery.
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Overview of the Mask Manager

This section contains the following subsections, which describe how to create, edit,
and delete a mask:

Creating New Masks with the Mask Manager

Overview of the Mask Manager

A mask defines a specific area of an image to use for feature-value calculations. The
IDEAS application contains a Mask Manager for viewing existing masks and cre-
ating new ones.This option is not available for basic FlowSight files without the
Quantitative Imaging (Ql) upgrade.

When the IDEAS application loads a .rif file, the application creates a segmentation
mask for each channel image and stores the mask along with the image in the .cif
file. The masks, labeled MO1 through M12, contain pixels that are detected as
brighter than the background. In addition, the application generates a Combined
Mask, named MC and a Not Combined Mask, Not MC for each object. A combined
mask consists of the union of the masks of all the channels of the object. A Not Com-
bined Mask is all of the pixels with no intensities above background.

You might need to adjust the masks or create new ones that include only a specific
area of a cell, such as the nucleus. You can combine masks by using Boolean logic,
or you can adjust them by applying functions.

Creating New Masks with the Mask Manager

There are two ways to work with new masks in the Mask Manager. First, masks can
be created by using functions, which allows you to choose an input mask and, if
needed, adjust the channel and scalar input. Alternatively, masks can be created by
combining masks through Boolean logic. This option is not available for basic Flow-
Sight files without the Quantitative Imaging (Ql) upgrade.

To create a new mask using Functions

1 Select Analysis > Masks.

The Mask Manager opens with a list of existing masks on the left.
2 Click New.

The right side of the window is enabled to define a new mask.
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= Mask Manager = 28 1
I i
Masks:
Name: w1
Moz
Moz
Mo4 -
|| |mos penion: [ Foncien ] AN ONENR "
Mg Mo1
Mo7
Mog
Mos
M0
M11
M1z
MC
MNone
NMC

Click Function.

The Define Mask Function window appears with 15 available masks to use.
SeeAbout Masks for mask definitions.

» Dilate

* Erode

« Fill

* Inspire

* Intensity

* Interface
*  Morphology
*  Object

* Peak

* Range

» Skeleton

» Spot

+ System

» Threshold
* Valley
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Number of Pixels: 1 EI

#"I'I'I'I'I'I'II
0

[
2 4 6 8 10 12 14 16 19

-
= Define Mask Function = LEI&EQ
Function: Select an object and image to display
17 - ChD1 -
Mask: I:I
[mo1 -
MO

4 Select afunction and choose the input mask(s), channel and scalar parameters
as needed. The right side of the window adjusts the display and view of the chan-
nel image.

« Toview a different object in the file, select it in the Object list or type it's
number.

» Toview a different image for the object, select it from the list.

5 The Link inputs checkbox is checked by default. To modify a mask with different
inputs uncheck this box.

6 Click OK.
7 The new function is added to the mask definition.
8 Click OK.
The new mask name will appear in the list of Masks on the left side.

To create a new combined mask

1 Select Analysis > Masks.

2 Click New.

3 Use the Masks list on the left and the Definition toolbar to build a new mask
using the definitions of existing masks with Boolean logic explained in the table
below.
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Table 1: Mask Tasks and Toolbar

Task Toolbar

Double-click the feature in the Masks list.
Add amask tothe |Or, single click the feature in the Masks list and click the

definition. leftmost down-arrow button on the toolbar.
3

Use the Boolean AND or OR operator.
® Use the AND operator to include only the pixels that
are in both of the original masks.
i# Use the OR operator to include the pixels that are in
either one of the original masks.
Select all pixels that |Use the Boolean NOT operator.
are not in the original | o The NOT operator specifies which mask will not be

Combine two
masks.

mask. used.
Affect the orderof  |Use the parentheses toolbar buttons.
operations. <>

Remove anitem Click the left-arrow button on the toolbar.
from the end of the -

definition.

4 Add masks and Boolean logic to the definition as needed.
5 Click OK to add the definition to the Masks list.
6 Click Close.
Viewing and Editing a Mask
To view a mask definition

1 Select Analysis > Masks.
The Mask Manager window appears.

2= Mask Manager = P
U T
Masks
M| Name:  up
M2
M3
M4
M5 Definition:
106 01
mMo7
Moa
Mg
Mo
M1
mz
Mc
None
NMC
I New
I

2 Click a mask in the Masks list to view the definition in the Definition area.
3 Click Close.

To edit a mask function
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1 Inthe Mask Manager window, select the mask that contains the function you
want to edit.

2 Click Edit.

3 Remove the definition for the combined mask using the back arrow tool as
needed.

-

4 Orclick the Function button on the toolbar for a function mask. The Define Mask
Function window appears.

Function |

5 Click OK when finished.

Example of Creating a Mask
Here is an example of creating a mask of the cytoplasm.

In this example, cells were stained with a green intracellular marker (in Channel 2)
and a red nuclear dye (in Channel 11). You can generate a cytoplasm-specific mask
by first refining the intracellular and nuclear masks and then removing the nuclear
mask pixels from the intracellular mask.

Greyscale Images

1 Observe the default masks in the Image Gallery. Since the default masks are
designed to capture all the light in an image, they tend to include light that exists
beyond the perceived boundaries of the images. In this case, both the intra-
cellular and nuclear masks need to be refined. Start by creating morphology
masks for both channel images because the Morphology mask is designed to
conform to the shape of the image. Note that the Object mask function may also
be used in place of the Morphology mask function.

2 Select Analysis > Masks.
3 Click New.
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4 Click on the Function toolbar button to adjust the mask that will define the whole
cell. The Define Mask Function window appears.

Function |

Select Morphology in the Function list.

Select a starting Mask.

Select Channel 2 (intracellular marker) on the left side of the window.

Click OK.

Click Set Default Name or, enter a new mask name.

10 Click OK to add this mask to the list.

11 To make the Morphology(Nuclear) mask, repeat steps 3-10 using Channel 11.
12 Click Close.

13 To view the resulting morphology masks, open the Image Display Properties win-
dow and, if necessary, select the new mask(s) for the channel.

© 00 d O O

(Icon for Image Display Properties)
14 Next, you will subtract the nuclear morphology mask from the intracellular mask.
In the Mask Manager window, click New.

15 Double-click the Morphology(Intracellular) mask in the list.
16 Click the AND button on the toolbar.

&
17 Click the NOT button on the toolbar.

O

18 Double-click Morphology(Nuclear) mask in the list.
19 Enter a new mask name.

20 Click OKto add this mask to the list.

21 Click Close.

22 To view the resulting mask on a Channel 3 image, open the Image Display Prop-
erties window,and select the new mask for the channel in the view you are using.
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Overview of the Analysis Area

The Analysis Area provides display space for individual images, plots of cellular fea-
ture values, tables of population statistics, tables of object feature values, and text
annotations. You can select different layouts for the IDEAS window and placement
of the analysis area and expand the Analysis Area by dragging it’s boundaries.

The graphs are created into panels of a default size and can be re-sized by dragging
a corner or using the size tool. The position of the panels is automatically adjusted to
fit in the available display space. A vertical scroll bar appears when the number of
panels exceeds the space available on the window. The panels can be re-tiled using
the arrange analysis area tool.

As illustrated by the following figure, the Analysis Area can contain several types of
panels: histogram, histogram overlay, scatter plot, tables of population statistics or
object feature values, channel image, composite image, and text. Each panel will
contain its own toolbar and context menu. To move a panel click on the name at the
top of the graph and drag it to a new location. A graph may be selected and then a
right click in a blank space in the work area allows you to choose paste in the new
location.

T TEE AT

A toolbar is visible at the top of the Analysis Area. The following table describes the
function for each tool.

Analysis Area Tools

Table 1: Analysis Area Tools

Tool

Description

L3 Pointer Tool

Provides the normal mode of interaction with the graphs. Clicking a
point on a scatter-plot graph causes the IDEAS application to display
the corresponding image in the Image Gallery (if the population that is
currently displayed in the Image Gallery contains that point).

Click the bin in a histogram to select the bin. In the Image Gallery, you
can view images of cells in the bin by choosing the Selected Bin pop-
ulation.
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New Histogram Tool

Tool Description
Click Pointer Tool while drawing a region on a graph to cancel the cre-
ation of a region.
Allows you to create a population of hand-picked objects. For more
B Tagging Tool information, see Creating Tagged Populations.
lis Creates a new histogram.

E New Scatter Plot Tool

Creates a new scatter plot. Refer to

Populations Statistics
table

Creates a table to display population statistics.

= Object Feature Values
table

Creates a table to display selected object feature values.

A Text Tool

Allows user to add text notes to the Analysis Area. Refer to Adding
Text to the Analysis Area.

| +

=~ Line Region Tool

Draws a horizontal line on a histogram to define a region.

-l

5| Rectangle Region Tool

Draws a rectangular region on a scatter plot.

+

Oval Region Tool

Draws an oval region on a scatter plot.

Draws a polygon region on a scatter plot graph. Each click starts a
new segment in the polygon until the entire image is double-clicked to

Building Blocks Tool

£ Polygon Region Tool
complete the region.
a § . . . .
H ‘ Wizards Tool Short-cut to using Wizards for guided analysis.
||°’f Short-cut to using Building Blocks for guided analysis.

Select All Tool

Selects all panels in the analysis area.

oo

Tile Graphs Tool

Tiles graphs in the analysis area after changing the size of the anal-
ysis area to fit all graphs to the new space.

(L] Layout Tools

Switches the layout of the image gallery and analysis area.

Graph Bkgd Tool

Changes the background of the graphs to black or white.

gl gl gl

Tools

Graph sizing

Changes the size of selected graphs to small, medium or large.

Creating Graphs

You can add two types of graphs to the Analysis Area:

» Histogram—Graphs a single feature.
» Scatter Plot—Graphs two features.
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Note that building blocks are available that will help you to create graphs for finding
single, focused, fluorescent positive events or a size versus scatter plot. See Build-

ing Blocks.

To create a graph without using a building block

1

9

Click the New Histogram or New Scatter Plot toolbar button.

W [
The New Histogram or New Scatterplot window appears, respectively.
S = - o)
U the contoal key 32 sehect mubiple sooulabons Scalng
¥ Speestends_ 10082 S00M_Flslperert 108 & Ao Mol
# Xe r
@ Lnes

T el Axe.

T ¥ s
" e N

L] XM Fosture:  Choces X s Festure
X Ao Labsl

] Hormalian ' Asis Frequency Brcou: | delot z| s

Select the one or more populations to graph by clicking them. To select more
than one population, use the Ctrl key.

The title defaults to the selected population. You can edit the title.

In the X Axis Feature drop down menu, select the feature that you want to graph
on the X Axis.

If you want to change the label for the X axis, edit the text in the X Axis Label
field.

The label defaults to the name of the selected feature.

If you are creating a scatter plot, select a feature and a label for the Y Axis. If you
are creating a histogram you can choose to normalize the Y axis frequency and
change the bin count.

The default font sizes are used, you may change them by clicking Font Sizes.
Assign colors by Population (default) for dot plots or by Density for density plots.

Set the scaling for each axis of the graph. (The default is Auto, which allows the
application to automatically scale the graph.)

To set minimum and maximum values for an axis, select Manual.

10 Select Linear or Log and enter Maximum and Minimum limits.
11 If you selected Log, enter the X > value.

Note: You can scale the X Axis of a graph or the Y Axis of a scatter plot in one of
two modes: Linear or Log. The Linear mode is the default.

The Log mode allows you to logarithmically scale a section of the graph or
scatter plot. Selecting this mode causes the IDEAS application to perform bi-
exponential plotting. The > X value defines the linear portion of the graph as -X
through X. The application plots the values outside of these limits on a log-
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arithmic scale. You can plot negative values as well as positive ones on a log-
arithmic scale by adjusting the limits.

Take care not to split a population such that it appears to be two separate pop-
ulations. This splitting is especially likely when negative values exist due to com-
pensation or corrections on the imagery. The graph on the left side was plotted on
a linear scale; the ones in the center and on the right side were plotted on log-
arithmic scales. The graph on the right side split the population because the
change from a linear to a logarithmic scale occurred in the middle of the pop-
ulation. In general the >X value should be 1000 for 40 and 60X data and 100 for
20X data.

[RETAT — SRS SIEIETR FeL A Y| EIEIEL xR A1 aelziEE

Hermaloed Fieguercy &

O B U 1L
103500 0 5007e] Sednd !
§_lntmnuity - 400

12 The font sizes can be changed for an individual graph.

13 Click OK.
Tip: After you have created a graph, you can change its properties by right-click-
ing the graph and selecting Graph Properties. The same window that you used
to create the graph will reappear, and you can then make any changes that you
want.

159

Graph Properties...
Statistics...

Show/Hide Legend

Plot Order and Properties...

20
ey

LI PR = ¥
Al

Apply/Remove Regions...

I Clear Selected Bin

Copy Region to Clipboard...

Paste Region from Clipboard

Features...
Masks...
Populations...

Regions...

Export Statistics To Clipboard...
Copy/Save Graph and/or Statistics...
Print Graph...

Normalized Frequency

0 20 40 60 80 100
Gradient RMS_M05_Ch05

To show selected statistics for a graph

1 You can show and hide statistics by clicking the Statistics toolbar button in the
panel that contains the graph.
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Or, right-click anywhere on the graph and click Statistics on the graph context
menu that appears.

The Statistics window appears.

i i’
=~ Graph Statistics i e S
Court [] View statistics

[] %Total
HGated
[ %Plotted
[ Objects/mL

[] Mean
[] Median

[ Std. Dev.
] MAD
oV

[] Minirmum
[] Maximum
[] Geo. Mean
[] Mode

[ Variance

| [] MaN Close |

Select the statistics that you want to display. Check the View statistics box and
the box next to the statistic to be displayed for each population on the graph. The
statistics that are supported are the Count, Percent Total, Percent Gated, Per-
cent, Concentration (count/sample volume), Mean, Median, Standard Deviation,
MAD (Median Average Deviation) RD -Mean, RD -Median, CV, Minimum, Max-
imum, Geometiric Mean, Mode, variance, and NaN (not a number).

When finished, click Close.

To show the legend for a graph

1

Right-click anywhere on the graph, and click Show/Hide Legend on the graph
context menu that appears.

If the legend was hidden, it appears on the graph. If the legend was shown, it dis-
appears from the display.
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Note: The legend contains an entry for each population on the graph. If the graph
is a scatter plot, the legend shows the population and its associated point style
and color. If the graph is a histogram or overlay histogram, the legend shows the
population name, associated color, and line type.

»  Tomove the legend, click and drag it. (You cannot drag the legend past the
boundary of the graph panel.)

To order the plots on a graph or change the fill and lines for a histogram

1 Right-click anywhere on the graph and choose Plot Order and Properties on
the graph context menu that appears. The Display Properties dialog appears.

Moving a Graph

* With any graph in the Analysis Area, you can move it to another location by
clicking in the center of the graph and dragging it. Alternatively, select the
graph, right-click in the a blank space in the analysis area choose cut and then
right-click where you would like to move the graph and choose past.

Creating Regions on Graphs

Regions may be drawn on graphs to create new populations, based on the physical
location of objects on a graph, and to compute statistics. Tools for drawing regions
are found on the Analysis Area toolbar. A line region may be drawn only on a his-
togram. All other types of regions may be drawn only on a scatter plot.

A region can be copied to another graph in the same file or other open files. Regions
may also be copied from one instance of the IDEAS application to another.

When you draw a region on a histogram or scatter plot, you create a population of
objects defined by the region that may be viewed in the Image Gallery or on other
graphs.

To change the attributes of a region or delete a region and the populations dependent
on that region see Using the Region Manager .

To draw a region on a Scatter Plot

On the Analysis Area toolbar, click either the:

* Rectangle Region, or
* Oval Region, or
L}

* Polygon Region button on the Analysis Area toolbar.

+

(v
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1

To

The Rectangle and Oval tools work by clicking on the graph at the point where
you would like to start the region, and drag to the region endpoint.

The region grows as you drag.

Aed  1ed 1.5ed Zed

Click again to complete the region.

If you are drawing a region on a histogram or scatter plot, the Create a Region
window appears.

Name the region.

Click the colored box to select an alternate color.

Select Use for statistics only if you do not want to create a population from this
region.

Click OK.

The region appears on the graph with the name and color that you selected.

Polygon Tool Option

The Polygon tool works by clicking the scatter plot at the point where you would
like to start the polygon.

Click once for each vertex of the polygon.
Double-click to complete the drawing of the region.

A window appears that allows you to name the population created by the polygon
region and to assign the region’s display properties.

Click OK.
The region appears on the graph with the name and color that you selected.

Tip: Before you click OK, you can click Cancel or you can click the Pointer but-
ton on the Analysis Area toolbar if you decide not to create the region.

L3
Draw a region on a Histogram

On the Analysis Area toolbar, click the Line Region tool.

+

Drag the line across the histogram.
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To move or resize a region on a graph

1 Click the Move/Resize Region toolbar button on the graph panel toolbar.
2 Click the region that you would like to move or resize.

When the region is selected, squares that can be moved appear at the vertices
and the label.

3 Thefirst time that you drag the region, the entire region and label move.
4 Dragging a specific vertex or label moves only that vertex or label.

5 Tofinish moving or resizing the regions on the graph, click the Move/Resize
Region toolbar button again to deactivate the tool.

The populations and statistics are updated, and the Move/Resize Region toolbar
button is deactivated.

Note: The recalculation of statistics and populations may take a moment if the
datafile is large or if many populations are dependent on the regions that are
being moved or resized.

To zoom in on the scale of a graph

1 Click the Scaling toolbar button on the graph panel toolbar.
g

2 Click and drag to define a rectangular region for rescaling.

The Zoom Out Scaling toolbar button appears in the graph panel toolbar, next to
the Scaling toolbar button.

gl

3 Click the Zoom Out Scaling toolbar button to automatically scale the graph.
The Zoom Out Scaling toolbar button is removed from the graph panel toolbar.

To resize a graph

-101 -



Chapter 3

» Select the graph(s) to be resized and then click the sizing button tool small,

medium or large. gl & o
» A graph may be resized by dragging the right, bottom or lower, right corner.

Tip: Select multiple graphs to make them all the same size.

To copy and paste a region to another graph

1 Right-click anywhere on a graph, and click Copy Region to Clipboard on the
graph context menu that appears.

The Copy a Region to the Clipboard window appears.
2 Click the region to copy in the list, and click OK.

3 Right-click on the graph where you want to paste the region, and click Paste
Region from Clipboard on the graph context menu that appears.

4 If the region already exists (in other words, you are copying it within the same
instance of the application), the Create a Region window appears.

5 Rename the region and set the display properties for the resulting new pop-
ulation, and click OK.

Note: When you copy a region, the scale is copied and is no longer associated
with the feature from which it was originally drawn. Therefore, the region might
not fit on the new graph.

To Apply or Remove a region on a graph

1 Right-click anywhere on the graph, and click Apply/Remove Region on the
graph context menu that appears. The Apply Graph Regions window appears.

Eﬂpply Graph Regions E]E]

Check the regions to be added to the graph.
Uncheck the regions to be removed.

™| RS

Mote: Only regions that have the same scaling
twpes [ie inear/log) az the graph may be added.

(] 8 | Cancel |

2 Select the regions that you want to appear on the graph.
3 Clear the regions that you want to remove from the graph.
4 Click OK.

To show or hide a population on a scatter plot

1 Click Show/Hide Populations on the graph context menu.
The Show/Hide Populations window appears.
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2 Select the populations that you want to appear on the graph.
3 Clearthe populations that you want to remove from the graph.

ES Show/Hide Populations |:||§|fg|
Select the populations to view:
S|
O E3
O M5
O A1
O Rz
N
4 Click OK.

Tip: On a scatter plot, you may show or hide any population on the graph—regard-
less of the features on the axes. Each scatter plot has an original, or base, pop-
ulation. When you show a population on a scatter plot, only those objects that are
also in the base population will be shown. To aid in the identification of the pop-
ulations shown, change the characteristics of the population(s) in the population
manager.

Analyzing Individual Images

To analyze an image in more detail, place the image in the Analysis Area to view
pixel positions and intensities as well as generate statistics for an area of the image.
You can also show the Measurement tool for the image.

Image panels, which are shown in the following figure, each contain a toolbar in the
upper-right corner and a context menu that appears when you right-click an image.
Animage in the Analysis Area is three times the size of an image in the Image Gal-

lery.
To add an image panel to the Analysis Area

* Right-click an image in the Image Gallery or Analysis Area, and click Add
Image to Analysis Areaon the context menu that appears.

The image panel appears in the Analysis Area.
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T cell G & s I VI ST

To view the individual pixel intensities of a single channel image

* Move the mouse pointer across the image.

The pixel positions and intensities appear under the image. (The pixel (0, 0) is
positioned at the upper left of the image.)

T cell . B3 cH

Pixcel {43, 40) Intensity: 253

To display the Measurement tool in an image panel

» Right-click the image panel, and click Show Measurement Tool on the con-
text menu that appears.

The 10-micron bar appears.
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T cell R+ s I VI ST

To examine a line profile or the statistics for an area of an image

«  While holding the Ctrl key, click and drag to create a boxed area on the image.

The Image Statistics are shown in the image panel. The statistics are cal-
culated for the area that is defined by the box. The line profile (the wavy line in
the image panel) represents the pixel intensity at each position along the red
line of the box.
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ch2 Q. @ ©

Minimum: 13
Mzxdmum: 1089
Mean: 28295
Std. Dew.: 28621
Width: 49
Height: 3
Area: 2597

Close Statistics

To change the display properties of an image

1 Click the Channel Display Properties button on the image panel toolbar.

T cell R & [ I

The Display Properties window appears.

» Forsingle channel image, you can change the displayed mask and adjust the
display intensity mapping. For more information, see Setting the Image Gal-

lery Properties.
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Select a different mask to display:

| valley(MO5, Drags. 2) -

Minimum Poeel Intensity: 17 Maximum Piel Intensity: 187

255

I 100 -

Image Display Mapping X Auis Scale

| Set Range to Pixel Data | | Full Scale
I Set Linear Curve ‘ | Autoscale

» Foracomposite image, you can change the images in the composite and
adjust the percent contribution of each image, see Setting the Image Gallery

Properties.
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a- Display Propertit

Name: |GHTAR=]

= ADAP/Actin/T cell
-~ ADAP (100%) Image:
- Actin (100%) ADAF [~

i T el (100%)

a9

Percert: 100

Add Image | [ Remove Image

2 Click OK.
To show or hide the mask for a single channel image

» Click the Mask button on the image panel toolbar, or right-click the image and
then click Show/Hide Mask on the image context menu.

T cell SR & B[

The mask appears as a transparent cyan overlay on the image.

To turn the color on or off

* Click the Color button on the image panel toolbar, or right-click the image and
then click Color Off or Color On.

T cell SOl & [ha I

Viewing the Object Feature Values

The Object Feature Values table, which is shown in the following figure, displays a

selected set of feature values for selected objects. For each feature, the name,
value, and description are shown.
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Object Feature Values Current Object: 25 v E |

Curmrent

To view and customize the features shown in the Object Data table

1 Click the Object Feature Values tool. =
2 Right-click anywhere in the table area to open the menu.

Select Features..,

Delete Feature

Add Current Object
Delete Object Row

Copy Feature Values to Clipboard

3 Choose Select Features.
The Select Object Features window appears.
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- Select Object Features

Features:

- Area_MO1

- Area_MOZ2

- Area_MO3

- frea_MD4

- frea_MO5

- frea_MODG

- frea_MO7

- Area_MOB

- frea_MOS

- frea_M10

- Area_M11

- frea_M12

- frea_MC

- Aspect Ratio Intensity_M01_Ch01
- Aspect Ratio Intensity_M02_Ch02 5

suiarety (2] (3] (=) (&) (@)

| ok | | cancal |

4 Select the features to view. Multiple features may be chosen by holding down the
Ctrl key.

5 Click OK.
The features appear in the Object Data table.

6 To add selected objects to the table right-click and choose Add Current Object.
To export or copy feature values

* Right-click in the table and choose Copy feature values to clipboard.

Adding Text to the Analysis Area

To add text to the Analysis Area

1 Click the Text button on the Analysis Area toolbar.
A

A text panel is added to the analysis area.
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- .. 1
Enter title...
Enter text here.. -

2 Type atitle and text.

Population Statistics

The Population Statistics table displays selected statistics for chosen populations.
The statistics that are supported are the Count, Percent Total, Percent Gated, Per-
cent, Concentration (count/sample volume), Mean, Median, Standard Deviation,
MAD (Median Average Deviation) RD -Mean, RD -Median, CV, Minimum, Max-
imum, Geometric Mean, Mode, variance, and NaN (not a number).

To view and customize the population statistics

Click the Populations Statistics tool.
Click the + next to the population to expand the list of populations.
Columns can be moved by click-dragging.

Right-click in the grey area in the table or on a column heading and the menu
opens.

AW N =

Edit Statistics Table...
Insert Column

Edit Column

Delete Column
Delete All Columns

Order Columns

Copy Statistics

Copy Statistics - Transposed

5 Edit Statistic Table opens a Statistics Properties window to enable changes to
multiple column statistics.

6 To add a single statistic column select Insert Column.
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7 Select Edit Column to make a change.

8 Todelete a single column right-click on that column and select Delete Column.
9 Select Delete All Columns to clear all statistics.

10 Order Columns places the columns in default order.

11 Copy Statistics copies the selected rows of the table in a text format that can be
pasted into other programs such as Excel.

12 Copy Statistics - Transposed copies the selected rows of the table and trans-
poses the data so that when pasted into other programs such as Excel the rows
become columns.
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Using the Feature Manager

This section describes how to create and delete features and to create multiple fea-
tures by selecting categories. The only new feature options for FlowSight basic files
without QI are combined features. The following subsections cover this information:

Viewing feature definitions

Creating New Features with the Feature Manager

Ranking features by discriminating power

Overview of the Feature Manager

The IDEAS application defines a set of base features that you can use to create fea-
tures for each object. To do so, you use the object’s mask and/or its channel
images. After a feature has been created and its value calculated for all cells, you
can plot the feature values or view them as statistics for any population. For descrip-
tions of all the base features, see Understanding the IDEAS® Features and Masks.

When the IDEAS application opens a .cif or .rif file, the application calculates the
values of features as defined by the selected template. You can refine your template
so that it includes only those features of interest for your experiment.

You use the Feature Manager to examine existing features and to define new ones.
To gain access to the Feature Manager, select Analysis > Features or select it from
one of the context menus that are available in the histogram and scatter plot panels
with a right-click. While the Feature Manager is open, all calculations for creating
graphs and statistics are disabled. However, you may view images and change the
population and channel views. When you close the Feature Manager, any changes
to feature names, definitions, and values are reflected in any currently displayed
graphs and statistics. The values of newly created features are also calculated at
this time.

You can create single features and combined features. You create a single feature
by selecting a base feature, such as Area or Intensity, along with a mask and/or an
image. This option is not available for basic FlowSight files without the Quantitative
Imaging (Ql) upgrade.You can create a combined feature by defining a mathematical
expression that includes one or more single features that exist in the feature list.
FlowSight files without the QI upgrade can utilize the combined feature option.

Some features, such as Area, depend on the boundary of a cell. These features
require you to select a mask that defines the portion of the image to use for the cal-
culation. Other features, such as Max Pixel, depend on pixel intensity meas-
urements and require you to select an image. Other features require you to select a
mask and one or more images.

You can add and remove features from the feature list. The feature definitions are
stored in templates, so the definitions are available when you analyze multiple data
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files. The default template used for ImageStream data or QI FlowSight data includes
most of the base features for each channel image and channel mask that the feature
list contains. Certain features, such as Similarity and Spot, require extensive cal-
culations so the default template does not include them. The reason is to save time

when you load files. However, you can add these features to the feature list.

Viewing feature definitions

To view existing features

1

Click Analysis > Features or select Features from a graph panel context menu.
The Feature Manager window appears.

pu

2> Feature Manager - 092011 X101 unstimulated_1.daf

2 o)

I Features:

~Area_WD1
Area_M02
| - Aea_woz
- Arsa_MO4
I Area_MO5
- Area_MO§
- Arsa_MO7
- Arsa_MO3
- Area_MO3
Area_M10
- Arsa_M11
- Area_M12
Area_MC

& Aspect Ratio Intensity_MO1_Ch01
- Aspect Ratio Intensity_M02_Ch2
.. Borart Dztin lebarsiu W02 k03

»

Feature Type

@ Aspect Ratio Intensity

Name: Aspect Ratio Intensity_M01_Ch01
Mash: Ma1

Image: Chil

Sort features by:

[ New I

[ Deete | [ Eat ]

Add Muttiple Features

Close

2 Choose anicon to sort the features:

Table 1: Sorting Features

Feature Icon

Definition

Sorts features alphabetically.

Sorts features based on the images used.

Sorts features based on the masks used.

Sorts features by category, such as size, loca-
tion, shape, texture, signal strength, and system.

Sorts by base features, such as area, aspect
ratio, intensity, and object number.

3 Click afeature in the Features list to view its definition in the right side of the win-
dow.

Creating New Features with the Feature Manager

To create a new single feature

A single feature uses the definitions of a base feature along with a mask and/or
an image.
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1 Click New in the Feature Manager.
The right-hand area of the Feature Manager is enabled.

Feature Type

* Single Angle j
" Combined

M ame: |

Mask: | Combined Mask j

Set Default Name oK, | Cancel

2 Select Single as the Feature Type.

The Mask and Image lists become visible depending on the single feature
selected.

Featurs Type

& Single =
" Combined
Marme:
Mask:  [Combined Mask =
Image 1:  [Charrel 1 ~|
Imsge 2 [Channel 1 =l

3 Select the mask and/or image that you want.
4 Enter a unique feature name or click Set Default Name.

The default name is the name of the base feature followed by the name of the
mask and name(s) of the image(s).

5 Click OK to add the new feature.
It appears in the Features list on the left side of the Feature Manager.
6 Click Close.

Note: When you close the Feature Manager, the IDEAS application calculates
values for the new features. These calculations may take several minutes,
depending on the number and complexity of the new features and the size of the
image file.

To create multiple features

1 Click Add Multiple Features in the Feature Manager.
2 Sort the feature list alphabetically or categorically.
3 Select multiple base features and masks
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4 Select one image or check the box to create for all channels using default masks

and images.
E Add Features E]@
Select baze features Select feature inputs
=1 [#] Testure ~ [[] Create for all channels using default masks and images
Bright Detail Intensity A3 RPN
Bright Detail Intensity 7 FIECE Masts
Contrast [T 2
Gradient Max MO2 T
Gradient RS r03
H Cantrast Mean
H Cantrast Std MO
H Correlation Mean M =
H Carrelation Std MM
H Energy Mean None A
H Energy Std
H Entropy Mean b Clear Selected
H Entropy Std
H Homogeneity Mean ;
H Hamaogeneity Std Felect image
H Yariance Mean
Tl U i A — SSE
< I3 Ch
— — MFKB
Sort Order
EF
() Alphabetical (%) Categaory DRAOS
Clear Selected Clear Selected
[ Add Features ] [ Cloze

5 Any list can be cleared by clicking the Clear Selected button.
6 When finished click Add Features to add the new features to the list.
7 Confirm the features in the next window.

E Confirm Feature Creation E]@

The following features will be created if they do not already exist.
Do you want to continue?

Bright Detail Intensity R7_tM04_Chd
Contrast_t04_Chd

Gradient Max_td04_Chd

Gradient Rk5_M04_Chd

H Contrast Mean_kM04_Chd_5

H Contrast 5td_M04_Chd_5

H Correlation bMean_M04_Chd_5

H Correlation Std_kM04_Chd_5

H Energy Mean_M04_Chd_5

H Energy Std_t04_Chd 5

H Entropy Mean_M04_Chd_&

H Entropy Std_M04_Chd_&

H Homogeneity Mean_td04_Chd 5
H Homogeneity Std_M04_Chd_&

Delete Selected Features ] [ ()8 ] [ Cancel
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8 Delete any features you do not want to calculate.

9 Click OK when finished. The new features are added to the list in the feature man-
ager.

10 Close the Add Features window.

11 Close the Feature Manager. The new features are calculated when the feature
manager closes.

To create a new combined feature

A combined feature uses one or more single features created by a mathematical
expression.

1 Click New in the Feature Manager.

The right hand area of the Feature Manager is enabled.
2 Select Combined as the Feature Type:

The editing interface appears.

Feature Type

£ Singe =l

" Combined

Name: |

=% 2| 0]=] ] 4| =

Sat Default Name oK Cancel

3 Enter the feature name in the Name box or use Set Default Name after you
have created your expression. The default name is the name of the definition
created.

4 Use the toolbar to build a definition (mathematical expression) of features and
operators:

Table 1: Combined Feature Tasks and Toolbar

Task Toolbar
Double-click the feature in the Features list.
Add afeatureto  |Or, single click the feature in the Features list and select

the definition. click the leftmost down-arrow button on the toolbar.
3

Add an operator or
a parenthesis to
the definition.

Click the corresponding button on the toolbar.
EEIEIPARARIE]

Enter the number in the box and then click the cor-

Add anumberto |responding down-arrow button.

the definition. S

If the area is greyed-out, an operator must be selected first.

Select the function in the list and then click the cor-

Add a functionto [responding down-arrow button.

the definition. - SLY The available functions are ABS (absolute),
B3 COS (cosine), SIN (sine), SQR (square), and

cos

SIM
SGR
SGRT
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Task

Toolbar

SQRT (square root).
If the area is greyed-out, an operator must be selected first.

Remove anitem |Click the left-arrow button on the toolbar.
from the end of the |«
definition.

Ranking

General:

5 Click OK.

6 Click Close.
Note: When you close the Feature Manager, the IDEAS application calculates
values for the new features. These calculations may take several minutes,

depending on the number and complexity of the new features and the size of the
image file.

To delete a feature

1 Select one or more features in the Features list by clicking them. To select more
than one feature, use the Ctrl key.

2 Click Delete.
A warning message will confirm or cancel deletion.
Note: Deleting a feature also deletes any populations that are dependent on that
feature. Your feature list may become large and unwieldy. You can narrow down
the list without deletions by sorting the list. See Using the Feature Manager for
more information.

features by discriminating power

With the IDEAS application you are able to create an unlimited set of features by
using the Mask manager to define location and the Feature manager to choose a
mathematical expression that uses the image pixel data and/or the mask. This can
make it difficult to choose a feature that provides good statistical separation of pop-
ulations of cells that have different appearances from each other. The following pro-
cedure describes the manual process to find features that separate two populations
of cells from each other with minimal knowledge of the feature set. A general descrip-
tion of the steps is followed by a specific example.

Note: IDEAS 6.0 includes the 'Feature Finder' wizard which replaces this manual
process. This process may still be useful for making features that are not included in
the feature finder template. See theFeature Finder Wizard for more details.

1 Setimage display and draw preliminary regions to include cells of interest (i.e. sin-
gle, focused, positive cells).

2 Visually inspect overall quality of images and experiment to determine whether to
proceed or redo the experiment.

3 Create two tagged ‘truth’ populations of cells that represent the phenotypes you
wish to discriminate. Perform the discrimination on one characteristic difference
at atime.

4 Create any additional masks and features you think may help differentiate the
truth populations.
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Example:

5 Calculate the statistical discrimination (RD) between the two populations
afforded by features in 1 category at a time. Pick the top feature for each cat-
egory.

6 Plot the features with the highest RD for the truth populations for each category

7 Validate by applying the feature to the base population, independent controls if
available and on multiple files and experiments.

Treatment-induced actin polarization. The data file is available for practice. Log in to
your account on the Amnis website and look in the folder ‘Training data files’.

* Cells were incubated with inducing compound for 1 hour.

* The nucleus was probed with DAPI and actin stained with FITC.
» Large event image files were collected on the ImageStream.

» Compensation and analysis was done in IDEAS.

The following steps find the best features that distinguish changes in actin dis-
tribution.

1 Gate single, focused, actin-positive cells. View cells of interest.

2 Create the truth populations from within the cells of interest using the tagging
tool.

Note: If truth populations are in different files, merge them together before begin-
ning. When selecting truth populations, choose images that represent the full phe-
notypic range of each truth. In this example case, note that the ‘uniform actin’
truth population contains cells of varying shape and intensity that all have uniform
actin distribution. Bias introduced during the selection of truth populations will
likely also bias the outcome during statistical ranking.
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The following figure shows the truth populations chosen to find a feature to dis-
criminate uniform versus polarized actin:

Uniform actin Polarized actin

2_FITC 2_FITC 2_FITC _FITC FITC

3 Create the Morphology and one or moreThreshold masks for the actin image.

4 Create features from the Size, Shape, and Texture categories using the Mor-
phology, Threshold and Default actin channel masks.

a. Choose Features from the Analysis menu and click
Add Multiple Features.

Features

Feature Type
.- Area_MO1
- Area_MD2

_M03 MName:

- Aspect Ratio Inten: )2

- Aspect Ra{ln \rrlen sity_MO1 Ch 1
ﬂﬂﬂﬂﬂﬂﬂﬂﬂﬂﬂﬂﬂ a1 cln

Sort festures by - \_I I_/ i l

| | Delete: |

Add Mult\ple Features.. . Close

b. In the Add Features window select Category as the

‘Sort Order’. ‘é/
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m ™
=~ Add Features - — e - - e B
Select base features Select feature inputs
|_¢_||E Size [7] Create for all channels using default masks and images
F_||:| Location
F_IEi Shiapie Select masks
EI--Texture I
-] Signal Strength
-] Comparisan
-] System
Clear Selected
Select image

Sort Order

() Aphabetical @ Category

a

G Sescd

I Add Features ] l Close l

c. Check Size, Shape and Texture base feature boxes.
d. Select the actin masks (Morphology, Object, Thresh-
old, M02)

e. Select the actinimage (FITC).

f. Click Add Features to display the list of features to
add.

g.In the next window Click OK to add the fea-
tures.Features that already exist will not be recal-
culated.

h. Click OK and Click Close.

i. Close the Feature Manager by clicking Close and the
features will be calculated.

Add the feature statistics to the population statistics table. Do this one category
at a time. Multiple statistics tables can be added to the analysis area, one for
each category of features.

Once the features are calculated you can use the RD,(
Fischer's Discriminant Ratio) to a statistics table. The

RD measures the separation between 2 populations. In
this case, the 2 truth populations picked in step 2. In
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order to get the statistic for 1 category at a time, select
all of the features for the image and then deselect cat-
egories, to leave 1 category for the channel selected.

a. Click onl=l to add a statistics table to the analysis
area.

b. Right-click in the table and choose Edit Statistics
Table.

c. Delete any statistics from the list.

d. Select the statistic ‘RD -Mean’.

e. Select one of the truth populations in the Reference
population box.

f. Sort by Images Used by clicking on the icon .
g. Check the box for the Ch02/Actin image.

h. Sort the features by Category .

Selected Statistics Create Mew Statistics

Statistics
Standard Deviation
MAD

RD - Median
cv

Reference population {f required) B
unifom actin |Z|

Features (if required) I

=[] 1_BF

i E-F12_Actin @
&-C]cho3

I [-[]6_S5C I
&-[C]7_DAPI

E-C]Chos

EICh11

1|6:| >

() ()
Sort features by:

| Delete | [ Edi
H
| |

i. De-select all but 1 category by checking and uncheck-
ing the box for the categories you want to de-select.
Note that the box next to the category will be checked
only if all of the features (all channels) in the category
are selected.
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=7E" e e

Area_Fill(Threshold(M02, -] Area_Fill{Threshald{M02, 2_Acti
Area_MO1 [0 Area_M01

Area_MO2 [ Area_mo2

First check all, then uncheck to
deselect all features in a category

TTRrEES
[ Area_m11
[C] Arez_mC
[ 1

j- Click ‘Add Statistics’.
k. Click Close.

I. Repeat until each statistics table contains 1 category
of features for ChO2(Actin).

6 Launch Excel and then Copy and Paste the statistics into the excel spreadsheet.

a. Select the row of statistics for the 2nd truth population
(the one not chosen above).

b. Right-click in the statistics table and choose Copy
Statistics - Transposed.

c. Paste into an Excel spreadsheet.

d. Keep all of the features and values selected and sort
the data set on the values column (heading may be the
population name) largest to smallest. The feature with
the largest RD will be at the top.

Note: you may have NaN values for some of the fea-
tures. This means Not a Number and occurs in some
cases when there is a division by 0. These can be
ignored.

7 Validate the features in IDEAS. Plot the features with the highest RD for the truth
populations and draw regions to discriminate.

8 Apply regions to the base population, independent controls if available and on mul-
tiple files and experiments.

9 Look for false negative and positive cells.
10 Repeat process if necessary by refining/creating new truth populations.

NOTES ON EVALUATING THE FEATURES:

Consider the features that produce the highest Rd. If there are any intensity based
features make sure that the staining was not uneven due to technical issues. Ifitis a
size feature, does it make sense with what you know about the cells and biology of
your experimental system? Since the feature value ranges vary between features
this is an approximate comparison and the result should be validated by viewing
images across the feature range from the whole population.
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Using the Population Manager

A population is a group of objects. You create populations by drawing regions on
graphs, by hand-selecting (tagging) objects in the Image Gallery or on plots, or by
combining existing populations. After a population has been defined, you can view it
in the Image Gallery or on a plot and you can use it to calculate statistics.

The Population Manager provides a central place for maintaining the display prop-
erties of existing populations and for creating new combined populations.

To open the Population Manager and view the population definitions

1 Select Analysis > Populations or right click a graph and select Populations.

The Population Manager window appears.

I Population Mansger

=% 092001 X101 unstimuisted_% of A

Pepuistors Properties
iame
B
e

D My Cor
Symbol: | Simpie Dot

Defintion:

[ESEr==]

Light Mode Coler [

=

Note: The list of populations is presented as a hierarchy that shows the depend-
encies of the populations on each other. The icon associated with a population

indicates how the population is defined.

icon Defined by
© Tagging
IR~ Region
L=l Combined

The definition of a selected population is shown in the Definition area.

To edit the display properties of a population

Change the name in the Name box.

D O WN =

Click Revert to reject the changes.

To delete a population

Within the Population Manager, click a population in the Populations list.

Click a Color square to select a new color on the color palette and click OK.
Click a display symbol in the Symbol drop down menu.
Click Close to save the population changes.

1 Within the Population Manager, click a population in the Populations list.
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2 Click Delete.

A confirmation warning message appears indicating all the dependent pop-
ulations that will also be deleted.

3 Click Yes to confirm.
To create a new combined population

1 Within the Population Manager (Analysis > Populations), click New.

The right side of the Population Manager window changes to allow you to define a
new population.

2 Poprtann Manager )

i Papetes

¢¢¢¢¢

Fls@GBouss

Enter a unique population name in the Name box.
Click a Color square to select a new color on the color palette and click OK.
Click a display symbol in the Symbol drop down menu.

Use the toolbar to build the population definition as described in the table and
click OK when done:

a b~ W N

Properties

Name: R4 And Not Tagged

Dark Made Color: D Light Mode Color: E]
—

Definition

Al [l ¥ EEBE O+
E 092011 X101 unstimulated 1t cif
B33 Al
B+ R1
=-[3 R2
-0 R3
b R4
-0
ok | [ caneal

Table 1: Population Tasks and Toolbar

Task Toolbar
Add a population to the def-
inition.

Select the population from the drop-down menu.
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Task

Toolbar

Combine two populations.

Use the Boolean AND or OR operator.
@ Usethe AND operator to include only the objects that
are in both of the original populations.
7 Use the OR operator to include the objects that are in
either one of the original populations.

Select objects that are not in
the original population.

Use the Boolean NOT operator.
o The NOT operator specifies which population will not
be used. Note: you must use AND before NOT.

Affect the order of operations.

Use the parentheses toolbar buttons. -

Remove an item from the end
of the definition.

Click the left-arrow button on the toolbar.
-

See Creating Tagged Populations for information about tagged populations.
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Creating Tagged Populations

You can hand-select objects from either the Image Gallery or a graph and group them
into a population.

To create a hand-selected population

1 Click the Tagging Mode toolbar button to begin.

Ro

The Tagged Population window appears.
2 Tagged Populations _- = é}

Tagged Populations

Image viewing mode:

() Update existing
@ Crdenew Nuclear Localization_Ch01_Ch07 Ch +

#Objects Tagged:

2 Select either Update existing or Create New.

* ToCreate New, double-click images within the Image Gallery and select
Save. Enter a new population name. Each population is given a new color and
the symbol solid diamond for ease of viewing in plots.

3 If you selected Update existing, choose a population to update in the drop down
menu.

4 Inthe Image viewing mode list, choose the mode that you want from the drop
down menu. See Setting the Image Gallery Properties for more information.

5 Toadd or remove an image from the tagged population, double-click either the
image in the Image Gallery or a dot in a bivariate plot.

The selected channel image for each tagged cell is displayed in the viewing area
of the Tagged Populations window. In the Image Gallery, a small smiley-face

icon appears on the left side of each tagged image. Each tagged object is also dis-
played as a yellow star in a graph in the Analysis Area. The number of objects in
the tagged population is updated in the bottom, left corner.

6 If you are updating an existing population, click the Update button in the Tagged
Populations window.

7 When you are finished updating, click Close in the Tagged Populations window.
Note: The tagging mode remains open until you click Close, and as long as the
Image Gallery is in tagging mode, you cannot create, resize, or move any regions
on the graphs.
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Creating a tagged population from a file of object numbers

You can use a comma-separated text file of object numbers to create a tagged pop-
ulation.

Select Create Tagged Population from File under the Tools menu.

-

= Create a Tagged Population From a File = | Bt S

Select a comma-separated text file that containg the object numbers for the population.

Create the tagged population

Population name:

Darc Mode Color:

Light Mode Color:

Symbal:

(| =[]

[ oK ] [ Cancel

Browse for the file.

Name the population, select the color, symbol and click OK.
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Using the Region Manager

The Region Manager provides a central place for defining the display properties,
names, and positions of existing regions. Regions can be deleted in the Region Man-
ager tool.

Regions are drawn on graphs to create new populations, based on the physical loca-
tion of objects on a graph, and to compute statistics. Tools for drawing regions are
found on the Analysis Area toolbar. See Creating Regions on Graphs for more infor-
mation.

To open the Region Manager and view the region definitions

1 Select Analysis > Regions or right click a graph and select Regions.

The Region Manager window appears. Click on the region in the list you want to
view.

(:_" Region Manager M

Name: R1

R3
R4 Dark Mode Color: I_

[ Use for statistics only

Shape: Rectangle

Vertices
X Coordinate | Y Coordinate
59.54751131221 1.041951213512

-

| |407.2398150045 0.679024390243

To edit a region

Within the Region Manager, click a region in the Regions list.

Change the name in the Name box.

Click a Color square to select a new color on the color palette and click OK.
Change the X or Y position of the vertices in the Vertices box.

Select or de-select the Use for statistics only box.

Click Delete to delete a region.

Click Revert to reject the changes.

Click Close when finished.

0 N O oA WN =
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Note: When a region is deleted, all populations that are defined by that region will be
deleted. A warning dialog box appears listing the populations that will be deleted.
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Creating Reports and Exporting Data

The following six-page sample report was created by copying data
from IDEAS, the ImageStream Data Acquistion forms and excel into
a MS word document. This template can be found in the customer
documents in your training materials or in the knowledge-base of
your account on the Amnis website.

RreamEY Eyurery
of BREWN BT EIMRAEER &1

Once you have finished analysing an experiment you will want to
report the results into third party applications. To streamline the proc-
ess the first step is to define your application defaults, image gallery
settings and statistics report definitions. This section covers the fol-
lowing topics that will help you to create reports.

Viewing and Changing the Application Defaults

Setting the Image Gallery Properties

Prepare the image gallery and analysis area for reporting.

Copy full or partial screens

Copy images to the clipboard or save images to files

Copy graphs to the clipboard or save graphs to afile

Reporting Statistics
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Exporting Data into other analysis applications
Printing Data

Viewing and Changing the Application Defaults

To view or change these defaults, chooseApplication Defaults from
the Options menu, Each tab allows you to view or change the
default settings.

|| Directories | Populations | Masks I Graph Display I Graph Export | Image Export I Colors |

Default Data Fles Directony

C:\Userssfriend\Desktop \MFkB Translocation FS

Update automatically when file is selected

Default Template Files Directony

C:\Users'sfriend"\App Data“Foaming"Amnis Corporationtemplates

[ Update automatically when file is selected Use defautt data directory

Default Batch Report Files Directory

C:\Users'sfriend"\AppData"Roaming"Amnis Coporation“batches

[ Update automatically when file is selected

Default Compensation Matrix Files Directory
C:\Users"sfriend"\App Data\FRoaming"Amnis Comporation\compensation

[ Update automatically when file is selected Use default data directory

0K | [ Cancel
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The Directories tab contains the default Data, Template, Batch or Compensation
Matrix file directories.

|| Directories | Populations I IMasks I Graph Display I Graph Export | Image Export I Colors |

Default Data Files Directory

C:\Users'sfriend"Desktop NFkB Translocation FS

Update automatically when file is selected

Default Template Files Directony

C:\Users'sfriend"App Data“\Roaming\Amnig Corporationtemplates

[ Update automatically when file is selected Use default data directory

Default Batch Report Files Directory

C:\Users'sfriend App Data"\Roaming ' Amnis Corporationbatches

7] Update automatically when file is selected

Default Compensation Matrix Files Directory

C:M\Users'sfriend App Data"\Roaming Amnis Corporationwcompensation

7] Update automatically when file is selected Use default data directory
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The Populations tab contains the default color or symbol for populations. To change
the default settings, click on the color to or choose a default symbol from the list.

||| Directories Fopulations | Masks I Graph Display I Graph Export I Image Export I Colorsl

| Default Color: D

Defautt Symbol:  Simple Dot -

The Masks tab contains the default mask color. To change the color of the mask
click on the color button.

L hl

|| Directories | F‘opulatior15| Masks |Gmph Display I Graph Export I Image Export | Color5|

| Default Color: @

The Graph Displaytab contains the default list of statistics shown for a graph.
Check the box next to the statistic to have it show below the graphs when statistics
are shown for a graph. The default graph size and font size for the graphs in the anal-
ysis area may be changed in this tab.
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|i| Directories I Populations I Masks | Graph Display |G|E|ph Export | Image Export ICoIors |

Default Graph Statistics Default Graph Size

Court @ Smal

[C] %Total ) Medium
Gated
7] %Plottzd © Large
[] Objects/mL

M
% M::I::ln Default Graph Font Sizes

[ Std. Dev.
] MAD Title: (12 =
[ cv
[] Minimum fods Labels: (10 -
[] Madmum
[] Geo. Mean Tick Mark Labels: (10 =
[] Mode
] Varance Region Mames: (10

] NaN

Update Graphs in Analysis fArea

[] Graph Size Spply to Al
[ Fort Sizes Appiy to Selected

[ Statistics

The Graph Export tab contains the default settings for printing and exporting graphs
when copying and pasting from IDEAS for reporting into other programs.
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|i| Directories I Populations I Masks I Graph Display| Graph Export |Image Export ICoIors |

Graph
Size (300 DPT)

Width: (1027 =]  Height: [0.947 = [E

Lock aspect ratio

Fort Size

Tile: 12 v|  Tick mark labels:
Pois labels: |12 = Region names:

Default export settings to @ Graph 0 Defaults

Graph Options
] Legend Show sample name in title
] Cursor

[ Statistics
Font Size

Title: |12 - Values:
Headers:

The Image Export tab contains the default settings for image export when copying
and pasting from IDEAS for reporting into other programs.
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I

||| Directories I Populations I Masks I Graph Display I Graph Export | Image Export | Colors

Options
Show channel names l_
[ Show object number Show scale bar

Background
@ Black ) White @ Transparent

Fort Sizes

Channel names: |12 =

Scalebar: (12 =

Object number: |10 =

The Colors tab contains the mapping of dark and light mode colors.

4~ Application Defaults

Directories | Populations | Masks [ Statistics [ Graphs | Image Export | Colors

Map population colors for light and dark graph backgrounds

Select a dark mode color a light mode color

ORECE N R
o {mfof T IRl fafof [
I Il
I T
EEEEEN EEEEEN

[ Update Populations in Open Files ]
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Setting the Image Gallery Properties

When a new data file opens in the default template, you might find it difficult to
clearly see cell morphology because the Image Gallery display properties have not
yet been properly adjusted for the data set.

To optimize the display you may use the wizard Display Properties Wizard to set the
pixel intensity mapping to the display range. Manual adjustment and other settings
are described below.

Clicking the Image Gallery Properties toolbar button opens the Image Gallery Prop-
erties window, which contains the following tabs:

©

» Display Properties—Allows you to define the name, color, and display inten-
sity mapping for each image. Allows adjustment of the image size for the
image gallery.

* Views—Allows you to customize the views for the Image Gallery.

»  Composites—Allows you to create composites and adjust the amount of color
from a channel that is included in a composite image.

To customize the Image Gallery display properties

1 Click the Image Gallery Properties toolbar button to begin.

0

The Image Gallery Properties window appears with the Display Properties
tab displayed.
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Display Properties | Views | Composites |

Images

chot Neme:  ChOZ coor: ()

ChD2

Cro3, Minimum Pirel Intensty: 15 Maximum Picel Intensity: 1484
ChD4
Chos Ey

Cho&

Cho8
Chog
Ch10
Ch11
Ch12

2000
Automatic | Manual

Image Display Mapping X Ads Scale

Dleoky Widkiy Disginy Helght [ 5et Rangeto Pl Data | [ RdScle |

@ Channel Width

[ setlnearCuve | [ Adoscae |
©) Ao Fe ® Aot
a [FE 3205

To change the size of the panels in the image gallery

1

Display Width and Display Height can be specified or changed to Auto Fit in the
lower left section of this window.

To change the name or color for each image

1

Select animage in the list of images on the Display Properties tab of the Image
Gallery Properties window.

On the right side of the window you can type a new, unique name for the selected
image. Note that each image is provided with a default name and the image
names appear near the top of the Image Gallery.

Click the colored square for the selected image.
Click the color that you want in the color palette.
Click OK to close the palette.

Tip: The grayscale image in each channel is assigned a default color forimage
display in the gallery. Setting the color to white is equivalent to using the original
grayscale image. The colors are also used to build composite images.

To fine-tune the image display intensity for an image

1

On the Display Properties tab of the Image Gallery Properties window, select
an image by clicking the image name in the list. The graph for the currently
selected image is shown in the window and updates as the changes are made.
Select and image in the image gallery that has intensities for the image channel
you are adjusting.
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Note: You will adjust the Display Intensity settings on the graph (the Y Axis),
the value of the display to (the X axis), the range of pixel intensities. The range of
pixel intensities will depend on the instrument and the collection mode set during
acquisition. The display range is 0-255; the range of intensities from the camera
is 0-4095 for the ImageStreamX or 0-32,767 for EDF mode collection. The IS100
first generation instrument has a 10 bit camera and therefore the range of pixel
intensities is 0-1023. The limits of the graph enable you to use the full dynamic
range of the display to map the pixel intensities of the image.

. [ I I
] 1000 2000 3000 4095

At each intensity on the X Axis of the graph, the gray histogram shows the
number of pixels in the image. This histogram provides you with a general sense
of the range of pixel intensities in the image. The dotted green line maps the pixel
intensities to the display intensities, which are in the 0-255 range.
Manual setting is done by Click-dragging the vertical green line on the left side
(crossing the X Axis at 0) allows you to set the display pixel intensity to O for all
intensities that appear to the left of that line. Doing so removes background noise
from the image.
Click-dragging the vertical green line on the right side allows you to set the dis-
play pixel intensity to 255 for all intensities that appear to the right of that line.
From the Image Gallery window, select the object to use for setting the mapping.
It appears in the Image Gallery Properties window.
Tip: You might need to select different objects for different channels because an
object might not fluoresce in all channels.
To adjust the pixel mapping for display, click-drag the vertical green line by click-
ing near it (but not near the yellow cross).
Tip: For fluorescence channels, set the vertical green line that appears on the left
side to the right of the large peak of background pixel intensities as shown above
and set the right vertical green line to the right of the brightest pixel intensities.
Click 'Set Linear Curve' to make the transformation linear. For the brightfield
channel, set the vertical lines to about 50 counts to the right and left of the his-
togram to produce an image with crisp brightfield contrast.
* To change the mapping curve to be logarithmic or exponential, click-drag the
yellow cross.

» Torestore the mapping to a linear curve, Click Set Linear Curve.
* Tosee the full scale for the X Axis Click Full Scale.

» Toset the display mapping of the X Axis to the lowest and highest values for
a selected object, Click Set Range to Pixel Data.
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* Toset the scale of the X Axis to the range of the vertical green lines or of all
the pixel intensities for the selected object—whichever is larger—Click Auto-
scale.

* You may enter values manually by selecting the Manual tab.

Aatomatic | Marual

Image Dizplay Mapping # Bz Scale

’ Set Range to Pixel Data l Full Scale

’ Set Linear Curve l Autozcale

4 If youwant to preview the changes in the Image Gallery, click Preview
Changes in Gallery.

5 Continue customizing the Image Gallery display properties with another pro-
cedure in this section, or click OK to finish and save changes or Cancel to finish
and discard changes.

To customize the Image Gallery views images and masks

1 Within the Image Gallery Properties window, click the Views tab.
Note: The Image Gallery view can be customized to view any combination of
channel images or composites. The default view All Channels is a view that
displays all image channels that were included during acquisition of the file
with their associated default masks. This mask may be changed for the
default view however, the images in this view cannot be changed.

The list of existing views is shown on the left.

= Image Gallery Properties

Display Propertiss | Views | Composites|
Wi View Difinition
Mame: [8Channele |
; Cal
i o & Al Channes i
f DRAGS S5 (mask: WMD)
o HB Ch2 (mask: MD2)
- 550 NFKE [mask: MO3)
e ChA sk MDA] ‘
L-BF (mack: MO5] aeEl
i DRAOS (mask: MOB] S8L ﬂ:l'
Mask.
MOl b
New
Fieview Changes in Gallery =
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10

11

To create a new view, Click New. The new view is automatically added to the list
on the left.

In the right section of the window, type in a name for the view.

Click Add Column.

Define the column by selecting an image and a mask or a composite from the
dropdown menu.

Repeat the previous 2 steps until finished adding columns to the view. A column
will be added under the column currently selected. To insert a column click on the
image above insertion point.

Columns may be removed by clicking on Remove Column.

A view may be edited at any time by selecting the view and following the same
procedures.

If you want to delete a view, click the view to select it, and then click Delete.

A confirmation window appears.

If you want to preview any new changes in the Image Gallery, return to the Image
Gallery and choose your new view in the View drop down menu. Then return to
the Image Gallery Properties window and click Preview Changes in Gallery.
Continue customizing the Image Gallery display properties with another pro-
cedure in this section, or click OK to finish and save changes or Cancel to finish
and discard changes.

To create a composite

1

Within the Image Gallery Properties window, click the Compaosites tab.

The list of existing composites is shown on the left.

E Image Gallery Properties E“i'@

Display Propetties | Views | Compasites |

[#- MFKB / DRAQS —
- Translocation Name: |NFKE / DRAQS Dhectl

= NFKE / DRAQS i
NFKB (1002%) a0c;
DRAGS [100%) wre 7]

Percent; 100

2

In the right section of the window, type a name for the composite or leave blank
to allow the name to be built automatically from the image names added to the
composite.

- 142 -



Creating Reports and Exporting Data

0 N O OB~

Click Add Image. The selected image appears in the Object box. Change the
Percent if desired. The percent specifies the percentage of of the image to
include in the composite.

Tip: As you make the changes, the image in the Object box updates accordingly.
If you want to preview any new changes in the Image Gallery, return to the Image
Gallery and select the View drop down menu to your new view. Then return to the
Image Gallery Properties window and click Preview Changes in Gallery.
Continue to add images as desired.

To remove and image from the composite, Click Remove Image.

The composite is automatically added to the list on the left.

A composite can be removed from the list by clicking Delete.

Continue customizing the Image Gallery display properties with another pro-
cedure in this section, or click OK to finish and save changes or Cancel to finish
and discard changes.
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Reporting Images and Graphs

The IDEAS application allows users to copy and print images and graphs, export sta-
tistics, feature data, pixel data, or TIF files for separate analyses.

Prepare the image gallery and analysis area for reporting.

1 Before you print or copy images, see Setting the Image Gallery Properties to opti-
mize the image display.

2 Inaddition to formatting the graphs and statistics in the Analysis area (see Over-
view of the Analysis Area), the IDEAS application provides color mapping from
the dark mode that you see in the Analysis Area to a light mode that has a white
background for the printing and exporting of data. Because the population colors
might not show on a white background, you can change the colors when using
the light mode.

To use light background graphs in the Analysis Area

Click the graph background tool to switch between light or dark mode. I,

To map the dark mode colors to light mode colors

1 See the Application Defaults-Colors tab .

Directories | Populations I Masks IStatlstlcs IGmphs | Image Exnortl Colors

Map population colors for light and dark graph backgrounds

Select a dark mode color a light mode color

(mEC T rEECEE
EET AN e [T
EEEEET EEEEET
EEEEEN EEEEEN
EEEEEN EEEEEN

[ Update Populations in Open Files ]

ok ] [caea ]

2 Click Update Populations in Open Files when done..
3 Click OKto save the changes or Cancel to exit.

Copy full or partial screens

To copy the entire screen to the Clipboard
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* Press CTRL+PRINT SCREEN. It is then available for pasting into a third
party application.

To copy a window to the Clipboard
» Select the window and then press ALT+PRINT SCREEN. It is then available
for pasting into a third party application.
Print the analysis area or image gallery directly
To print the Analysis Area data

« Select Reports > Print Analysis Area.

The IDEAS application prints all the graphs, statistics, text panels, and
images that are displayed in the Analysis Area.

To print the Image Gallery data

* Select Reports > Print Image Gallery.
The IDEAS application prints all the images that are visible in the Image Gal-
lery.

Copy images to the clipboard or save images to files
To copy or save Images

1 Right-click anywhere in the Image Gallery and then choose one of the following
options:

» Copy/Save Image for a single image
» Copy/Save Object Images for the row of images for one object

* Copy/Save Gallery Column for the images of one channel in the
current gallery

» Copy/Save Gallery for all images in the current gallery

2 A preview of the image(s) is shown. Changes from the default settings may be
made to the following:

*  Show Channel names

»  Show Object number

» Show Scale bar

» Text color for channel names

» Background

* Number of rows and columns

» Size and DPI settings

* Font sizes and clipboard format
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Opiona
7] Show Charrel Names | Ted Color.. | [
Object rumber
b @ Back
i
¥| Scale bar Transpacent
Image S
| |
I Rows. 3 o Z
|
Width: 30 000 n DPE: 300
Fort Sices Upsbwand Furmal
1 & Metaie
Charnel Names:
Bemap
Setleber 12
Object rumber. | 10
[ savetmre | | copyracimoms | [ e

3 The settings may be Saved to the Default settings or Default set-
tings may be loaded.

4 Click Save to File or Copy to Clipboard when done. Files may be
saved as .png, .bmp or .tif formats.

5 If Copy to Clipboard was chosen, paste into third party application.

Copy graphs to the clipboard or save graphs to a file
To copy or save graphs

1 Right click anywhere in the graph and choose Copy/Save Graph and/or Statistic.

2 A preview of the graph is shown. Changes from the default settings may be made
to the following:

* Include Graph
* Graph Size
*  Fontsizes

These first three settings are loaded from the graph - you may choose
to load the default settings that are set in the applications defaults tab.

* Include Legend

* Include Sample name in title
*  White background on/off

* Include Cursor

* Include Statistics

» Font sizes for statistics

3 If changes are made they can be previewed by clicking Generate Preview.
Otherwise they will be applied when Save to File or Copy to Clipboard is chosen.

4 Option: settings may be saved to default settings or loaded from default settings.

5 Click Save to File or Copy to Clipboard when done. Files may be saved as
.png, .bmp or .tif formats.

6 If Copy to Clipboard was chosen, paste into third party application.
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(@ corsor s massea D D TR
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R1-050611 FS 12 THP1
SEEIN NFKE Dy LPS
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o
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| Losd Graph Settings | [ Load Defaut Settings | Similarity_Morphology(MO5,
|l Graph Gptions
[ Legend ‘Show sample name in tle
| White background
[ Statistics
Font Size
Ttle Values
Headers:
Save as Defaut Settings Generate Previe SaveloFle.. | [CopytoCipoard | [ Close

To export graph statistics to the Clipboard

Right-click a graph and then click Export Statistics To Clipboard. They are
then available for pasting into a third party application.

To copy population statistics from a Statistics Table

Right-click the table and then click Copy Statistics or Copy Statistics -
transposed. They are then available for pasting into a third party application.
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Reporting Statistics

Define a Statistics Report

A statistics report definition can be saved in a .daf file or an .ast template file. It
allows users to select specific statistics within a .daf file and open the data in Excel.

A statistics report can be generated during batching if it is part of the template used.
It may also be applied to pre-existing .daf files from the Reporting menu. In this
case, the rest of the template is not processed—only the report. The statistics report
definition allows you to specify population percentages and feature statistics and the
layout of the report is accessed from the reporting menu.

To create a Statistics Report Definition

1 Select Reports > Define Statistics Report.
The Statistics Report Definition appears.

== |

Statistic Columns

[ AddColumns | [Delete Columns |

Report tite: 092011 X101 unstimulated_1t.daf_stats Generats Report ok | [ Ccancal |

2 EnteraReport title.

3 Under the Statistic Columns clickAdd Columns. The Add Statistic Report Col-
umn window opens.

4 Select the statistic(s) in the Statistics list.
» Count - the absolute count of the populations
*  %Total - percentage of a population as a percentage of Al
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*  %Gated - the percent of one population as a percentage of another, but not
used for tagged populations

* % - the percentage of one population as a percentage of another, also is used
for tagged populations

*  Objects/mL - the concentration of the population in the sample run.
* CV -the coefficient variable

* Geometric Mean - standard statistical definition

* Maximum - standard statistical definition

* Mean - standard statistical definition

» Median - standard statistical definition

* MAD - standard statistical definition

*  Minimum - standard statistical definition

* Mode - standard statistical definition

* RD - Median - the ratio discriminant (Fisher's discriminant) using the Median
and MAD

* RD - Mean - the ratio discriminant (Fisher's discriminant) using the Mean and
StdDev

- Standard Deviation - standard statistical definition
¢ Variance - standard statistical definition

» NaN - stands for not a number; the number of objects whose values are not
valid numbers.

5 Select a population to base on the selected statistic(s).
6 Select a reference population if necessary. This is required for % and RD.

7 Select aFeature. This is not necessary for the %-related statistics, Count or
Objects/ml.

8 Click Add Statistics.The statistic is added to the list.
9 Click Close when finished.
10 Select a statistic in the list to view the definition or edit any input.

11 Change the name of the statistic by unchecking Use default title and typing a
new name if desired..

12 Delete Columns removes a selected statistic.
13 To reorder the list click-drag a statistic to it's new location.

14 Click Generate Report when complete to generate a report for a
current (opened) .daf file.
A prompt appears to save the text file. This text file can be opened from Excel.

15 If you do not want to generate a report, click OK to save your changes and exit
the window.

16 The saved template can generate a statistics report for multiple data files by
selecting Generate Statistics Report from the Reports menu or during batch proc-
essing.
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Generating a Statistics Report using .daf Files

Once a Statistics Definition has been created, the user can generate a statistics
report from multiple .daf files. However, these files must use the same template.
Batch Processing can also generate a statistics report where statistics for each data
file will be generated either for .rif, .cif, or .daf files. Generating a statistics report
under the Reports menu simply adds the statistics template to the specified .daf
files.

To Generate a Statistics Report

1 Select Reports > Generate Statistics Report.

The current .daf file appears in the window with the specified statistics columns.

2= Generate Statistics Report ‘ Q@E

Select a .daf ortemplate file that contains a statistics report definition.
152011 X107 unstimulated_Tt = P

Report title
052011 X101 unstimulated_1t daf_stats

= Similarity, Similarity.
Files Count Al Count R1 Count R2 Count R3 Count R4 %Gated. R4 Median, B3 MAD, B3

[ AddFles | [ Remove Files | [ cancet | | oK |

Pick a Report Definition. The definition may be obtained from a .daf or .ast file.
Change the Report title if desired.

Additional .daf files can be added or removed with the Add Files or Remove
Files buttons.

Reorder the files as desired by selecting files and then right-click the new loca-
tionin the list and choose move here. You can Ctrl select multiple files in the
desired order and then move all at once by right-clicking in the desired location
and choosing move here.

Click OK.

A prompt will confirm that the .daf file will be saved. The report title name will be
used as the default file name for the report. In the above example, the file gen-
erated will be named “Report 1.txt". If the report title contains illegal characters,
such as “\/><“the default filename will change to “Statistics Report.txt”. Tab
delimited text format is used for the report.
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Reporting Statistics from a Single Graph or Statistics Table

Statistics can also be reported directly from an open .daf from the graph or statistics
tables in the analysis area.

To export graph statistics to the Clipboard

* Right-click a graph and then click Export Statistics To Clipboard. They are
then available for pasting into a third party application.

To copy population statistics from a Statistics Table

+ Right-click the table and then click Copy Statistics or Copy Statistics -
transposed. They are then available for pasting into a third party application.
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Exporting Data

You can export feature values for a population to the Clipboard, a text file, or a Flow
Cytometry Standard (FCS) file. You can export pixel intensity values for an object to
the Clipboard or a text file. Later, you can open or paste the FCS file into a spread-
sheet or other programs that uses the FCS file format. Keep in mind, however, that
limitations might exist on the number of values that these programs can import.

Exporting Feature Data

Exporting feature data is useful if you want to create an fcs file or graph the feature
data in a third party graphing application.

To export feature data

1 Onthe Tools menu, click Export Feature Values.
The Export Feature Data window appears.

5 Export Feature Data

Select .daf files to process Select features to export

Area_t01
Area_t02
Area_bOE
Area_bC
Aszpect Ratio Intensity_01_Chi1
Aszpect Ratio Intensity_MO02_Ch02
Aszpect Ratio Intensity_MOE_Ch0&
Aszpect Ratio_MO1
Aszpect Ratio_M0O2
Aszpect Ratio_MOE
[ addfies | [ FemoveFies | Bgd Mean_Chi1

Bkgd Mean_Choz2
Bkgd Mean_Chis

- Blgd StdDev_Chii

Select a population:

|A" "ZI Sort features by:

1ape change MCP1_2default daf

Expart to Order by
O 5= © Object [ Export all used features
O TestFile O Feature
) FCS Fil [ Export all features
ile

(] 8 ] ’ Cancel

2 Addfiles to the list on the left to export values for multiple files.
3 Inthe Select a population drop down menu, select the population that you want.

If you haven’t defined any populations, All is the default. To make a new pop-
ulation, refer to Creating Tagged Populations.

4 Inthe Select feature values to export area, select features by clicking items in

the list or hold down the Ctrl while clicking to select multiple items.

5 Select the Export to option that you want. Note that data exported to the Clip-

board can be pasted directly into a spreadsheet program.

6 Select the Order by option that you want. Note that ordering by object causes

the values to be listed in a column, whereas ordering by feature causes the
values to be listed in a row.

7 Click OK.
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Exporting Pixel Data

Exporting pixel data is useful when importing the data into third-party programs
where you would need to graph the individual pixels.

To export pixel data

1

a b~ W N

On the Tools menu, click Export Image Pixel Values.
The Export Image Pixel Values window appears.

E Export Image Pixel Yalues E@

Select object to expart: Ewpart to
v .
+ [lipboard
" File
k. Cancel

Select the object to export in the drop down menu.
Select to Export to either the Clipboard or File.
Click OK.

Paste into desired application.

- 153 -



Chapter 3

Creating TIFs From Population for Export

The IDEAS application allows users to create separate TIF files for channel images
for every event in that population. The exported TIF files can be opened in image
viewing applications that support 8 bit tif format for display or 16 bit tif format for anal-
ysis.

To create TIFs From Population for Export

1 Onthe Tools menu, click Export .tif Images.
The Create TIFs From Population window appears.

A Create TIFs From Population Elllg

Select population:

(=Rl 052011 X101 Unstimulated_12temp cif

Select Channels TIF Settings

Chil File name prefic:

Chi2
Chi6
Ch03
Ch1

Bit Depth:
@ 8bit for display)
) 16hit for analysis)

Pixel Data
@ padded ffor display)

) raw ffor analysis)

[—- I[Cancel]'

Select the population and channels.

Type a prefix for the TIF file name.

Select the bit depth.

Select padded or raw.

Click OK.

A TIF file is created for every selected channel within the selected population.

oD OB WN
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Printing Data

The IDEAS application provides color mapping from the dark mode that you see in
the Analysis Area to a light mode that has a white background for the printing and
exporting of data. Because the population colors might not show on a white back-
ground, you can change the colors when using the light mode.See Application
Defaults for more information.

To use light background graphs in the Analysis Area
*  Click the graph background tool to switch between light or dark mode. =,

» SeeViewing and Changing the Application Defaults - colors tab to set the
color mapping desired.

To print the Analysis Area data

» Select Reports > Print Analysis Area.

The IDEAS application prints all the graphs, statistics, text panels, and
images that are displayed in the Analysis Area.

To print the Image Gallery data

» Select Reports > Print Image Gallery.
The IDEAS application prints all the images that are visible in the Image Gal-
lery.
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To print an individual graph

1 Right-click the graph and then select Print Graph on the graph context menu.
The Print Graph window appears.

= Print Graph =1

Select options for printing
Graph [ Legend
[ Statistics ] Curser I

[ Show Sample Name in Title

Size scaling factor (%) I

50

2 Select the checkboxes Graph, Statistics, Legend, Cursor, Show Sample
Name in Title to include the elements in the report.

3 If necessary, adjust the size scaling factor. Recomended setting is 100%.

4 Click OKto print the graph.
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Chapter 4: Features and Masks

_Flu ‘cmm&s Asalyis  Compensation Teals  Option:  Reports  Windows  Help
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Understanding the IDEAS® Features and Masks

This section contains the following subsections, which describe the
features that the IDEAS application uses for data analysis:

See the following lists of base features:

Table of Base Features - Alphabetical

Table of Base Features- by Category

Table of Basic Features available for FlowSight without QI

Understanding the Size Features

Understanding the Location Features

Understanding the Shape Features

Understanding the Texture Features

Understanding the Signal Strength Features

Understanding the System Features

Understanding the Comparison Features

About Masks

Mask Functions

- 158 -



Understanding the IDEAS® Features and Masks

Overview of the IDEAS Features and Masks

Objects passing through an Amnis cell analysis system are illuminated in different
directions by lasers and/or brightfield LEDs. Light emitted from the object is focused
through an objective lens and relayed to a spectral decomposition element, which
divides the light into six spectral bands located side-by-side across a charge-cou-
pled detector (CCD), as shown in the following diagram. Therefore, each object has
six images that can be individually analyzed or, because they are in spatial register
with respect to one another, reconstructed. Each of the separate bands is called a
channel. Below is an example of collecting 6 images. The ImageStreamx system
has a second camera option which enables collection of up to 12 images per object.
The FlowSight system has 12 channels collection on 1 camera.

detector

Spectral
decomposition
element

cells in flow - ‘
. autofocus velocity
‘\ detector

%

y

brightfield
illuminater

About Features

The IDEAS application provides a large selection of criteria, or features, for analyz-
ing images. A feature is described by a mathematical expression that contains quan-
titative and positional information about the image. A feature is applied to specific
locations of an image by the use of a mask that identifies pixels within the region of
interest of the image. A few system features, such as Object Number, Camera Back-
ground and Flow Speed, do not require calculations, masks, orimage intensity infor-
mation.

There is a slight difference in features created during data acquisition and those in
IDEAS. During acquisition features are created with the INSPIRE mask. Features
and masks are calculated in IDEAS for files collected with the ImageStream or a
FlowSight with the Quantitative Imaging (Ql) upgrade.

New masks and features can be created in files from an ImageStream or FlowSight
with the QI upgrade using the Mask and Feature Manager tools. Features are
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created in IDEAS using base feature algorithms,such as Area or Intensity along with
a mask and/or a channel image for files created with an ImageStream or with the

QI upgraded FlowSight machine. The default masks are recomputed in IDEAS for
ImageStream or Ql enabled files. Combined features can be created using existing
features in mathematical expressions in the Feature Manager.

IDEAS groups the features into eight categories: size, location, shape, texture, sig-
nal strength, comparison, system and combined.

For more information, see Overview of the Mask Manager

To calculate the value of a feature, the IDEAS application maps the channel image
to X and Y coordinates, as illustrated by the following diagram. Each box in the dia-
gram represents a pixel.

v

0,8

The pixel size and field of view per channel is dependent on the magnification used.
See your INSPIRE Users Manual for more information.
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Features Categories

Size
Size features are in microns and include Area, Diameter, Length, Major Axis, Minor

Axis, Major Axis Intensity, Mnor Axis Intensity, Perimeter, Thickness Max and Min,
Spot Area Min, Width and Height.

Location

Location features include Angle, Angle Intensity, Centroid X, Centroid Y, Centroid X
Intensity, Centroid Y Intensity, Delta Centroid X, Delta Centroid Y, Delta Centroid
XY, Max Contour position, Spot Distance Min, Valley X and Valley Y.

Shape

Shape features define the mask shape and have units that vary with the feature.
They include the Aspect Ratio, Aspect Ratio Intensity, Compactness, Elon-
gatedness, Lobe Count, and Symmetry 2,3,4.

Texture

The Texture features determine local intensity variations in images and include
Bright Detail Intensity R3 and Bright Detail Intensity R7, Contrast, Gradient Max,
Gradient RMS, H Texture (H-Contrast, H-Correlation, H-Energy, H-Entropy, H-
Homogeneity, and H-Variance), Modulation, Spot Count, and Std Dev.

Contrast, Gradient Max and Gradient RMS are generally used to determine best
focus.

Comparison

The Comparison features describe the difference of intensity measurements
between masks or pixels in different images or the same image with different
masks. These include Bright Detail Similarity R3, Intensity Concentration Ratio,
Internalization, and Similarity.

System
The system features do not require a mask.
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Table of Base Features - Alphabetical

Delete this text and replace it with your own content.

Feature Name Category
Angle Feature Location
Angle Feature Location
Area Feature Size
Aspect Ratio Feature Shape
Aspect Ratio Intensity Feature Shape
Signal
Bkgd Mean Feature Strength
Signal
Bkgd StdDev Feature Stgr]ength
Bright Detail Intensity R3 and Bright detail Intensity R7 Features S5z
Strength
Bright Detail Similarity R3 Feature Comparison
Camera Line Number Feature System
Camera Timer Feature System
Centroid Features Location
Centroid Features Location
Circularity Feature Shape
Shape
Contrast Feature Texture
Centroid Features Location
Centroid Features Location
Diameter Feature Size
Elongatedness Feature Shape
Elongatedness Feature Texture
Flow Speed Feature System
Gradient Max Feature Texture
Gradient RMS Feature Texture
Height Feature Size
H Texture Features Texture
Intensity Concentration Ratio Feature Comparison
. Signal
Intensity Feature St?ength
Internalization Feature Comparison
Length Feature Size
Lobe Count Feature Shape
Major Axis and Minor Axis Features Size
Major Axis Intensity and Minor Axis Intensity Features Size
Max Contour Position Feature Location
. Signal
Max Pixel Feature Strength
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Feature Name Category
. Signal
Mean Pixel Feature Strength
. . Signal
Median Pixel Feature Strength
- Signal
Min Pixel Feature Strength
Minor Axis: see Major Axis Intensity and Minor Axis Intensity Fea- Size
tures
Modulation Feature Texture
Object Number Feature System
Objects/ml Feature System
Objects/sec Feature System
Perimeter Feature Size
Spot Intensity Min and Spot Intensity Max Features Location
: Signal
Raw Intensity Feature Strength
. Signal
Raw Max Pixel Feature Strength
. Signal
Raw Mean Pixel Feature Strength
- Signal
Raw Min Pixel Feature Strength
. . Signal
Raw Median Pixel Feature Strength
. Signal
Saturation Count Feature Strength
Saturation Percent Features STz
Strength
Shape Ratio Feature Shape
Similarity Feature Comparison
Similarity Feature Comparison
Spot Area Min Feature Size
Spot Count Feature Texture
Spot Distance Min Feature Location
: . . Signal
Spot Intensity Min and Spot Intensity Max Features Strength
Std Dev Feature Texture
Symmetry 2, 3, 4 Features Texture
Thickness Max Feature Size
Table of Base Features- by Category Size
Time Feature System
Valley X and Valley Y Features Location
Width Feature Size
XCorr Feature Comparison
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Table of Base Features- by Category

Table 1: List of Features by category

The central tendency of the pixels along the X Axis and

n Mask_Image
Usedin
Template?
plate
Size Size-based Features are in microns.
Area Feature Yes Yes MO01-M12,
The size of the mask in square microns. MC
Diameter Feature
Estimates the diameter of the mask based on Area. No Yes MO1-M12
Height Feature
Based on a bounding rectangle, the Width is the smaller [Yes Yes [MO1-M12
side and the Height is the longer side of the rectangle.
Length Feature
Measures the longest part of the mask. Yes Yes MOT-M12
Major Axis and Minor Axis Features
Describes the widest part of the mask and the narrowest |No Yes MO1-M12
part of the mask, respectively.
Maijor Axis Intensity and Minor Axis Intensity Features MO1 ChO1-
Based on a bounding ellipse, the Minor Axis is the nar- [No Yes M12_Ch12
row part and the Major Axis is the widest part. -
Minor Axis:Major Axis and Minor Axis Features No Yes MO1-M12
Perimeter Feature
Describes circumference of the mask. No Yes MO1-M12
Spot Area Min Feature
The Area of the smallest spot in the mask. (See also No No
Spot Distance Min Feature, Spot Intensity Min and Spot
Intensity Max Features and Spot Count Feature.
Thickness Max Feature
Describes the longest width of the mask. No Yes MOT-M12
Thickness Min Feature
Describes the shortest width of the mask. No i U
Width Feature
Based on a bounding rectangle, the Width is the smaller [Yes Yes MO01-M12
side and the Height is the longer side of the rectangle.
. Location Features are in X,Y pixel coordinates from
Location C . .
an origin in the upper left corner, pixels or contour
Angle Feature
The angle of the major axis from a horizontal plane in radiiNo No
ans.
Angle Feature
The angle of the major axis intensity from a horizontal  [No No
plane in radians.
Centroid Features No Yes MO1-M12
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n Mask_Image
Feature Usedin
category Feature name ITne?"T’f'thj:? E):f)aa:'fed Default Tem-
Template?
plate

Y Axis, respectively.

Centroid Features _ _ MO1_ChO1-

The central tendency of the pixels along the X Axis and |No Yes M12 Chi2

Y Axis, respectively, with the pixel intensities weighted. —

Centroid Features

The distance between the X or Y Centroids of two No No

images.

Centroid Features No No

The distance between the Centroids of two images.

Max Contour Position Feature

The location of the contour in the cell that has the high- [No No

est intensity concentration.

Spot Distance Min Feature

The shortest distance between two components (spots). Ves No

See also Spot Area Min Feature, Spot Intensity Min and

Spot Intensity Max Features and Spot Count Feature.

Valley X and Valley Y Features

The (X,Y) coordinates of the minimum intensity within No No

the skeletal lines that are used when creating the Valley

Mask.
Shape Shape Features define the mask shape and have

units that vary with the feature.

Aspect Ratio Feature

Ths ratio of the Minor Axis divided by the Major Axis. | &5 [Yes  [MOT-M12

Aspect Ratio Intensity Feature M01 ChO1-

The ratio of the Minor Axis Intensity divided by the Major [Yes Yes -

. . M12_Ch12

Axis Intensity.

Circularity Feature No No

The degree of the mask’s deviation from a circle.

. . . o - . No No

Describes the density of intensities within the object.

Elongatedness Feature

The ratio of the Height/Width which use the bounding  |No Yes MO01-M12

box.

Lobe Count Feature No No

The number of lobes in a cell. (Also see Symmetry)

Shape Ratio Feature

TheFr)atio of Thickness Min/Length features. No Yes MO1-M12

Symmetry 2, 3, 4 Features

These three features measure the tendency of the object

to have a single axis of elongation, a three-fold and a No No

four-fold variation of the shapes. See also Lobe Count

Feature.

Texture features measure pixel or regional variation
Texture s . .

and indicate the granularity or complexity of the
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n Mask_Image
Feature InDefault |Expanded [Used in
Category Feature name Template? |Default Default Tem-
Template?
plate
image.
Bright Detail Intensity R3 and Bright detail Intensity R7
Features Yes MC Chi-
The Intensity of the pixels in the bright detail image using|(R3) Yes M C_Ch6
a 3 or 7 pixel structuring element. Also, see Spot Mask |No (R7) -
for a description of the bright detail image.
Contrast Feature
Enumerates changes of pixel values in the image to Yes Yes MO1_Cha1-
. . M12_Ch12
measure the focus quality of animage.
Gradlent.Max Feature _ _ MO1_ChO1-
The maximum slope of the pixel value changes in the No Yes
' . . M12_Ch12
image to measure focus quality of an image.
Gradient RMS Feature . . ' MO1_Cho1-
Enumerates changes of pixel values in the image to Yes Yes
. . M12_Ch12
measure the focus quality of animage.
H Texture Features Mo1_Cho1_
Measures Haralick texture features e U el
| Ch12_5
Modulation Feature
Measures the intensity range of animage, normalized |Yes Yes MO1_Cha1-
M12_Ch12
between 0 and 1.
Spot Count Feature
Enumerates the number of spots.
See also Spot Distance Min Feature, Spot Area Min Fea-|No No
ture, and Spot Intensity Min and Spot Intensity Max Fea-
tures.
Std Dev Feature No Yes MO01_ChO01-
Describes the overall distribution of pixel intensities. M12_Ch12
Signal Signal Strength Features are measured in pixel
Strength  |values.
Bkgd Mean Feature
The average intensity of the camera background. Yes Yes [ChO1-Chi2
Bkgd StdDev Feature
The standard deviation of the background intensities. No I e
Intensity Feature MC ChoO1-
The sum of the pixel intensities in the mask, background |Y es Yes -
MC_Ch12
subtracted.
Max Pixel Feature MC ChO1-
The largest pixel value within the mask, background sub-{Yes [Yes -
MC_Ch12
tracted.
Mean Pixel Fefature o MO1_Cho1-
The average pixel value within the mask, background  |Yes Yes
M12_Ch12
subtracted.
Median Pixel Feature % % MO01_Ch01-
The median pixel value within the mask, background sub: es ©s M12_Ch12
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Feature
category

Feature name

In Default
Template?

In
Expanded
Default
Template?

Mask_Image
Usedin
Default Tem-
plate

tracted.

Min Pixel Feature

The smallest pixel value within the mask, background
subtracted.

No

Raw Intensity Feature

The sum of the pixel intensities within the mask.

Raw Max Pixel Feature

The largest pixel intensity.

Yes

Y es

MC_Ch01-
MC_Ch12

Raw Mean Pixel Feature

The average pixel intensity: Raw does not have back-
ground subtracted.

INo

No

Raw Median Pixel Feature

The median pixel intensity.

Raw Min Pixel Feature

The lowest pixel value within the mask.

Yes

Yes

MC_ChO01-
MC_Ch12

Saturation Count Feature

The number of pixels in the mask that are saturated.

Yes

Yes

MO01_Ch01-
M12_Ch12

Saturation Percent Features

The Percentage of pixels in the mask that are saturated.

Yes

Yes

Spot Intensity Min and Spot Intensity Max Features

The raw intensity (not background subtracted) of the dim-
mest component (spot).

See also Spot Count Feature, Spot Distance Min Fea-
ture, and Spot Area Min Feature.

Com-
parison

Difference of intensity measurements between
masks or pixels.

Bright Detail Similarity R3 Feature

Measures the correlation of the bright details between
image pairs.

No

No

Intensity Concentration Ratio Feature

Given two masks, the ratio of the intensity in one mask
to the total intensity in both masks.

No

No

Internalization Feature

The ratio of the intensity inside the cell to the intensity of
the entire cell.

No

No

Similarity Feature

The Similarity is a measure of the degree to which two
images are linearly correlated pixel by pixel within a
masked region.

No

XCorr Feature
The XCorr is a measure of the degree to which two
images frequencies are cross correlated.

No

No

System

System features do not require a mask and tend to
deal with system wide metrics.

Camera Line Number Feature

No

Yes
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n Mask_Image
Feature InDefault [Expanded [Used in
Category Feature name Template? |Default Default Tem-
Template?
plate
An incremental count of objects.
Camera Timer Feature
- .. R No Yes
The clock rate in KHz. This is relative time.
Flow Speed Feature Yes Yes
The calculated flow speed in mm/sec.
Object Number Feature
. Yes Yes
The sequence of objects.
Objects/ml Feature
A local concentration of all objects per ml. No Yes
Note: to get objects per ml of a population, use the sta-
tistic ‘Concentration’.
Objects/sec Feature
A local concentration of number of objects per second.
) . . No Yes
Note: to get objects per ml of a population, use the sta-
tistic ‘Concentration’
Time Feature Yes Yes
The camera timer feature, converted to seconds.
Combined |Any combined feature will be listed under Combined |No No
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Table of Basic Features available for FlowSight without QI
The default masks used for FlowSight Basic (non-Ql) files is the INSPIRE mask.

FlowSight Basic Features

Feature Mask_Channel Brief definition
Area MO1-GM, MC  [The size of the mask in square microns.
. The ratio of the Minor Axis divided by
Aspect Ratio MOI-M12 e Ml Av e
Bked Mean ChO1-Ch12 The average intensity of the camera
background.
Bked StdDev ChO1-Ch12 The star.ldard F1§V1at1on of the back-
ground intensities.
Camera Line none An incremental count of objects.
Number
e s MO1_Chol- Elnqmerateis changes (g‘l plé(el Valuesl.ln
radien MI12 Chl2 ¢ image to measure the focus qua ity
- of an image.
Intensi MC _ChO1 - MC_|[The sum of the pixel intensities in the
o Chl2 mask, background subtracted.
Minor Axis MO1-M12 Describes the narrowest part of the
mask.
Object Number none The sequence of objects.
Raw Centroid X The central tendency of the pixels
none along the X Axis and Y axis respec-
Raw Centroid Y tively
Raw Max Pixel MC_Cho1-MC_ The largest pixel value.
Ch12
Raw Min Pixel MC_Chot - MC_ The lowest pixel value.
Chl12
Uncompensated MC Cho1-MC_ The sum of the pixel intensities in the
) mask, background subtracted, no com-
Intensity Chl2 . .
pensation applied.
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Understanding the Size Features

Size features are in microns and include Area, Diameter, Length, Major Axis, Minor
Asix, Major Axis Intensity, Minor Axis Intensity, Perimeter, Thickness Max and Min,
Spot Area Min, Width and Height.
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Area Feature

The number of microns squared in a mask is equal to the Area. In the following fig-
ure, al symbolizeawhetherthe area is included jn the mask. The number of pixels
is converted to um“. Note that 1 pixel = 0.25 pm“. As an e)?mple, acell witha
mask that includes 2000 pixels is therefore equal to 500 um*~.

Brightfield

|-l'|_.|-l|-l| B

E

= -
[ Eol O S )

Lol F R

1 [1
PR

Channel 5 PI1 DNA

Application Examples:

— Quantify and compare cell size.

— ldentify single cells.

— Calculate the radius, diameter and volume of the cell.

— ldentify apoptosis using the Area of the 30% threshold mask of a nuclear
dye.

— Create a pseudo FSC va. SSC plot for comparing with flow cytometry.
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Diameter Feature

(5]
L

Nomalzed Frequensy

o
|

The Diameter feature provides the diameter of the circle that has the same area as
the object. The accuracy of the diameter is highly dependent on a close fitting mask
and roundness of the cell.

Area
T

Digmeter= 2 %

The images below depicts beads with a uniform diameter of 9 microns.

In the next figure, note that images with longer shapes that have the same area will
have the same diameter value.

Focus

Brightfield Brightfield Brightfield

0 s

Dlameki_Brgllied

Brightfield Brightfield Brightfield

1
B e

Application Example:

— Used to obtain approximate size of the cell.
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Understanding the Size Features

Height Feature

Using the bounding rectangle, Height is the number of microns of the longer side and
Width the shorter side. See also Elongatedness Feature.

Application Example:

— These features can be used to separate rectangular shaped objects. For
curved objects, measurement is more accurately obtained using the thick-
ness features.
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Length Feature

Length measures the longest part of an object. Unlike the Major Axis feature, Length
can measure the object's length even if it folds to form a cashew, banana, or dough-
nut shape, where in many of these cases the major or minor axis features would not
be able to differentiate these with true circular shaped objects with no hole.

This feature is based on an input mask and is sensitive to the variation of the input
mask shape. Selecting an input mask that can accurately capture the object shape
is important. See the Shape Ratio Feature, Table of Base Features- by Category
and Thickness Max Feature for more information.

Thickness max

Le n gth e .,

Shape ratio = Thickness min / Length
Thickness min
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Major Axis and Minor Axis Features

The Major Axis is the longest dimension of an ellipse of best fit. The Minor Axis is
the narrowest dimension of the ellipse of best fit. See the Aspect Ratio Feature for
more information.

inor Axis

ajor Axis

Application Examples:

— Quantify and compare cell shape.
— ldentify small, medium, and large cells.
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Major Axis Intensity and Minor Axis Intensity Features

The Major Axis Intensity is the longest dimension of an ellipse of best fit and is inten-
sity weighted. The Minor Axis Intensity is the narrowest dimension of the ellipse of
best fit and is intensity weighted.

The figure below illustrates the difference between intensity weighted and non-inten-
sity weighted Major or Minor Axis and Aspect Ratio. See the Aspect Ratio Intensity
Feature for more information.

Azpect Ratio_k4

I I ]
0 3 B g 1.2

'Aspect Ratio Intensily._Mfl

Application Examples:

— Quantify and compare the image fluorescence shape.
— ldentify single cells.
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Understanding the Size Features

Perimeter Feature

The perimeter feature measures the boundary length of the mask in the number of
microns.

This example uses a 1-pixel wide mask created to illustrate how a perimeter would
appear.

Brightfield

Channel 5 PI DNA

Application Examples:

— Quantify and compare cell circumference.
— Identify cells with highly irregular surfaces from smooth cells.

— Perimeter of the morphology or threshold masks can identify cells with or
without dendrites.
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Spot Area Min Feature

The Spot Area Min feature provides the area of the smallest spot (connected com-
ponent) in a spot or peak mask.

This is one of four features that can be used to identify objects with spots that are
close together, dim, bright or small when counting spots in animage. To use these
features, the spots need to be individually masked, such as using the Spot or Peak
Mask. The Spot Area Min, Spot Distance Min, and Spot Intensity Min or Max fea-
tures measure properties of different spots in an image and are often used with the
Spot Count feature (under Texture). For more information see Spot Distance Min
FeatureSpot Count FeatureSpot Intensity Min and Spot Intensity Max Features.

* Spot Area Min is the Area of spot 1

» Spot Distance Min is distance 2 in microns

* Spot Intensity Max is the Raw Mean Pixel of spot 2

* Spot Intensity Min is the Raw Mean Pixel value of spot 3

Application Example:

— InFISH Spot Counting, these features are used to identify objects with
ambiguous spots that are located too close together, are too dim to count
or are too small in order to remove these objects from the analysis.
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Thickness Max Feature

Thickness Max measures the largest width of an object. This feature is based on an
input mask and therefore sensitive to the variation of the input mask shape. Select-
ing an input mask that can accurately capture the object shape is important. See
also Table of Base Features- by Category , Length Feature and Shape Ratio Feature
for more information.

Thickness max

Le n gth -“_‘___ ................ e

Shape ratio = Thickness min / Length
Thickness min
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Thickness Min Feature

Thickness Min measures the smallest width of an object. This feature is based on an
input mask and therefore sensitive to the variation of the input mask shape. Select-
ing an input mask that can accurately capture the object shape is important. See
also Thickness Max Feature, Length Feature and Shape Ratio Feature for more infor-
mation.

Thickness max

Length -“_‘___ ................ e,

Shape ratio = Thickness min / Length
Thickness min
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Width Feature

Using the bounding rectangle, Width is the number of microns of the smaller side
and Height the longer side. See also Elongatedness Feature.

Application Example:

— These features can be used to separate rectangular shaped objects. For
curved objects, measurement is more accurately obtained using the thick-
ness features.
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Understanding the Location Features

Location features include Angle, Angle Intensity, Centroid X, Centroid Y, Centroid X
Intensity, Centroid Y Intensity, Delta Centroid X, Delta Centroid Y, Delta Centroid
XY, Max Contour position, Spot Distance Min, Valley X and Valley Y.

- 182 -



Understanding the Location Features

Angle Feature

Angle is the angle of the major axis from a horizontal plane in radians.
Application Example:

— lIdentify the orientation of an image relative to the image frame.

Angle Intensity Feature

Angle Intensity is the angle of the major axis intensity from a horizontal plane in radi-
ans.

Brightfield 7AAD Composite

Major Axis

Angle 7AAD = 1.2 Angle 7AAD = 0.83

Angle Intensity 7AAD = 1.2 Angle Intensity 7AAD = 0.81

Application Example:

— ldentify the orientation of an image relative to the image frame.
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Centroid Features

Centroid X and Centroid Y Features

Centroid X is the number of pixels in the horizontal axis from the upper, left corner of
the image to the center of the mask. Centroid Y is the number of pixels in the vertical
axis from the upper, left corner of the image to the center of the mask.

In this example, the Centroid X=54 and the Centroid Y=32.

Brightfield RTX AF488

Application Examples:

— ldentify the center of the mask.

— Calculate the Delta Centroid or the distance between two fluorescent
markers.

— Used by IDEAS to calculate the Delta Centroid X, Y, or XY.

Centroid X Intensity and Centroid Y Intensity Features

Centroid X Intensity is the intensity weighted X centroid and is shifted from the
center of the mask toward the center of fluorescence. The Centroid Y Intensity is the
intensity weighted Y centroid. X and Y pixel coordinates are calculated from an origin
in the upper left corner.
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Centroid X,Y Intensity

‘ - Centroid XX Intensit

* Centroid X,Y Tl

\ CentrmX,Y

PE

Feature
Centroid X

Centroid X Intensity

X Intensity Shift
Centroid Y

Centroid Y Intensity
Y Intensity Shift

Application Examples:

— ldentify the center of peak fluorescence.
— Calculate the distance between two fluorescent markers.

— Used by IDEAS to calculate the intensity weighted Delta Centroid X, Y or
XY.

Delta Centroid X and Delta Centroid Y Features

Both the Delta Centroid X and Y features measure the distance between the Cen-
troids X or Centroids Y, respectively, of two images using the user-provided masks
for each image. Either one or both the centroids of the images may be intensity-
weighted. X and Y pixel coordinates are calculated from an origin in the upper left
corner to obtain the centroid positions and the distance between the centroids is con-
verted to microns.
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An example is shown below.

PE Podo Composite

Composite

2

Centroid Y

Delta Centroid Y

&L
e
&
&
&

Delta Centroid X

Centroid X

Delta Centroid XY=v(Delta Centroid X)?+(Delta Centroid Y)?

The graph below illustrates using the Delta Centroid X versus Delta Centroid Y to
identify cells with a variation of location of a protein with respect to the nucleus.

Cells with no spatial shift of signal between the nuclear stain(Ch6) and protein of
interest(Ch4) have a low Delta Centroid X and Y and are found in the lower left
corner. Cells with a large shift between the images in both the X and Y direction are
found in the upper, right section and those with a large shift in X but not Y are found
in the lower, right. Similarly a cell with a large shift in the Y direction and not X are
found in the upper, left. See Delta Centroid XY Feature to measure the X and Y shift
together.
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Single. Focused cells
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Application Example:

— Used to identify capped versus not capped cells.
— Used to measure shifts in X or Y direction between two images.

Delta Centroid XY Feature

The Delta Centroid XY feature measures the distance between the Centroid feature
of two images using the user-provided masks for each image. Either one or both the
centroids of the images may be intensity-weighted. X and Y pixel coordinates are cal-
culated from an origin in the upper left corner to obtain the centroid positions and the
distance between the centroids is converted to microns. In the example, below an
image pair is shown stained with the nuclear dye Draq 5 and a PE labeled antibody
that is differentially expressed two cells, either uniformly or in the pseudopod. The
two cells are identified by their different Delta Centroid XY values.
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Composite

%

Composite

5

Centroid Y

S
&
&
Y
&

Delta Centroid Y

Delta Centroid X

Centroid X

Delta Centroid XY=v(Delta Centroid X)?+(Delta Centroid Y)?

Below is an example of using the Delta Centroid XY. A bivariate graph of a shape
ratio versus Delta Centroid XY can identify cells with caps as shown here:

Shape Ratio BF

3 3 12
Delta Centroid XY_PODO / DRAQS

Application Examples:

— Quantify the spatial relationship between two fluorescent probes.
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Understanding the Location Features

— ldentify false apoptotic positive cells in the TUNEL and Annexin V
assays.

— Quantify shape change.

— Quantify capping of cell surface antigens.

Raw Centroid X and Raw Centroid Y Features

The centroid X and Y of the original position of the image during acquisition before it
was centered IDEAS. Data analyzed in IDEAS versions 4.0 or later cut and center
objects that were collected as one image in INSPIRE.
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Max Contour Position Feature

The Max Contour Position is defined as the location of the contour in the cell that has
the highest intensity concentration. It is invariant to object size and can accom-
modate localized intensity concentrations. The actual location in the object is
mapped to a number between 0 and 1, with 0 being the object center and 1 being the
object perimeter, which allows one to compare the results across cells of different
sizes. An example is shown below.

All

Channel 3

_ Womialzed Frequency %

7 | :
onlour Pogllon inkemallack_Cl

Channel 3 Channel 3

¢

Application Example:

— Used in conjunction with the Internalization feature to determine the dis-
tribution of intensity within a cell.
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Shift X and Shift Y Features

The Shift X or Shift Y feature is the location of the highest cross-correlation of a pair
of images. When two identical images are aligned perfectly the cross-correlation is
at it's maximum. The shift X or Shift Y is the shift required to get the highest cross-
correlation value for the 2 images. This feature is used mainly for troubleshooting
cross-camera alignment.
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Spot Distance Min Feature

The Spot Distance Min feature provides the shortest distance in microns between
two spots (connected components) in a spot or peak mask.

This is one of four features that can be used to identify objects with spots that are
close together, dim, bright or small when counting spots in animage. To use these
features, the spots need to be individually masked, such as using the Spot or Peak
Mask. The Spot Area, Distance, and Spopt Intensity Min or Max features measure
properties of different spots in an image and are often used with the Spot Count fea-
ture (under Texture). For more information see Spot Area Min Feature; Spot Count
Feature; Spot Intensity Min and Spot Intensity Max Features.

» Spot Area Min is the Area of spot 1

* Spot Distance Min is distance 2 in microns

» Spot Intensity Max is the Raw Mean Pixel of spot 2

* Spot Intensity Min is the Raw Mean Pixel value of spot 3

Application Example:

— InFISH Spot Counting, these features are used to identify ambiguous
spots that are located too close together, too dim, to bright or too small to
count and can be eliminated from the analysis.
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Valley X and Valley Y Features

The Valley X and Y are the exact X,Y coordinates of the minimum intensity within
the skeletal lines of the input mask. The objects condensed shape, typically 1-pixel
wide skeletal line is determined from the starting mask. This is also the origin of the
Valley mask. See Valley Mask and Skeleton Mask.

In the figure below, the Valley X and Valley Y position of the 7AAD image is shown.
In this example a protein of interest in the PE image localizes to the synapse
between two cells.

£2 - TAAD | 1]® [fia] K
Walue

alley _Skeleton[Mb, FAAD, Thin_ 7 43
alley v _Skeleton[Mb, FAA0, Thin_ ¥ E7

Piwel [43, 67] Intensity: 38

These features define the origin of the Valley mask.
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Application Example:

— Measure the exact center of where a synapse between two cells is
located.
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Understanding the Shape Features

Understanding the Shape Features

Shape features define the mask shape and have units that vary with the feature.
They include the Aspect Ratio, Aspect Ratio Intensity, Compactness, Elon-
gatedness, Lobe Count, and Symmetry 2,3,4.
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Aspect Ratio Feature

Aspect Ratio is the Minor Axis divided by the Major Axis and describes how round or
oblong an object is. See also: Major Axis and Minor Axis Features.

Aspect Ratio
(Minor Axis/Major Axis)

inor Axis

ajor Axis

See also Elongatedness Feature and Shape Ratio Feature for other shape ratios.

Aspect Ratio Elongatedness Shape Ratio
(Minor Axis/Major Axis) (HeightANidth) (Thickness min/Length)

SS Max

] ] ess min
inor Axis

ajor Axis

Application Examples:

— Quantify the roundness of the mask.

— ldentify single cells vs. doublets.

— Cell classification based on shape change.
— Identify recently divided cells in mitosis.
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Aspect Ratio Intensity Feature

Aspect Ratio Intensity is the Minor Axis Intensity divided by the Major Axis Inten-
sity. See also: Major Axis Intensity and Minor Axis Intensity Features.

The figure below illustrates the difference between Aspect Ratio Intensity and
Aspect Ratio. See also: Aspect Ratio Feature.

Agpect Fatio_M4

I I I
0 E = 9 12

..&spect Fia.tio Intensily'_Mei

Application Examples:

— Quantify the roundness of the fluorescent image.

— Better resolution for identifying single cells vs. doublets in experiments
using a DNA dye.

— Cell classification based on fluorescent morphology.
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Circularity Feature

This feature measures the degree of the mask’s deviation from a circle. Its meas-
urement is based on the average distance of the object boundary from its center
divided by the variation of this distance. Thus, the closer the object to a circle, the
smaller the variation and therefore the feature value will be high. Vice versa, the
more the shape deviates from a circle, the higher the variation and therefore the Cir-
cularity value will be low. See also .

Below is an example using Circularity and Compactness to characterize the shape
of peripheral blood mononuclear cells stained with the DNA dye Draq 5.

Cormp actne ss_Drag &

0 5 10 15 20 25 30
Circu larity Drag 5
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Understanding the Shape Features

Brightfield

Application Examples:

— Distinguish singlets and doublets.
— Separate circular and non circular shapes.
— Used in the Shape Change Wizard
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Compactness Feature

Compactness measures the degree of how well the object is packed together. This
feature is similar to the Circularity feature but unlike Circularity, this feature includes
all of the pixels within the mask and is intensity weighted. The higher the value, the
more condensed the object.

Below is an example using Circularity and Compactness to characterize the shape
of peripheral blood mononuclear cells stained with the DNA dye Draqg 5.

Comp actne ss_Drag 5

Brightfield Dragy 5 Circularity

Application Example:

— Differentiate between rounded objects with smooth boundary to less reg-
ular objects.
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Elongatedness Feature

Elongatedness is the ratio of the Height over Width of the object’s bounding box.
See also Width Feature.

See also Aspect Ratio Feature and Shape Ratio Feature for other shape ratios.

Aspect Ratio Elongatedness Shape Ratio
(Minor Axis/Major Axis) (HeightAWVidth) (Thickness min/Length)

SS Mmax

] ] ess min
inor Axis

ajor Axis

Application Examples:

— Measure object shape properties to differentiate between long and narrow
versus short and thick objects.

— Quantify the roundness of the morphology mask.
— ldentify single cells and doublets.

— Cell classification based on shape change.

— Identify recently divided cells in mitosis.
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Lobe Count Feature

The Lobe Count feature counts the number of lobes in a cell. It is determined based
on the maxima of the weighted Symmetry features. The feature reports the values 1,
2,3 or 4. If an object does not have a high value for Symmetry 2, Symmetry 3, or
Symmetry 4 it is reported as 1 for no lobes. An example is shown below. See also
Symmetry 2, 3, 4 Features.

Symmetry
Lobe Count 2 3 4
1 Lo Lo Lo
2 High Law Low
3 Loy High Low
4 Low Law High
Single, Focused Cell e EEE x|

| —
e O \

Application Example:

— Usedin cell classification studies. Also used to differentiate small round
cells from small square cells of similar area.
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Shape Ratio Feature
The Shape Ratio is Thickness Min divided by Length.
The Shape Ratio feature is based on an input mask and is sensitive to the variation

of the input mask shape. Selecting an input mask that can accurately capture the
object shape is important.

Thickness max

Length -“_‘___ ................ .,

_ _ Shape ratio = Thickness min / Length
Thickness min

See also Aspect Ratio Feature and Elongatedness Feature for other shape ratios.

Aspect Ratio Elongatedness Shape Ratio
(Minor Axis/Major Axis) (HeightAVidth) (Thickness min/Length)

SS Max

] ) ess min
inor Axis

ajor Axis

Application Example:

— Measure object's elongatedness to provide shape classification.
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Symmetry 2, 3, 4 Features

Single, Focused Cells
9

F:eauenc%j

w

The Symmetry 2 feature measures the tendency of the object to have a single axis
of elongation and therefore 2 lobes. The Symmetry 3 feature measures the tendency
of the object to have a three-fold axis of symmetry and likewise, Symmetry 4 a four-
fold axis. The absolute value of these features are dependent on the number of
lobes. For example an image that has high 4 lobe symmetry will also have high 2
lobe symmetry. See the Lobe Count Feature for more information.

4 lobe symmetry

e X | Single, Focused Cells e | Single, Focused Cells
18

20
Symmetry 4_Che

Application Example:

— Classify different white blood cells based on the morphology of the nuclear
image.
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Understanding the Texture Features

Understanding the Texture Features

The Texture features determine local intensity variations in images and include
Bright Detail Intensity R3 and Bright Detail Intensity R7, Contrast, Gradient Max,
Gradient RMS, H Texture (H-Contrast, H-Correlation, H-Energy, H-Entropy, H-
Homogeneity, and H-Variance), Modulation, Spot Count, and Std Dev.

Contrast, Gradient Max and Gradient RMS are generally used to determine best
focus.
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Bright Detail Intensity R3 and Bright detail Intensity R/ Fea-
tures

The Bright Detail Intensity R3 and Bright Detail Intensity R7 features compute the
intensity of localized bright spots within the masked area in the image. Bright Detail
Intensity R3 computes the intensity of bright spots that are 3 pixels in radius or less,
while Bright Detail Intensity R7 computes the intensity of bright spots in the image
that are 7 pixels in radius or less. In each case, the local background around the
spots is removed before the intensity computation.

The figure below shows the process of obtaining the localized bright spots in the
image.

Original Image Detail Eroded Image Bright Detail Image

The graph below illustrates the use of the Bright Detail Intensity R3 feature on a
nuclear image to separate apoptotic cells from non-apoptotic cells.

zingle cells gl% .g.l Zlﬂlﬂ! w

Frequency
T
=
T

0 | 1 1 1 1 1 | |
0 3e3 2ed 1 5ed

Eed =3 1
Bright Dretail Intenzity B 2_Threzshold(t45, ChE, 20%)_CHE
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Application Example:

— ldentify cells that have bright specks such as Apoptotic cells.

— Usedinthe Cell Cycle - Mitosis Wizard.
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Contrast Feature

The Contrast feature measures the sharpness quality of an image by detecting large
changes of pixel values in the image and is useful for the selection of focused
objects or apoptotic brightfield images. For every pixel, the slopes of the pixel inten-
sities are computed using the 3x3 block around the pixel. This is similar to the Gra-
dient RMS calculation with different weighted assignments to the pixel arrays with
no background subtraction. Example images are shown in the figure below.

E0

Contrazt_BF
|

30

Gradient RMS_BF

Application Examples:

— Find apoptotic images with high contrast in brightfield imagery.
— Determine overall focus quality of images.

— Use with Gradient RMS to determine focus quality.

— Characterize texture.

See also: Gradient Max Feature and Gradient RMS Feature.
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Ensquared Energy Feature

The Ensquared Energy feature is a measure of image quality. Computes the inten-
sity of the square block around the brightest pixel using the diameter input as the
side for the square divided by the intensity of the total intensity. The closer this ratio
is to 1.0 the better focused the image. This feature is mainly used for single, uniform
particles such as beads.

The figure below shows the image quality test using the Ensquared Energy feature.
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Gradient Max Feature

The Gradient Max feature measures the sharpness quality of an image by detecting

largest change of pixel values in the image and is useful for the selection of focused
objects.

This figure shows the change in intensity across the red line. The top image has a
larger slope change than the lower image.

Application Example:

— Determine peak focus quality of images.

— Also used to characterize texture. However, the Gradient RMS and Con-
trast feature are more robust for these applications.

See also: Gradient RMS Feature and Contrast Feature.
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Gradient RMS Feature

The Gradient RMS feature measures the sharpness quality of animage by detecting
large changes of pixel values in the image and is useful for the selection of focused
objects. The Gradient RMS feature is computed using the average gradient of a pixel
normalized for variations in intensity levels. This is similar to the Contrast cal-
culation with different weighted assignments to the pixel arrays and with background
subtracted. Example images are shown in the figure below.

zingle cells
90—

E0

Contrazt_BF
|

30

Gradient RMS_BF

Application Examples:

— Determine overall focus quality of images.
— Used with Contrast to determine focus quality.
— Characterize texture.

See also: Gradient Max Feature and Contrast Feature.
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H Texture Features

H Texture features include the following: H Energy Mean and Std, H Entropy Mean
and Std, H Contrast Mean and Std, H Homogeneity Mean and Std, H Correlation
Mean and Std, H Variance Mean and Std Features.

R.M. Haralick (H) defined a set of texture features that characterize the spatial rela-
tionships amongst the pixel values in animage " . IDEAS uses a common nor-
malization method so that images with different intensities can be directly
compared. For each H texture feature, the mean reflects the average value and the
standard deviation (Std) reflects the presence of texture orientation.

The user defines the texture grain by assigning a granularity value. For very fine tex-
tures, this value is small (1-3 pixels), while for very coarse textures, it is large (>10).
Inthe IDEAS default template, the granularity value is 5.

While these features have value for distinguishing cellular texture when used individ-
ually, images often contain a mixture of different textures at different grains. There-
fore, these features are most powerful when combined.

Application Example:

— Quantify texture in cells.

1Hara|ick, R.M., K. Shanmugan, and |. Dinstein, "Textural Features for Image Clas-
sification", IEEE Transactions on Systems, Man, and Cybernetics, Vol. SMC-3,
1973, pp. 610-621.
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Modulation Feature

The Modulation feature measures the intensity range of an image, normalized
between O and 1.

The formula is: Modulation = Max Pixel - Min Pixel / Max Pixel + Min Pixel

The following example illustrates Modulation on brightfield images and Intensity of
scatterin channel 1.

Single, focused cells

SV [Tl Y x

Intensity_SSC

] ]
a 3
Modulation_BF

High Modulation

=

Low Modulation

Low Modulation

Application Example:

Quantify image quality and characterize contrast and texture in cells.
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Spot Count Feature

The Spot Count feature provides the number of connected components in an image.
The connected component algorithm examines the connectivity of each pixel based
on whether this pixel is connected to a particular spot or the background. In order to
count the number of connected components the mask input is very important. See
Spot Mask, Peak Mask, and Range Mask for information on masking spots. See
also Spot Area Min Feature, Spot Distance Min Feature, andSpot Intensity Min and
Spot Intensity Max Features for more information.

The following figure illustrates the application of Spot Counting to quantify parasitic
infection of Babesia in erythrocytes by staining nuclei with YOYO (green).

Brightfield Babesia YOYO1

Single
Parasite

Two
Parasites

Three
Parasites

Application Examples:

— Counting parasites.

— Counting phagocytosed particles.
— FISH spot counting.

— Counting punctate spots in images.
— Used in the Spot Wizard.
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Std Dev Feature

The Std Dev feature describes the overall distribution of pixel intensities.

The Std Dev is the standard deviation of the pixel intensity values in the mask. The
Std Dev value provides an indication of the texture or complexity of an object.

The following illustrates that apoptotic cells (AnxnV positive) exhibit higher Std Dev
values in the darkfield channel (scatter) and higher brightfield Modulation values than
non-apoptotic cells (AnxnV negative).

Brightfield Scatter AnxnV_7AAD

Live Cells with low Scatter Std Dev and BF_Modulation

Application Example:

— Quantify intensity variation within a mask.
— Distinguish apoptotic and necrotic cells.
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Understanding the Signal Strength Features

Signal Strength features include the following:

Bkgd Mean and Bkgd StdDev features describe the background of the image.

Intensity and Raw Intensity features quantify the intensities in the region of
interest.

Raw Max, Raw Min, Raw Mean and Raw Median Pixel report single pixel
values in an image.

Max, Min, Mean and Median Pixel report background subtracted single pixel
values in an image.

Saturation Count and Saturation Percent quantify the saturated pixels.
Spot Intensity Min is used when counting spots.

Note that when the name includes ‘Raw’, this means that there is no background
subtraction.
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Understanding the Signal Strength Features

Bkgd Mean Feature

The Bkgd Mean feature estimates the average camera background level in an image
by taking the mean of the background pixels.

Application Examples:

— Obtain estimate of the mean camera background level.

— Compute background-subtracted pixel values in other feature com-
putations.
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Bkgd StdDev Feature

The Bkgd Std Dev feature estimates the standard deviation of the camera back-
ground level in an image computed using the background pixels.

Application Example:

— Obtain estimate of the camera background noise.
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Understanding the Signal Strength Features

Intensity Feature

The Intensity feature is the sum of the background subtracted pixel values within the
masked area of the image.

o)

O

) £

Single Cells

Bright field Scatter CD45 FITC CD14 PE DRAGS

Intensity_Darkfield

1eb
Intensity_CO45

Application Examples:

— Quantify relative levels of fluorescence between cells and within different
regions of the same cell.

— Immunophenotyping.
— Cell cycle analysis.
— Protein expression.
— Protein activation.
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Max Pixel Feature

The Max Pixel feature is the largest value of the background-subtracted pixels con-
tained in the input mask. An example plot is shown below that demonstrates the
advantage of using this feature over the Intensity feature for identifying true positive
events. For a concentrated signal, Max Pixel is more sensitive than Intensity as
shown in the figure below.

The relationship of Max, Mean, Median, and Min Pixel is shown in the figure below:

Py r—— EIEIESEra o

FITC Cell A CellB

Max Pixel 576 838
Mean Pixel 152 152
Median Pixel 178 130
Min Pixel -0.05 -0.1
Intensity 230,000 230,000

Application Examples:

— Used to estimate the true peak fluorescence activity. Is preferred over the
Raw Max Pixel for this application.
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Understanding the Signal Strength Features

— Max Pixel to Mean Pixel ratio identifies bright punctate staining vs. uni-
form staining.
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Mean Pixel Feature

The Mean Pixel feature is the mean of the background-subtracted pixels contained in
the input mask. This is computed as Intensity/number of pixels.

The relationship of Max, Mean, Median and Min Pixel is shown in the figure below:

FITC Cell A Cell B

Max Pixel 576 838
Mean Pixel 152 152
Median Pixel 178 130
Min Pixel -0.05 -0.1
Intensity 230,000 230,000

Application Examples:

— Estimate the average fluorescence activity. This feature is preferred over
the Raw Mean Pixel feature.

— Quantify relative levels of mean fluorescence between cells.
— Identify bright punctate spots by calculating the max to mean pixel ratio.
— Track internalization of surface bound antibodies.
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Median Pixel Feature

The Median Pixel feature is the median of the background-subtracted pixels con-
tained in the input mask. It is more robust than the mean as an estimate of the aver-
age fluorescence since it is less influenced by outliers.

The relationship of Max, Mean, Median and Min Pixel is shown in the figure below:

FITC Cell A Cell B

Max Pixel 576 838
Mean Pixel 152 152
Median Pixel 178 130
Min Pixel -0.05 -0.1
Intensity 230,000 230,000

Application Example:

— Estimate the average fluorescence activity. This feature is preferred over
the Raw Median Pixel feature.
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Min Pixel Feature

The Min Pixel feature is the smallest value of the background-subtracted pixels con-
tained in the input mask. There will be some negative numbers due to the back-
ground subtraction, therefore the Raw Min Pixel feature is preferred.

FITC Cell A Cell B

Max Pixel 576 838
Mean Pixel 152 152
Median Pixel 178 130
Min Pixel -0.05 -0.1
Intensity 230,000 230,000

Application Examples:

— Obtain the minimum value in an image after background subtraction. Very
likely to be negative in brightfield imagery.

— Quantify spectral absorbance using the brightfield image.
— ldentify over compensated images.
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Understanding the Signal Strength Features

Raw Intensity Feature

The Raw Intensity feature is the sum of the pixel values within the mask including
camera background.

Application Example:

— Estimate raw fluorescence activity. This feature is less relevant than the
Intensity feature because it includes camera background intensity.
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Raw Max Pixel Feature

The Raw Max Pixel feature is the largest value of the pixels contained in the input
mask.

RTX FITC CD45 PE Brightfield

This image is saturated in the FITC
channel but not in the PE channel.

Raji Cells
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Raw Max Pixel Ch4
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Application Examples:

— Determine the presence of saturated events.

— May also be used to estimate the peak fluorescence activity, though the
Max Pixel feature is recommended for this application.

— Measure the maximum pixel value within the mask.

— ldentify cells that saturate the CCD, Saturation Count feature can also be
used for this application.
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Raw Mean Pixel Feature

The Raw Mean Pixel feature is the mean of the pixels contained in the input mask.
This is computed as Raw Intensity/number of pixels.

Application Example:

— Estimate the raw average fluorescence activity. This feature is less rel-
evant that the Mean Pixel feature.
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Raw Median Pixel Feature

The Raw Median Pixel feature is the median of the pixels contained in the input
mask.

Application Example:

— Estimate the raw average fluorescence activity that is robust to outliers.
This feature is less relevant than the Median Pixel feature.
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Raw Min Pixel Feature

The Raw Min Pixel feature is the smallest value of the pixels contained in the input
mask. The example below illustrates quantifying the level of malarial infected cells
by using Min Pixel values of brightfield imagery.

Brightfield YoYol Brightfield YoYol

Malaria Infected RBC

E-N
]

]
|

M
|

Mormalized Freguency %

o_bull ahllﬂ”l m \mlnln” mll] \JJJ ulmh “M‘m.ll..:. \

60 1 0
Raw Mln Pixel

Application Example:

— Quantify spectral absorbance using the brightfield image.
— Identify over compensated images.
— Measure the level of malaria infection in RBCs.
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Saturation Count Feature

The Saturation Count feature reports the number of saturated pixels in an object.
See also Saturation Percent Features.

In the figure below, objects with saturated pixels are lined up at the Raw Max Pixel
value of 1023 and a selected image is shown with saturated pixels in red.

zingle cellz Ei ey E
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Saturation Count_Channel 3
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Feature Walue
3["] EEIEI EII:IEI 1 283 Saturation Count_Channel 3 H
Raw kax Pikel_Channel 3 Saturation Percent_Channel 3 42082

Application Example:

— Measure the validity of the experiment setup. Saturated data may not
produce useful information.
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Saturation Percent Features

The Saturation Percent feature reports the percentage of saturated pixels in an
image. Pixel intensities are measured on the camera pixels from 0 to 1023 (10 bit)

and therefore become saturated and cannot be quantified after 1023. See also Sat-
uration Count Feature.

An object with saturated pixels shown in red:

Application Example:

— Measure the validity of the experiment setup. Saturated data may not
produce useful information.
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Spot Intensity Min and Spot Intensity Max Features

Spot Intensity Min provides the smallest Raw Mean Pixel value (not background sub-
tracted) of the dimmest spot (connected component). The Raw Mean Pixel values
for each spot is computed and the smallest value is reported.

Spot Intensity Max provides the largest Raw Mean Pixel value (not background sub-
tracted) of the brightest spot (connected component). The Raw Mean Pixel values
for each spot is computed and the largest value is reported.

These are two of four features that can be used to identify objects with spots that are
close together, dim, bright or small when counting spots in animage. To use these
features, the spots need to be individually masked, such as using the Spot or Peak
Mask. The Spot Area, Distance, and Intensity Min or Max features measure prop-
erties of different spots in an image and are often used with the Spot Count feature
(under Texture). Spot Area Min (Size) provides the area of the smallest spot. Spot
Distance Min (Location) provides the shortest distance between two spots. See also
Spot Area Min Feature, Spot Distance Min Feature, and Spot Count Feature.

The following diagram illustrates these features:

» Spot Area Min is the Area of spot 1

* Spot Distance Min is distance 2 in microns

* Spot Intensity Max is the Raw Mean Pixel value of spot 2
* Spot Intensity Min is the Raw Mean Pixel value of spot 3

Application Example:

— InFISH Spot Counting, these features are used to identify ambiguous
spots that are located too close together, too dim, to bright or too small to
count and can be eliminated from the analysis.
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Uncompensated Intensity

The Uncompensated Intensity feature is the sum of the background subtracted pixel
values within the masked area of the image with no compensation applied. This is
the Intensity of the uncompensated image. This feature is calculated in INSPIRE
during acquisition.
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Understanding the Comparison Features

The Comparison features describe the difference of intensity measurements
between masks or pixels in different images or the same image with different

masks. These include Bright Detail Similarity R3, Intensity Concentration Ratio,
Internalization, and Similarity.
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Understanding the Comparison Features

Bright Detail Similarity R3 Feature

The Bright Detail Similarity R3 feature is designed to specifically to compare the
small bright image detail of two images and can be used to quantify the co-local-
ization of two probes in a defined region, such as that of endosomes. The Bright
Detail Similarity R3 feature is the log transformed Pearson’s correlation coefficient
of the localized bright spots with a radius of 3 pixels or less within the masked area
in the two input images. Since the bright spots in the two images are either cor-
related (in the same spatial location) or uncorrelated (in different spatial locations),
the correlation coefficient varies between 0 (uncorrelated) and 1 (perfect correlation),
and does not assume negative values. The coefficient is log transformed to increase
the dynamic range between {0, inf}.

The following figure shows the Bright Detail Similarity R3 graph of two populations,
one that has colocalization and one that has no colocalization.

Double Positive

Mot Colocalized Colocalized

[ 1
0 3 &

Bright Detail Similarity R3_C38&Cy4

The figure below illustrates the process of obtaining the localized bright spots. The
bright areas are eroded from the original image and the detail eroded image is sub-
tracted from the original image resulting in the bright detail image.
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Original Image Detail Eroded Image Bright Detail Image

The figure below shows the correlation analysis between an image pair.

Hon-specifically Localized Cell

ADC Image

Codocalized Cell

PE anti-RTX HBJI3)

ADC Image

Application Examples:

Quantify the degree of colocalization between two probes.

Track internalization and intracellular trafficking of antibody drug con-
jugates to either the endosomes or the lysosomes.

Colocalization of Rituxan and compliment C3b.
Used in the Co-localization Wizard
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Intensity Concentration Ratio Feature

The intensity concentration ratio is defined as the ratio of the intensity inside the first
input mask to the intensity of the union of the two masks - the higher the score, the
greater the concentration of intensity inside the first mask. All pixels are background-
subtracted. The ratio is invariant to cell size and can accommodate concentrated
bright regions and small dim spots. The ratio is mapped to a log scale to increase the
dynamic range to values between {-inf, inf}. This feature is a generalization of the
Internalization feature. See Internalization Feature for more information.

Application Example:

— Quantify relative intensity concentrations between different cellular com-
partments. Internalization is a special case of this where the first mask is
the internal compartment and the second is the membrane region.
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Internalization Feature

The Internalization feature is defined as the ratio of the intensity inside the cell to the
intensity of the entire cell. The higher the score, the greater the concentration of inten-
sity inside the cell. All pixels are background-subtracted. The user must create a
mask to define the inside of the cell for this feature (see About Masks and Overview
of the Mask Manager). The feature is invariant to cell size and can accommodate
concentrated bright regions and small dim spots. The ratio is mapped to a log scale

to increase the dynamic range to values between {-inf, inf}. Internalized cells typ-
ically have positive scores while cells with little internalization have negative scores.
Cells with scores around 0 have a mix of internalization and membrane intensity.

Composite Images of brightfield and channel 6 are shown for High, Medium, and
Low Internalization values.

S—— - Mid Internalization
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Application Examples:

— Quantify internalization when supplied with the internal mask.
— Quantify the intensity ratio of a region of interest to the whole cell.
— Used in the Internalization Wizard.
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Similarity Feature

The Similarity feature is the log transformed Pearson’s Correlation Coefficient and is
a measure of the degree to which two images are linearly correlated within a masked
region.

The following figure shows two image pairs that are in spatial registry to one another.
On the left the NF-kB (green) is predominantly located in the cytoplasm of the cell
and has a dissimilar distribution compared to the 7-AAD image (red). When the inten-
sity of the green is high, the intensity of the red is low and vice versa. The Similarity
value for this cell is -2.067 indicating that the image pair has a high degree of dis-
similarity. Analysis of the image pair on the right shows that when the intensity of the
green is high, the intensity of the red is high and the Similarity value is a high positive
number.
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Below are examples of cells with varying amounts of similarity between the NFkB
image in green and 7-AAD image in red shown here as a composite image. The most
dissimilarimage pairs in the upper left to the most similarimage pairs in the upper
right.

0 3
Simiarity_NFkB / 7-AAD

Application Examples:
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— Quantify translocation.
— ldentify copolarization of two probes.
— Usedinthe Nuclear Localization Wizard
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XCorr Feature

The XCorr feature is a measure of similarity or 'sameness' between two images - the
higher the value, the more similar the images. It is robust to intensity variations and
relative shifts between the images and is typically used with the combined mask

MC. It is computed using the normalized cross correlation between the two input
images.

Application Examples:

— Used as a mask-independent measure of similarity between two images.
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Understanding the System Features

The system features do not require a mask.
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Camera Line Number Feature

The Camera Line Number feature returns the camera line number values. This fea-
ture is obtained from INSPIRE.

Application Example:

— Used in objects per mL feature.
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Camera Timer Feature

The Camera Timer feature returns the camera timer values that are in ticks. This fea-
ture is obtained from INSPIRE.

Application Example:

— Usedin Time feature.
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Flow Speed Feature

The Flow Speed is the calculated flow speed, in mm/sec, of the object.

The Flow Speed feature is the speed of flow of the cells. It is obtained from
INSPIRE. It should be very consistent across all cells in afile.

Application Example:

— Determine consistency of flow.
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Object Number Feature

The Object Number feature denotes the serial number of a cell in a file.
Application Example:

— Reference an object in afile.
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Objects/ml Feature

The Objects per mL feature returns the object concentration with respect to local vol-
ume.

Application Example:

— Monitor the object flow during the run. Note: Use the statistic Con-
centration to obtain objects/ml of a population.
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Objects/sec Feature

The Objects per sec feature returns the local object concentration with respect to
time.

Application Example:

— Monitor the throughput during a run. Note: Use the statistic Concentration
to obtain objects/ml of a population.
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Time Feature

The Time feature returns the camera timer values that are in ticks, converted to secs
with a formula.

Application Example:

— Obtain the time taken to collect a sample
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About Masks

The set of pixels that contains the region of interest is called the mask. In the fol-
lowing picture, the mask consists of the set of pixels on the right image that are col-
ored cyan. The cell is represented in the greyscale image on the left. Calculating
some feature values, such as the Area value, requires only a mask. Calculating
others, such as Intensity value, requires a mask and a channel image.

O O

There are three types of masks: Default masks, Combined Masks and Function
Masks:

1 Default masks named MO1 through M12 are either created in INSPIRE during
acquisition or created in IDEAS when a .rif file is opened. The default mask used
by INSPIRE during acquisition (Inspire) is different than the default mask created
in IDEAS (Default Object) when a .rif file is opened with QI or from an ImageS-
treamX. These masks are stored in the .cif file and cannot be changed by the
user.

Conversion note: Versions of IDEAS prior to 3.0 were using the System function
mask with a weight of 5 for the default masks which was more permissive and
resulted in larger masks.

Below is an example of the difference between the default masks.

@ 0 0 9

Inspire mask no mask System mask Default Object mask

2 Combined masks are created using Boolean logic to combine and subtract
masks. For example, the cytoplasmic mask is created by taking the brightfield
mask and not the morphology mask of the nuclear image.

You can use the Mask Manager to combine masks of different regions or images.
The IDEAS application default template provides a combined mask named MC
that is the union of the pixels from all channel masks and a NMC mask that is
everything outside of MC. The following illustration shows two channel masks
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About Masks

that are combined into one mask, which is shown in the right-most panel.

[ | [ |

Below is an example of making a membrane mask using Boolean Logic.

© © ©

Dilate 1 pixel Erode 3 pixels A And NotB

3 Function masks are created with user input. There are fourteen types of function
masks, Dilate; Erode; Fill; Inspire; Intensity; Interface; Morphology; Threshold;
Spot; System; Object; Peak; Range; Skeleton; and Valley. Each of the functions

masks are defined here.

Refer to Creating New Masks with the Mask Manager for more details about how to
create new masks.
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Dilate Mask

The Dilate mask adds the selected number of pixels to all edges of the starting
mask.

O O

Morphology Dilate 2 pixels
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Erode Mask

The Erode mask removes the selected number of pixels from all edges of the start-
ing mask.

Morphology Erode 3 pixels
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Fill Mask

The Fill mask fills in any holes in the starting mask.
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Inspire Mask

The Inspire mask masks pixels above background and is the mask used during data
acquisition in INSPIRE. This mask is available to understand what is being masked
during collection and is not generally used for feature calculations.

Note: this mask is new in IDEAS versions 4.0 or later.

Default Inspire
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Intensity Mask

The Intensity mask masks pixels between the lower and upper raw intensity thresh-
olds not background subtracted. See also Threshold Mask.

In the example below, cell #10678 is bright and cell #11992 is dim. The 50% Thresh-
old mask is similar for both images whereas the Intensity mask 250+ is quite dif-
ferent, since only a few pixels in the dim image are greater than 250 counts, while
most of the metaphase plates in the bright image are masked.

S Ve

-a - -

-, -, .

Threshold 50% Intensity 250-1023

-256 -



About Masks

Interface Mask

The interface mask identifies pixels in an object where the object is in contact with a
second object. Three input parameters are defined. First, the mask of one of the
objects (cell of interest). Next, the mask that covers both objects (conjugate). A
close fitting mask using another function mask such as Object (tight) can be used for
the cell of interest mask. A brightfield mask can be used for the conjugate. Finally,
the width of the interface mask from the contact point towards the cell of interest is
entered.

Examples are shown below:

Pail-of Intenest haaah Interface sk shown on

Brightfield Image

Conjugate hiask Cell of Composite
(BF Interest hiash Interface hiask Image

Application Examples:

— Used to quantify synapses in T cell APC (antigen presenting cell) con-
jugates.
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Morphology Mask

The Morphology mask includes all pixels within the outermost image contour. This
mask, which is used in fluorescence images, is best used for calculating the values
of overall shape-based features.

O

Morphology
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Object Mask

The Object mask segments images to closely identify the area corresponding to the
cell. It is based on the assumption that background pixels exhibit high uniformity to
each other. This helps distinguish the background from the cell pixels. The mask
characterizes the background pixels using a set of features and then segments the
image by determining all the pixels that deviate from the background feature set. The
default option is used for the default segmentation masks. The tight option uses a dif-
ferent set of features to characterize the background which results in a tighter fit
around the cell.

Examples are shown below:

Object Object

Image  etault) (tight)

09 ©

Application Examples:

— Used to get a close fit around the cellular area (tight option).

— Can be used in lieu of the morph mask for applications where the morph is
so tight that it provides incomplete masking, sometimes splitting cells into
two regions, such as a nuclear dye image of cells in anaphase or telo-
phase.

— Can be used in lieu of the morphology mask with the Similarity feature
when measuring nuclear translocation for better separation between
untranslocated and translocated cells (tight option).

— Used as the default segmentation masks (default option).
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Peak Mask

The Peak mask identifies intensity areas from an image that have local maxima
(bright) or minima (dark). Initially, the peak mask will identify all peaks in the image.
To select peaks which have certain brightness, the spot to cell background ratio is
used. This is the ratio between the spot pixel value to the mean camera background
value in the original image.

Below is an example of the Peak, bright option.

"/‘\

Y

Spot Mask Peak Mask

These peak areas
will be masked

Application Examples:

— Used with the Spot Count feature to quantify the speckleness of cells.
— Separate connected spots in a Spot Mask into individual components.
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Range Mask

The Range mask provides a capability to select components in an image within a
selected size and/or aspect ratio by setting a minimum and maximum area and mini-
mum and maximum aspect ratio.

To select pixels within a range of intensity values, see Intensity Mask.

4> Selecting small aspect ratio = object 3, object 4

Selecting small size = object 1, object 3
. @ Selecting small intensity = object 1, object 4

FISH-IS: Masking a cell with one spot using the spot and range masks
. * - -

ﬁm

Range_Area>2 Range_AR>04

Application Examples:

— Usewith a Spot Mask to constrain the Spot Count feature to round spots.

— Use on any other mask that has multiple components to define unwanted
objects such as debris, objects that are too small or whose shapes are not
circular.
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Skeleton Mask

The skeleton mask provides the barebone structure of the object from the starting
mask. Two options are available: thin or thick skeletons. The thin option produces
the condensed shape of the object and typically takes a form of 1-pixel wide skeletal
line. The thick option is intensity weighted. The thin option is dependent on the
shape of starting mask; thick uses the pixel intensities and is less sensitive to the
shape of the starting mask. The user will need to pay careful attention to the starting
mask. In the example below the Morphology mask of the image was used as the
starting mask for creating the skeleton.

Morphology Skeleton_thin  Skeleton_thick

Application Examples:

— Thick skeletons can be used with shape-based features such as sym-

metry to accentuate the shape of an object, and provide greater sep-
arations.

— Separate singlets and doublets by computing the area of the thin skeleton
mask. We have used the object(tight) for this case.

— Nuclear morphology measurements with lobe count feature for cell clas-
sification cells.
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Spot Mask

The Spot Mask has two options: bright or dark. The bright option obtains bright
regions from an image regardless of the intensity differences from one spot to
another. The ability to extract bright objects is achieved using the an image proc-
essing step that erodes the image and leaves only the bright areas. The dark option
obtains dark regions. The spot to cell background ratio and radius are specified by
the user. The spot to cell background ratio is the spot pixel value divided by the back-
ground in the bright detail image. A radius value of x implies that the image contains
spots with thickness of 2x+1 pixels.

The figure below illustrates the open residue process. The bright areas are eroded
from the original image and the detail eroded image is subtracted from the original
image resulting in the bright detail image.

Original Image Detail Eroded Image Bright Detail Image

The image pairs below show objects in grayscale next to their corresponding Spot
Masks in cyan. Spot masks can be further refined using the Peak and/or Range
masks. See Peak MaskRange Mask.

Application Examples:
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— Used with %e Spot Count feature to enumerate spots in images such as
for FISHIS™.

— Used with Intensity features to quantify intensity in spots.

— Dark spot finds valleys in images such as the low intensity between 2
stained nuclei and is useful for finding immune synapses.

— ldentifies the dark areas in red blood cells or parasitic infections in bright-
field imagery.
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System Mask

The System mask segments objects in an image based on a probability model of
how pixels should be grouped together. The user sets a weight value that defines a
loose or tight grouping. A low weight value groups in a more permissive manner.

Shown is an example of a cell with a apoptotic bleb that is not masked with the Sys-
tem mask weight set at 5 but is masked with the System mask weight set at 2.

Application Example:

— Used on brightfield images to capture a low contrast areas such as cells
that undergo a blebbing process, tails of sperm or other low contrast type
of structures.
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Threshold Mask

The Threshold mask is used to exclude pixels, based on a percentage of the range of
intensity values as defined by the starting mask. The user chooses the starting
mask when creating the Threshold mask. See also Intensity Mask.

In the example below, cell #10678 is bright and cell #11992 is dim. The 50% Thresh-
old mask is similar for both images whereas the Intensity mask 250+ is quite dif-
ferent, since only a few pixels in the dim image are greater than 250 counts, while
most of the metaphase plates in the bright image are masked.

Y Ve

-a - -

-, - E

Threshold 50% Intensity 250-1023

Application Example:

— Used with the Area feature to define apoptotic cells in the Apoptosis Wiz-
ard.
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Valley Mask

The Valley mask is a rectangular mask that sits between two bright regions in a start-
ing mask, such as between two nuclei. It is constructed by finding the minimum
intensity along the skeletal line between these two bright regions. The skeletal line is
obtained internally using the skeleton (thin) masking as described in Skeleton Mask.
This minimum intensity identifies the intersection between the two objects. The
mask is drawn perpendicular to this skeletal like. The length of the valley mask rec-
tangle is equal to the minor axis of the object and the width of the mask is defined by
the user in pixels.

Application example:

— Quantify the intensity of a probe in an immune synapse.
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Troubleshooting

This chapter covers common issues and provides solutions.

Always make sure you are using the most up-to-date version of
IDEAS by logging in to your account at www.amnis.com and down-
loading the software.

Application Hanging
If the IDEAS application is hanging, there may be a memory issues, especially with
large file processing. You must use the Task Manager to force quit the application.

Press and hold Ctrl + Alt + Delete.

The Window Task Manager appears.

Under the Applications tab, select IDEAS Application.

If the status is Not Responding, select End Task.

The manager will force quit the application after a confirmation.

a b W N =

Compensation

Sometimes an applied matrix produces poorly compensated data. This can happen
for a number of reasons: 1) miscalculation of the compensation matrix by inclusion
of inappropriate events (such as doublets, saturated pixel events, or artifacts), 2)
controls used for matrix calculation differ significantly from the experimental sam-
ples (different cell type, different probe), or 3) cells exhibit substantial auto-
fluorescence. This protocol describes a method for manually adjusting and validating
a compensation matrix for difficult samples.

To troubleshoot and repair a compensation matrix:

1 Create a population of cells that are miscompensated using the tagging tool. See
Creating Tagged Populations. Choose single cells that are exhibiting crosstalk.
Choose a range of intensities from negative to bright but not saturated, preferably
single color. If single color cells are not available, choose cells with a distinct
staining pattern in the peak channel.

2 Create Intensity scatter plots of adjacent channels in order to observe the over-
or under-compensation.

3 ldentify the matrix values that need adjusting by inspecting the scatter plots and
images. Each column contains the coefficients for the peak channel into the cor-
responding crosstalk channels (rows). For example the crosstalk of channel 2
(green) into channel 3 is highlighted in the matrix below.
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Compensation Matrix

Select a compenzation matrix:

081109 G2A1 shape change MCP1_2 cif

Chil 1 0.043
Cho2 003 |1

b Ch03 (002 [l
Ch04 |0 0.085

Chls |0 omz
Ch6 007 |0.044
Chd7 |0 0.001
Chiz |0 0.002
Chd3 |0 0.001
Chi0 |0 0
Ch11 |0 0
Ch1z 0 0

0
0
1
0

0
0
0
0
0
0
0
0

0

oo olooolo|lo|l=|oo

0

oo olooolo|l=2|loo o

0

oo oloo o= |loloo o

0

oo oloo = |lololoo o

Ch01 | ChO2 | Ch03 | ChO4  Ch0S | ChOG | ChO7 | ChO2 | Ch03 | Ch10 | Ch11 | Ch12

0

oo olo = ololo|lo/oo

0 0 0 0

oo o= o ololo|lo/oo
oo =|looololo|looo
o= olooolo|lo|looo
o olooolo|lo|lojo o

Freview a file with this matriz applied

(®) Select an exizting i file

() Select a population from the curent fils

| Ovenwrite preview files

| hd I Preview...

[ 1] ] [ Cancel ]

* Undercompensation (crosstalk coefficient is too low):

Plots: Intensity mean for the single color positive population is higher than the
unlabeled population in the crosstalk channel or the intensity in the crosstalk

channel trends diagonally upwards.

Images: the crosstalk channel contains an apparent fluorescent mirror-image.
» Overcompensation (crosstalk coefficient is too high):
Plots: Intensity mean for the single color positive population is lower than the
unlabeled population in the crosstalk channel or the intensity in the crosstalk
channel trends diagonally downwards.
Images: the crosstalk channel contains dark spots corresponding to the bright
spots in the fluorescent channel of interest.
4 Inthe Compensation menu choose View/Edit Matrix and manually change the
incorrect crosstalk matrix values identified above. Start with changes of ~.1 or
~.05 and use smaller and smaller increments as you refine the matrix.

5 Click Preview and choose the tagged population to view the results of the

changed coefficient.

6 Repeat steps 4 and 5 until the matrix is corrected.
7 Click Save, append manual to the matrix name, then click OK.
8 Open the .cif file and use the new matrix to create a new .daf file.

Creatinga TIFF

If you cannot see the TIFF image that you created, trying changing the resolution to

8-bit.
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Deleting a Population and Region

Often, a user deletes a population but forgets to delete the region. Deleting a pop-
ulation does not delete the region. You must delete the region itself.

Object Number set to Zero

When opening a .daf file, there may be an error if the object number is set to zero.
This can happen if the data was collected during a crash within INSPIRE. This error
can be corrected with the following procedure.

1 Select Tools > Merge .rif Files.
2 Click Add Files to select the single .rif file.

3 Click OK. Enter a new name if desired. The single .rif file will merge with itself
and rewrite the file with the proper object count.

Buttons or options in windows are not appearing

When the font size setting is set to large some windows will not size properly caus-
ing buttons or text boxes to not appear. To change the font size in Windows go to the
Control Panel>Display>Appearance and select Font size Normal.
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Glossary

Table 1: Glossary of Terms

Term Definition
- The process of collecting data from the ImageStream cell analysis
acquisition
system.
brightfield A type of illumination that uses transmitted light. On the ImageS-

tream cell analysis system, this light is provided by a halogen lamp.

brightfield image

An image that is produced by transmitted light. On the ImageStream
cell analysis system, this light is provided by a halogen lamp.

brightfield The camera channel that the brightfield image appears in.
. . The precise adjustment of instrument components based on test
calibration o o
results for the purpose of optimizing functionality.
CCD See charge-coupled detector (CCD).

One of the six physical partitions on the camera. Each camera chan-
nel collects a different spectral band of imagery, which allows for the
collection of brightfield, darkfield, and up to four fluorescence images
per object.

charge-coupled detec-
tor (CCD)

A sensor for recording images that consists of a particular type of inte
grated circuit—one that contains an array of linked, or coupled, capac-
itors. Under the control of an external circuit, each capacitor can
transfer its electric charge to either of its neighbors.

The mean-normalized standard deviation, expressed as a per-

coefficient of variation |centage. The CV measures the variation of a feature value inde-

(CV) pendent of the population mean value. The formula is: CV = 100 x
standard deviation / mean

CVv See coefficient of variation (CV).

compensation

The process of removing intensity—specifically, intensity that was
derived from fluorescence crosstalk that originated from dyes cen-
tered in other channels. The IDEAS application performs com-
pensation on a pixel-by-pixel basis.

compensation matrix

The set of values that report the relative amount of fluorescence of
each probe in each channel. The compensation matrix is used to sub-
tract intensity originating from dyes centered in other channels.

Leakage of fluorescence signal from a fluorochrome into adjacent

crosstalk
channels.
A type of illumination in which the sample is illuminated at angles that
darkfield do not directly enter the objective. On the ImageStream cell analysis
system, 90-degree angle side scatter from the 488-nm laser provides
the darkfield imagery.
FISH See fluorescent in situ hybridization (FISH).
A fluorescent dye used to label cellular constituents or specific
fluorochrome .
probes of cellular constituents.
fluorescence Light emitted by a fluorescent dye following excitation.

fluorescence com-

The adjustments made to remove the fluorescence emissions of a
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Term

Definition

pensation

fluorochrome into adjacent channels.

fluorescent in situ hybrid-

/A physical mapping approach that uses fluorescent tags to detect the
hybridization of probes with metaphase chromosomes or the less-cont

ization (FISH) densed somatic interphase chromatin.

gain The amplification of a detector signal.
The brightness level, ranging from black to white, of a pixel or grou

grayscale of pixelgs ' ging P group
A pixel is equal to a half micron in length with the 40X objective, 1

pixel micron with the 20X objectiv92and 0.33 microns with the 60X objec-
tive. Note that 1 pixel = x pm*<.

saturation The state of a pixel that hag, a value at or above 1023 for the IS100 or
4095 for the ImageStream” .

segmentation The process of discriminating an object from its background.

spectral decomposition
element

A custom set of longpass dichroic filters arranged in an angular array.
The spectral decomposition element directs different spectral bands
to laterally distinct channels on the detector. With this technique, an
image is optically decomposed into a set of six sub-images, each cor-
responding to a different color component and spatially isolated from
the remaining sub-images.

spatial offset

The registration error of the six channel images for a single cell. The
spatial offset is measured during calibration and the values are saved
to the image database.

Table of Coefficients

The table used by the compensation matrix to place the detected light
that is displayed in each image into the proper channels, on a pixel-
by-pixel basis.

template

A file that saves the set of instructions for an analysis session. Note
that a template contains no data; it simply contains the structure for
the analysis. This structure includes definitions of features, graphs,
regions, and populations; image viewing settings; channel names;

and statistics settings.
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Index

Acquisition information 72
Advanced Analysis 49
Analysis Area
adding an image panel 103
adding text 110
overview 94
printing 145, 155
tools 94
Apoptosis
wizard 33
Application defaults 5, 132
Area 171
ast

about 19

Batch processing 74

Brightfield information 73

Building Blocks 47
Fluorescence Positives-one color 47
Fluorescence Positives-two color 47
Focus 47
Single Cell 47
Single Cell Default 47
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Size/SSC 47
Tool 95

Camera settings information 73
Cell Classifiers 73
Cell Cycle
using a wizard 35
Channels collected 73
cif
merging 70
opening 53
saving 56
cifiabout 18
Co-localization
using a wizard 37
Color
mapping dark/light mode defaults 10, 137
Show in Image Gallery 80
Compare, FlowSight, FlowSight QI, ImageStream 15
Compensation
adjusting compensation population 64
creating 59
definition 16
editing the matrix 67
overview 58

validating matrix 63
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view matrix 73
Compensation matrix file

about 19

creating 59
Composites 85, 142
Copying images 87
Corrections information 72
ctm

about 19

creating 59

daf
about 18
opening 55
saving 56
Data analysis steps 22
Data analysis tools
about 78
Data files
ast 19-20
cif 18,20
ctm 19-20
daf 18,20
new from populations 71
opening 50
rif 18, 20
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type 20
Defaults

application 5
color mapping dark/light mode 10, 137
compensation matrix 15
directories 6, 133
graphs 9, 135
image export 9, 136
mask 15
mask color 8, 134
population color 7, 134
population symbol 7, 134
statistics for a graph 8, 134
Diameter 172
Directories
changing default 6, 133
Display
making composites 81, 138
setting properties 81, 138
setting properties using a wizard 27

views in the Image Gallery 81, 138

EDF
kernels 73

Example data files 5
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Exporting data 152
features 152

pixel intensity values 153

Feature Finder
wizard 29

Feature Manager
overview 113
tasks 117
tools 114

Features
angle 183
angle intensity 183
Area 171
aspect ratio 196
aspect ratio intensity 197
Bkdg mean 217
Bkgd std dev 218
bright detail intensity 206
camera line number 243
camera timer 244
categories 161
centroid delta x and y 185
centroid delta xy 187
centroid x and 'y 184

circularity 198
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compactness 200

contrast 208

create combined 117
create multiple 115

create new 114

delete 118

diameter 172
elongatedness 201
Feature Finder Wizard 30
find a feature 118

flow speed 245

gradient max 210
gradient RMS 211

height 173, 181

intensity 219
internalization 238

lobe count 202

major and minor axis intensity 176
major axis and minor axis 175
max contour position 190
min pixel 224
modulation 213

object number 246

object per mL 247

object per sec 248
overview 159

perimeter 177
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raw intensity 225

raw max pixel 226

raw mean pixel 227

raw median pixel 228
raw min pixel 229
saturation count 230
saturation percent 231
shape ratio 203
similarity 239

similarity texture R3 235
size 170

spot area min 178

spot count 214

spot distance min 192
spot intensity min 232
std dev 215

symmetry 2 204

table alphabetical list 162
table by category 164
thickness max 179

time 249

valley x andy 193
viewing 114

width and height 173, 181
without QI 169

File name extensions 5
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Fluorochromes
table for IS100 61
table for ISX - 12 channel system 61
table for ISX - 6 channel system 61
Focus building block 47

graphs
copy and paste 102
Graphs
apply or remove region 102
creating 95
creating regions 99
defaults 9, 135
legend 98
moving 99
printing 156
resizing regions 101
statistics 97
zoom 101

Guided Analysis 23

Hardware requirements 4

Histogram tool 95
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IDEAS
getting started 22
Image
copy 87
exporting defaults 9, 136
individual image 86
Image Display intensity mapping 83, 139
Image Gallery
channel view 80
composites 85, 142
overview 79
population 80
printing 145, 155
properties 81-82, 138
properties tool 79
resize 81
show-hide color 81
show-hide masks 80
tools 79
using 79
views 84, 141
Image panel size
change in Image Gallery 82, 139
Individual image

display properties 106
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manipulating 86
measurement tool 104
pixel intensities 104
show-hide mask 108
Internalization

using a wizard 39

Laser information 73

Line Region Tool 95

Mask Manager
overview 88
tools 91

Masks
about 250
combining 91
creating new 88
default color 8, 134
dilate 252
edit 91
erode 253
examples 92
fill 254
intensity 256
list of 89

morphology 258
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object 259

peak 260

range 261

show in Image Gallery 79

skeleton 262

spot 263

system 265

threshold 266

valley 267

viewing definitions 91
Merging cif files 70
Merging raw images files 69
Mitosis

using a wizard 35

Name and Color
Image Gallery 82, 139
Nuclear Localization
using a wizard 41
Nuclear translocation

using a wizard 41

Object Data 108
Object Feature Values Table 95

One color histogram building block 47
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Opening files
using a wizard 26

Oval Region Tool 95

P
Pointer tool 94
Polygon Region Tool 95
Population Manager 124
tools 125
Population Statistics 111
Population Statistics table 95
Populations
creating 127
creating a new data file from 71
creating combined 125
deleting 124
display properties 124
during acquisition 73
viewing 124
Printing 145
R

Rectangle Region Tool 95
Region Manager 129
Regions

editing 129

viewing 129
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Reporting 131
changing color mapping 144
graphs and statistics 146
Images 145
Images and Graphs 144
light mode graphs 144
statistics 148
statistics from multiple files 150
Reports
printing data 145, 155
rif
about 18
merge 69

opening 50

Sample Information

view 72
Saturation

view in Image Gallery 80
Saving data files 56

ast 57

cif 56

daf 56

Template 57

Scatter plot tool 95
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Scatter plots
show-hide populations 102
Screen resolution 5
Select All Panels Tool 95
Shape Change
using a wizard 43
Single Cell Building Block 47
default 47
Size/SSC Building Block
default 47
Software requirements 4
Spot Count
using a wizard 45
Statistics

defaults for a graph 8, 134

Tagging tool 79, 95

Template file
about 19
default 15
definition 16
saving 57

Text tool 95

TIFs
creating 154

Two color scatter plot building block 47
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Views
custom 84, 141

Volume information 72

Wizards
Apoptosis 33
Begin Analysis 28
Cell Cycle - Mitosis 35
Co-localization 37
Display Propertes 27
Feature Finder 29
Internalization 39
list 24
Nuclear Localization 41
Open File 26
Shape Change 43
Spot Count 45
Tool 95

Workflow; data analysis workflow 16

Zoom

Image Gallery 80
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